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Safety information
These warnings and precautions are included in order to prevent injury to you and others, as well as preventing any 
potential damage to your machine. Be sure to read and understand all of these instructions before using the machine.

Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and 
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place 
for future reference.

Important safety symbols

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of 
danger.

Explanation of all icons and signs used in the user’s guide:

Warning Hazards or unsafe practices that may result in severe personal injury or death.

Caution Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

Follow directions explicitly.
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Operating environment

 Warning

 Caution

Do not use if the power cord is damaged or if the electrical outlet is not grounded.
►This could result in electric shock or fire. 

Do not place anything on top of the machine (water, small metal or heavy objects, candles, lit cigarettes, etc.).
►This could result in electric shock or fire. 

• If the machine gets overheated, it releases smoke, makes strange noises, or generates an odd odor, immediately turn off 
the power switch and unplug the machine.

• The user should be able to access the power outlet in case of emergencies that might require the user to pull the plug out.
►This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power cord. 
►Stepping on or allowing the power cord to be crushed by a heavy object could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not handle the plug with wet hands. 
►This could result in electric shock or fire. 

During an electrical storm or for a period of non-operation, remove the power plug from the electrical outlet. 
►This could result in electric shock or fire. 

Be careful, the paper output area is hot. 
►Burns could occur. 

If the machine has been dropped, or if the cabinet appears damaged, unplug the machine from all interface 
connections and request assistance from qualified service personnel.
►Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these instructions have been followed, unplug the machine from all 
interface connections and request assistance from qualified service personnel.
►Otherwise, this could result in electric shock or fire.

If the plug does not easily enter the electrical outlet, do not attempt to force it in. 
►Call an electrician to change the electrical outlet, or this could result in electric shock.

Do not allow pets to chew on the AC power, telephone or PC interface cords.
►This could result in electric shock or fire and/or injury to your pet. 
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Operating method

 Caution

Installation / Moving

 Warning

Do not forcefully pull the paper out during printing. 
►It can cause damage to the machine.

Be careful not to put your hand between the machine and paper tray.
►You may get injured.

Be care when replacing paper or removing jammed paper. 
►New paper has sharp edges and can cause painful cuts.

When printing large quantities, the bottom part of the paper output area may get hot. Do not allow children to touch. 
►Burns can occur.

When removing jammed paper, do not use tweezers or sharp metal objects. 
►It can damage the machine.

Do not allow too many papers to stack up in the paper output tray.
►It can damage the machine. 

Do not block or push objects into the ventilation opening.
►This could result in elevated component temperatures which can cause damage or fire.

Use of controls or adjustments or performance of procedures other than those specified herein may result in hazardous 
radiation exposure.

This machine's power reception device is the power cord. 
►To switch off the power supply, remove the power cord from the electrical outlet. 

Do not place the machine in an area with dust, humidity, or water leaks. 
►This could result in electric shock or fire. 
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 Caution

Maintenance / Checking

 Caution

Before moving the machine, turn the power off and disconnect all cords. The information below are only suggestions based 
on the units weight.
If you have a medical condition that prevents you from lifting, do not lift the machine. Ask for help, and always use the 
appropriate amount of people to lift the device safety.
Then lift the machine:
•  If the machine weighs under 20 kg (44.09 lbs), lift with 1 person.
•  If the machine weighs 20 kg (44.09 lbs) - 40kg (88.18 lbs), lift with 2 people.
•  If the machine weighs more than 40 kg (88.18 lbs), lift with 4 or more people.
►The machine could fall, causing injury or machine damage.

Do not place the machine on an unstable surface.
►The machine could fall, causing injury or machine damage.

Use only No.26 AWGa or larger, telephone line cord, if necessary.
►Otherwise, it can cause damage to the machine.

a.AWG: American Wire Gauge

Make sure you plug the power cord into a grounded electrical outlet.
►Otherwise, this could result in electric shock or fire.

Use the power cord supplied with your machine for safe operation. If you are using a cord which is longer than 2 meters (6 
feet) with a 110V machine, then the gauge should be 16 AWG or larger.
►Otherwise, it can cause damage to the machine, and could result in electric shock or fire.

Do not put a cover over the machine or place it in an airtight location, such as a closet.
►If the machine is not well-ventilated, this could result in fire.

Do not overload wall outlets and extension cords.
►This can diminish performance, and could result in electric shock or fire.

The machine should be connected to the power level which is specified on the label.
►If you are unsure and want to check the power level you are using, contact the electrical utility company.

Unplug this product from the wall outlet before cleaning the inside of the machine. Do not clean the machine with benzene, 
paint thinner or alcohol; do not spray water directly into the machine. 
►This could result in electric shock or fire. 

When you are working inside the machine replacing supplies or cleaning the inside, do not operate the machine.
►You could get injured.
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Supply usage

 Caution

Keep cleaning supplies away from children. 
►Children could get hurt.

Do not disassemble, repair or rebuild the machine by yourself. 
►It can damage the machine. Call a certified technician when the machine needs repairing.

To clean and operate the machine, strictly follow the user's guide provided with the machine.
►Otherwise, you could damage the machine.

Keep the power cable and the contact surface of the plug clean from dust or water.
►Otherwise, this could result in electric shock or fire. 

• Do not remove any covers or guards that are fastened with screws. 
• Fuser units should only be repaired by a certified service technician. Repair by non-certified technicians could result in 

fire or electric shock.
• The machine should only be repaired by a Samsung service technician.

Do not disassemble the toner cartridge.
►Toner dust can be dangerous if inhaled or ingested.

Do not burn any of the supplies such as toner cartridge or fuser unit.
►This could cause an explosion or uncontrollable fire.

When storing supplies such as toner cartridges, keep them away from children.
►Toner dust can be dangerous if inhaled or ingested.

Using recycled supplies, such as toner, can cause damage to the machine.
►In case of damage due to the use of recycled supplies, a service fee will be charged.

When toner gets on your clothing, do not use hot water to wash it.
►Hot water sets toner into fabric. Use cold water.

When changing the toner cartridge or removing jammed paper, be careful not to let toner dust touch your body or clothes.
►Toner dust can be dangerous if inhaled or ingested.
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Regulatory information
This machine is designed for our sound environment and certified with several regulatory statements.

Laser Safety Statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1 : 2007.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.

WARNING 
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

Ozone Safety

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Samsung dealer.
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PERCHLORATE WARNING

This Perchlorate warning applies only to primary CR (Manganese Dioxide) Lithium coin cells in the product sold or distributed ONLY in 
California USA. 
Perchlorate Material - special handling may apply.
see www.dtsc.ca.gov/hazardouswaste/perchlorate. (U.S.A. only)

Power Saver

Recycling

China only

Correct Disposal of This Product (Waste Electrical & Electronic Equipment)

(Applicable in the European Union and other European countries with separate collection systems)

(The United States of America only)
Dispose unwanted electronics through an approved recycler. To find the nearest recycling location, go to our website: 
www.samsung.com/recyclingdirect Or call, (877) 278 - 0799

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://www.energystar.gov

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB 
cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to 
promote the sustainable reuse of material resources.
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and 
how they can take these items for environmentally safe recycling.
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for disposal.
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Radio Frequency Emissions

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to 
operate the equipment.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe A prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.

UNITED STATES OF AMERICA

Federal Communications Commission (FCC)

Intentional emitter per FCC Part 15
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be 
present (embedded) in your printer system. This section is only applicable if these devices are present. Refer to the system label to verify the 
presence of wireless devices.
Wireless devices that may be in your system are only qualified for use in the United States of America if an FCC ID number is on the system 
label.
The FCC has set a general guideline of 20 cm (8 inches) separation between the device and the body, for use of a wireless device near the 
body (this does not include extremities). This device should be used more than 20 cm (8 inches) from the body when wireless devices are on. 
The power output of the wireless device (or devices), which may be embedded in your printer, is well below the RF exposure limits as set by 
the FCC.
This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Operation of this device is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation of the device.

 

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to 
use it. Contact manufacturer for service.

RFID (RADIO FREQUENCY INTERFACE DEVICE)

RFID operation is subject to the following two conditions:(1) this device may not cause interference, and (2) this device must accept any 
interference, including interference that may cause undesired operation of the device. (U.S.A., France, Taiwan only)
Regulatory information_ 16



Russia only

Germany only

Turkey only

Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device to send any 
message via a telephone facsimile machine unless such message clearly contains in a margin at the top or bottom of each transmitted page or 
on the first page of the transmission the following information:

1. the date and time of transmission
2. identification of either business, business entity or individual sending the message; and
3. telephone number of either the sending machine, business, business entity or individual.
The Telephone Company may make changes in its communications facilities, equipment operations or procedures where such action is 
reasonably required in the operation of its business and is not inconsistent with the rules and regulations in FCC Part 68. If such changes can 
be reasonably expected to render any customer terminal equipment incompatible with telephone company communications facilities, or require 
modification or alteration of such terminal equipment, or otherwise materially affect its use or performance, the customer shall be given 
adequate notice in writing, to allow the customer an opportunity to maintain uninterrupted service
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Ringer Equivalence Number

The Ringer Equivalence Number and FCC Registration Number for this machine may be found on the label located on the bottom or rear of the 
machine. In some instances you may need to provide these numbers to the telephone company.
The Ringer Equivalence Number (REN) is a measure of the electrical load placed on the telephone line, and is useful for determining whether 
you have “overloaded” the line. Installing several types of equipment on the same telephone line may result in problems making and receiving 
telephone calls, especially ringing when your line is called. The sum of all Ringer Equivalence Numbers of the equipment on your telephone 
line should be less than five in order to assure proper service from the telephone company. In some cases, a sum of five may not be usable on 
your line. If any of your telephone equipment is not operating properly, you should immediately remove it from your telephone line, as it may 
cause harm to the telephone network.
The equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On the right lower side of this equipment is 
a label that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be 
provided to the telephone company.

 

FCC Regulations state that changes or modifications to this equipment not expressly approved by the manufacturer could void the user’s 
authority to operate this equipment. In the event that terminal equipment causes harm to the telephone network, the telephone company 
should notify the customer that service may be stopped. However, where prior notice is impractical, the company may temporarily cease 
service, providing that they:

a) promptly notify the customer.
b) give the customer an opportunity to correct the equipment problem.
c) inform the customer of the right to bring a complaint to the Federal Communication Commission pursuant to procedures set out in 

FCC Rules and Regulations Subpart E of Part 68.

You should also know that:
• Your machine is not designed to be connected to a digital PBX system.
• If you intend to use a computer modem or fax modem on the same phone line as your machine, you may experience transmission and 

reception problems with all the equipment. It is recommended that no other equipment, except for a regular telephone, share the line with 
your machine.

• If your area experiences a high incidence of lightning or power surges, we recommend that you install surge protectors for both the power 
and the telephone lines. Surge protectors can be purchased from your dealer or telephone and electronic specialty stores.

• When programming emergency numbers and/or making test calls to emergency numbers, use a non-emergency number to advise the 
emergency service dispatcher of your intentions. The dispatcher will give you further instructions on how to actually test the emergency 
number.

• This machine may not be used on coin service or party lines.
• This machine provides magnetic coupling to hearing aids.
You may safely connect this equipment to the telephone network by means of a standard modular jack, USOC RJ-11C.

Replacing the Fitted Plug (for UK Only)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
Contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.
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Important warning: 

Earth
Neutral

Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

Declaration of Conformity (European Countries)

Approvals and Certifications

Hereby, Samsung Electronics declare that this product is in compliance with the essential requirements and other relevant provisions of:
CLX-92x1 93x1 Series: R&TTE Directive (1999/5/EC)
The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer (MFP) 
name to browse the EuDoC. 
January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics 
Co., Ltd. representative.

EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal Equipment Directive (FAX)
This Samsung product has been self-certified by Samsung for pan-European single terminal connection to the analogue public switched 
telephone network (PSTN) in accordance with Directive 1999/5/EC. The product has been designed to work with the national PSTNs and 
compatible PBXs of the European countries:
In the event of problems, you should contact the Euro QA Lab of Samsung Electronics Co., Ltd. in the first instance.
The product has been tested against TBR21. To assist in the use and application of terminal equipment which complies with this standard, the 
European Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 201 121) which contains notes and additional 
requirements to ensure network compatibility of TBR21 terminals. The product has been designed against, and is fully compliant with, all of the 
relevant advisory notes contained in this document.

You must earth this machine.
The wires in the mains lead have the following color code:
• Green and Yellow: 
• Blue: 
• Brown: 

Hereby, Samsung Electronics, declares that this [CLX-865x Series] is in compliance with the essential requirements and other relevant 
provisions of R&TTE Directive 1999/5/EC.
The declaration of conformity may be consulted at www.samsung.com, go to Support > Download center and enter your printer (MFP) name 
to browse the EuDoC. 
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About this user’s guide
This user’s guide provides information to provide a basic understanding of the machine as well as detailed explanations on 
each step during actual usage. Valuable for both novice and professional users, all users can refer to this guide for 
installing and using the machine.

 

• Read the safety information before using the machine.
• If you have a problem using the machine, refer to the troubleshooting chapter (see "Troubleshooting" on page 125).
• Terms used in this user’s guide are explained in the glossary chapter (see "Glossary" on page 171).
• Use the Index to find information.
• All illustrations in this user’s guide may differ from your machine depending on its options or models. 
• The display screen image in this user’s guide may differ from your machine depending on its options or models.
• The procedures in this user’s guide are mainly based on the operating system of Windows 7.

Conventions

Some terms in this guide are used interchangeably:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• Machine refers to printer or MFP.
The following table offers the conventions of this guide:

 

The date format may differ from country 
to country.

 

Do not touch the green underside of the 
toner cartridge. 

Convention Description Example

Bold Used for texts on the display or button names on the machine. Start

Note Provides additional information or detailed specifications of the machine function 
and feature.

Caution Gives users information to protect the machine from possible mechanical 
damage.

Footnote Provides additional information on certain words or a phrase. a. pages per minute

(“Cross-reference”) Guides users to a reference page for additional detailed information. (see "Finding more information" on page 22).
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Finding more information

You can find information for setting up and using your machine from the following resources, either as a print-out or on screen.

Material name Description

Installation Guide This guide provides information on setting up your machine and requires that you follow the instructions in the guide to prepare the 
machine.

Go Guide This guide provides operating procedures and descriptions of the most frequently used functions, allowing the machine to immediately 
be used.

Online User’s Guide This guide provides you with step-by-step instructions for using your machine’s full features and contains information for maintaining 
your machine, troubleshooting, and installing accessories. 

Machine Driver Help This help guide provides you with help information on the printer driver and instructions for setting up the printing options (see the User 
Guide).

Samsung website If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website. 
(www.samsung.com)

Downloadable 
software

You can download useful software from the Samsung website. 

• SyncThruTM Web Admin Service: convenient for network administrators who need to manage many machines simultaneously. This 
software is for network models only. (http://solution.samsungprinter.com)

• Samsung AnyWeb Print: helps personal users to screen-capture the website screen in Windows Internet Explorer easily. 
(http://solution.samsungprinter.com/personal/anywebprint)

• XPS printer driver: used to print XPS file format. The XPS printer driver can be installed only on Windows Vista OS or higher. 
(www.samsung.com)
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Features of your new product
Your new machine is equipped with a number of special features that improve the quality of your printed documents.

Special Features

Print with excellent quality and speed

• You can print with a resolution of up to 1,200 x 1,200 dpi 
(CLX-92x1 9301 Series). You can print with a resolution of 

Print in various environments

• You can print on various operating systems such as 
Windows, Linux, MAC and Unix systems.
Handle many different types of printable material

Create professional documents

Save time and money

up to 9,600 x 600 dpi effective output (SCX-812x Series).
• CLX-9301 Series prints A4-sized or letter-sized paper at up 

to 30 ppm. CLX-9251 Series prints A4-sized or letter-sized 
paper at up to 25 ppm. CLX-9201 Series prints A4-sized or 
letter-sized paper at up to 20 ppm.

• CLX-9301 Series prints A3-sized paper at up to 15 ppm. 
CLX-9251 Series prints A3-sized paper at up to 12.5 ppm. 
CLX-9201 Series prints A3-sized paper at up to 10 ppm.

• SCX-8128 Series prints A4-sized or letter-sized paper at up 
to 28 ppm. SCX-8123 Series prints A4-sized or letter-sized 
paper at up to 23 ppm.

• SCX-8128 Series prints A3-sized paper at up to 14 ppm. 
SCX-8123 Series prints A3-sized paper at up to 11.5 ppm.

• The multi-purpose tray supports various printable materials 
(see"Print media specifications" on page 165).

• The multi-purpose tray holds up to 100 sheets of plain paper.
• The 1,040-sheet standard tray and 1,040-sheet optional dual 

cassette feeder support plain paper in various sizes.

• Print Posters. The texts and pictures of each page of your 
document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster (see 
"Printing posters" on page 107).

• Print Watermarks. You can customize your documents with 
words, such as “CONFIDENTAL” (see "Using watermarks" 
on page 108).

• You can use preprinted forms and letterhead with plain 
paper (see"Using overlay" on page 108).

• To save paper, you can print multiple pages on one single 
sheet of paper (see "Printing multiple pages on one sheet of 
paper" on page 106).

• This machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• To save paper, you can print on both sides of the paper 
(double-sided printing) (see "Printing on both sides of the 
paper" on page 107).
Features of your new product_
Copy originals in several formats

Scan the originals and send it right away

Set a specific time to transmit a fax (optional)

Use USB flash memory devices

Support XOA applications

• Your machine is equipped with a network interface.

• Your machine can copy multiple image copies from the 
original documents on a single page (see "N-up copying" on 
page 57).

• There are special functions to erase catalog and newspaper 
background images (see "Adjusting background" on 
page 62).

• The print quality and image size can be adjusted and 
enhanced at the same time.

• Scan in color and use precise compressions of JPEG, TIFF, 
and PDF formats.

• Quickly scan and send files to multiple destinations using 
Networks scanning (see "Scanning" on page 76).

• You can specify a certain time to transmit a fax and also 
send the fax to several stored addresses.

• After transmission, the machine may print out the fax reports 
according to the setting.

If you have a USB memory device, you can use it various ways 
for your machine.
• You can scan documents and save them to the device.
• You can directly print data stored in the device (see 

"Printing from a USB memory device" on page 117).

The machine supports XOA custom applications.
• Regarding the XOA custom applications, please contact 

your XOA custom application provider.
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Features by model

The machine is designed to support all of your document needs from printing and copying to more advanced networking solutions for your business. Some features 
and optional goods may not be available depending on models or countries.
Features by model include:

( ●: Included, o: Optional, Blank: Not available) 

FEATURES CLX-9301 Series CLX-9251 Series CLX-9201 Series SCX-8128 Series SCX-8123 Series

USB Memory Interface ● ● ● ● ●

Duplex Automatic Document Feeder ● ● ● ● ●

Hard Disk ● ● ● o

Network Interface Ethernet 
10/100/1000 Base TX wired LAN

● ● ● ● ●

Duplex (2-sided) printing ● ● ● ● ●

500-sheet Inner Finisher o o o o o

Cabinet Stand o o o o o

Dual Cassette Feeder o o o o o

Working Table o o o o o

Fax Kit o o o o o

FDI Kit o o o o o

Job Separator o o o o o
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1.Introduction
These are the main components of your machine:

This chapter includes:

• Machine overview
• Control panel overview
• Touch interaction
• Understanding the status LED
• Turning the machine on
• Turning the machine off
• Connecting a printer cable
• Introducing the display screen and useful buttons
  

Machine overview

Front view 1

 4

 3 

 7

 5

 6

10

13

1

12

11

 9

8

 2 

 

1 Duplex automatic document feeder cover
 

8 Dual cassette feeder (tray 3, tray 4)a

 

2 Duplex automatic document feeder width guides
 

9 Standard tray (tray 1, tray 2)
 

3 Duplex automatic document feeder input tray
 

10 Front door
 

4 Duplex automatic document feeder output tray
 

11 Front door handle
 

5 Power-switch
 

12 Paper output tray
 

6 Power receptacle
 

13 Control panel
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Front view 2
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7 Optional dual cassette feeder right bottom door

a.Optional device.

Scanner glass Multi-purpose tray paper width guide

White sheet USB port

Multi-purpose tray
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Rear view
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Duplexing automatic document feeder cable USB port

Network port USB printer port
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Inner view (CLX-92x1 Series, CLX-9301 Series)
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If you want to see the imaging unit, you need to remove the waste toner container.

LSU window cleaning stick Toner Cartridges

Waste toner container Imaging units
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Inner view (SCX-812x Series)
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If you want to see the imaging unit, you need to remove the waste toner container.

Waste toner container Imaging unit

Toner cartridge
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Control panel overview
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When you use the display screen, use your finger only. 

Display screen Shows the current machine status and prompts during an operation. You can set menus easily using the display screen.

Status LED Shows the status of your machine (see "Understanding the status LED" on page 32).

Job Status Shows the jobs currently running, queued jobs, completed jobs, current error code or secured jobs. 

Counter Shows the amount of paper used (see "Counter button" on page 35).

Eco Turn on Eco mode (see "Eco button" on page 35).

Clear Deletes characters in the edit area.

Numeric keypad Dials numbers and enters alphanumeric characters. You can also enter the number value for document copies or other 
options.

Reset Resets the current machine setup.

Redial/Pause Redials the recently sent fax number or received caller ID in ready mode, or inserts a pause (-) into a fax number in edit 
mode.

Log in/Log out Allows user to log in or log out.

On Hook Dial When you press this button, you can hear a dial tone. Then enter a fax number. It is similar to making a call using a speaker 
phone.

Power
Turns the power on or off. When the blue LED is on, the machine is powered on and you can use it. To turn the machine off, 
press and hole this button for at least 3 seconds. Press Yes when the confirmation window appears.

Interrupt Stops a job in operation for urgent copying.

Stop
Stops an operation at any time. The pop-up window appears on the screen showing the current job that the user can stop or 
resume.

Start Starts a job.
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Touch interaction

Type Description

Tap
(Press)

Action of quickly pressing and releasing an area of screen
(When used with “release”, it will be called a “press’”).

Touch & Move

When touching the screen, the focus will be moved straight slowly.
When releasing, only the focus will be moved.
On the touchable view (not item), touch & move will activate and through the touch & move, 
function will be activated -> micro control activates through touch & move on the video player.

Release

Action of removing your finger from the screen (The moment that the function is activated).
(Used with a “press” or “long press”).
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Understanding the status LED

The color of the status LED indicates the machine's current status.

 

Check the message on the display screen. Follow the instructions in the message or refer to the troubleshooting chapter (see "Understanding display 
messages" on page 145). If the problem persists, call for service.

Status
Description

Off • The machine is off-line.
• The machine is in power saver mode. When data is received, or any button is pressed, it switches to on-line automatically.

Green On The machine is on-line and can be used.

Blinking Fax The machine is sending or receiving faxes.

Copy The machine is copying documents.

Scan The machine is scanning documents.

Print • When the status LED slowly blinks, the machine is receiving data from the computer.
• When the status LED blinks rapidly, the machine is printing data. 

Red On • The imaging unit is at the end of its lifespan. Remove the old imaging unit and install a new one.

• The toner cartridge lifea is totally empty. Remove the old toner cartridge and install a new one.
• A paper jam has occurred (see "Clearing paper jams" on page 137).
• The door is open. Close the door.
• There is no paper in the tray. Load paper in the tray (see "Loading paper in the tray" on page 39).
• The machine has stopped due to a major error. Check the display message (see "Understanding display messages" on 

page 145). 
• The waste toner container is not installed in the machine, or the waste toner container is full (see "Replacing the waste toner 

container" on page 132).

a.Estimated cartridge life means the expected or estimated toner cartridge life, which indicates the average capacity of print-outs and is designed pursuant to 
ISO/IEC 19798. The number of pages may be affected by operating environment, printing interval, media type, and media size. Some amount of toner may 
remain in the cartridge even when the red LED is on and the printer stops printing.

Blinking • A minor error has occurred and the machine is waiting for the error to be cleared. Check the display message 
(see "Understanding display messages" on page 145). When the problem is cleared, the machine resumes its original task. 

• The toner cartridge lifea, imaging unit, or waste toner container is near the end of its life. Order a new toner cartridge, imaging 
unit, or waste toner container. You can temporarily improve print quality by redistributing the toner.
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Turning the machine on

 

Keep in mind that you should use the power cord supplied with the 
machine. Otherwise, it can cause fire or damage to the machine.

1. Plug the power cord into the power receptacle.

2. Plug the other end into a properly grounded AC outlet.

3. Turn on the main power switch.

 

• Some parts inside of the machine may be hot when power is on, or 
after printing. Be careful not to burn yourself when working inside 
the machine.

• Do not disassemble the machine when it is turned on or plugged 
in. Doing so may give you an electric shock.
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Turning the machine off

If you need to turn the machine off, press the Power button for more than 
three seconds on the right side of the control panel. When the confirmation 
window appears, press Yes from the display screen, then wait until power is 
turned off automatically.

 

• The machine has three types of power off mode. Press the 
Machine Setup > General Settings > Power Button Operation. 
The Power Button Operation option can only be configured by an 
authorized user who has registered an ID and a password on the 
machine. For detailed information about the power off mode using 
the Power button, refer to the Administrator’s Guide.

• You can also turn the machine on by pressing the Power button.

 

If you turn the machine off directly using the main power switch above 
the power receptacle, it could cause a hard disk problem in the 
machine.

Connecting a printer cable

Using a network cable
This machine has a bulit-in network interface card. You can connect your 
machine to a network using a network cable.
Connect your machine to the network with a network cable:
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Introducing the display screen and useful 
buttons

Display screen
The display screen on the control panel allows user-friendly operation of the 

machine. Once you press the home icon ( ) on the screen, it shows the 
display screen. The display screen image in this user’s guide may differ 
from your machine depending on its options or models.

 

• Icons shown on the display screen such as Fax may be grayed 
out, depending on the optional kit or program installed in your 
machine.

• To switch to the next display screen, press the right arrow or drag 
your finger across the display screen .

• Depending on the authentication setting, the machine’s users have 
to enter an ID and a password. In this case, the machine can only 
be used by an authorized user who has registered an ID and a 
password on the machine. Contact the machine’s administrator.

• Copy: Enters the Copy menu (see "Copying" on page 50).
• Fax: Enters the Fax menu. Fax is activated on the display screen by 

installing an optional fax kit (see "Faxing (optional)" on page 65).
• Stored Document: Enters the Stored Document menu (see 

"Understanding the Stored Document screen" on page 92).
• Shared Folder: Enters the Shared Folder menu (see "Understanding 

the Shared Folder screen" on page 91).
• Scan to Email: Enters the Scan to Email menu (see "Scanning 

originals and sending through email (scan to email)" on page 77).
• Scan to Server: Enters the Scan to Server menu (see "Scanning 

originals and sending via SMB/FTP (Scan to server)" on page 78).
• Scan to PC: Enters the Scan to PC menu (see "Scanning originals and 

sending to your computer (scan to PC)" on page 86).
• Scan to Shared Folder: Enters the Scan to Shared Folder menu.

• Quick Copy: Enters the Quick Copy menu (see "Using the Quick Copy 

menu" on page 64).
• ID Copy: Enters the ID Copy menu (see "Using the Quick Copy menu" 

on page 64).
• USB: Enters the USB menu. When a USB memory device is inserted 

into the USB memory port on your machine, USB is activated on the 
display screen (see "Using a USB memory device" on page 116).

• Scan to USB: Enters the Scan to USB menu. When a USB memory 
device is inserted into the USB memory port on your machine, Scan to 
USB is activated on the display screen (see "Scanning originals and 
sending to a USB memory device (scan to USB)" on page 80).

• Machine Setup: You can browse current machine settings or change 
machine values. 

 

Some menus are only configured by an administrator or an 
authorized user who has an ID and password registered on the 
machine by an administrator. When the machine requests, enter 
the ID and password.

• SmarThru WorkFlow: Enters the SmarThru Workflow menu (see 
"using Smarthru Workflow, shared Folder, and stored document" on 
page 89).

Counter button
When you press the Counter button on the control panel, You can see the 
number of impressions.

When you select Device, you can see the number of impressions by device. 
An impression typically refers to a single side of a sheet and not a one-sided 
print.
• Total Usage: Displays the total number of impressions.
• Large Page: Displays the total number of impressions with large size 

paper.
• Send Usage: Displays the number of images sent via email, server, 

etc.
• Fax Send Usage(PSTN): Displays the number of sent faxes.
When you select User, you can see the number of usage, limit, and 
remaining usage by each user. For detailed information about Counter, 
refer to the Administrator’s Guide.

Eco button
The eco feature allows you to save print resources and leads you to 
eco-friendly printing. When you press the Eco button, the machine turns eco 
mode on or off. If the eco mode is on, you can see the eco image ( ) on 
some features. Some options in the features are not available to use in the 
eco mode. For detailed information about the eco feature, refer to the 
Administrator’s Guide.

 

• Only administrators have permission for Eco Setting in Machine 
Setup. 
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• If the machine requests a password for eco mode, you need to 
enter the password. Contact your administrator.

• The Eco button is activated only for Copy, Quick Copy and 
Stored Document menus.

Job Status button
When you press the Job Status button, the screen lists the currently 
running, queued, and completed jobs.

Current Job
Displays the list of jobs in progress and pending.
Pressing the job name shows more detailed information.
• No: Gives the order of jobs.
• Job Type: Displays type of the job, such as print, copy, fax, etc.
• Job Name: Displays the name of the job. 
• User: Displays the name of the job owner.
• Status: Displays the current status of each job (see "Meaning of 

status" on page 36).
• Promote: Promotes a selected job from the list when many jobs are 

queued. The selected job cannot be promoted in front of a job in 
progress.

 

You cannot use the Promote button depending on the state of 
the job.

• Job Hold: Holds a selected job from the list.

 

You cannot use the Job Hold button depending on the state of 
the job.

• Delete: Removes a selected job from the list.

Completed Job
Displays the list of completed jobs.
Pressing the job name shows more detailed information.
• No: Gives the order of jobs.
• Job Type: Displays type of the job, such as print, copy, fax, etc.
• Job Name: Displays the name of the job. 
• User: Displays the name of the job owner.
• Status: Displays the status of each completed job (see "Meaning of 

status" on page 36).

Meaning of status
• Receiving: The machine is receiving data from the network or fax 

line.
• Image Processing: The machine is processing the image 

(decoding, encoding, converting data format).
• Formatting: The machine is generating the image for printing.
• Pending: The job in the job queue is waiting for its turn.
• Transferring: The machine is transferring the data to email, server, 

or fax. 
• Scanning: The machine is scanning.
• Dialing: In the fax mode, the machine is dialing to the receiver’s fax 

machine.
• Connecting: In the fax mode, the machine is waiting to connect to 

destination.
• Printing: The machine is printing.
• Storing: The data is storing to a box or a USB.
• Delayed Job: The job is temporarily stopped until the time you set 

for Delay Send (email, fax, server).
• Held: In the Secured Job tab, the job is temporarily stopped when 

secure print job is sent from a computer. You can release the job by 
pressing Print.

• Held: Proof Print: The job is temporarily stopped when a proof print 
job is sent from a computer. You can release the job by pressing 
Release.

• Held: Proof Copy: In copy mode, the job is temporarily stopped 
when the proof copy was selected. You can release the job by 
pressing Release.

• Held: User Request: The job is temporarily stopped when Job 
Hold is pressed. You can release the job by pressing Release.

• Held: Delayed Print: The job is temporarily stopped until the time 
you set.

• Held: Needs Resources: The job is temporarily stopped when the 
machine has a problem such as paper empty, paper mismatch, etc.

• Interrupted: The job is temporarily stopped when the Interrupt 
button is pressed for an urgent copy job.

• Paused: The job is paused when the Stop button is pressed.
• Completed: The job is completed.
• Completed with error: The job is completed with error.
• Deleted: If you select a job in the list and press Delete, the job is 

deleted.

Secured Job
Displays the list of secured jobs the user has set in the printer driver (see 
"Confidential" on page 105). You need to enter the User ID and 
Password set in the printer driver (see "Confidential" on page 105).
• No: Gives the order of jobs.
• Job Type: Displays type of the job.
• Job Name: Displays the name of the job. 
• User: Displays the name of the job owner.
• Detail: Displays detailed information of the selected job. You can 

also change the number of copies by pressing Change Settings.
• Edit: Changes the Job Name of the selected job.
• Delete: Removes the selected job from the list.
• Print: Prints the selected job from the list.
• Close: Closes the job status window.

Status Description

Off The machine is not in Eco mode.

Green On The machine is in Eco mode.
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Active Notice
Displays any error messages and codes that have occurred.
• No: Gives the order of messages.
• Machine Status Message: Displays the error messages for the 

current errors in the machine.
• Error Code: Displays the error message's code.
• Detail: Displays detailed information of the selected job.
• Close: Closes the job status window.

Interrupt button

When you press Interrupt ( ), the machine goes into interrupt mode, 
which means it stops the current printing job for an urgent copy job. When 
the urgent copy job is completed, the previous printing job continues.

 

When you select the staple feature for a printing job, interrupt mode 
works after stapling is completed in the printing job.

Status Description

Off The machine is not in interrupt printing 
mode.

Green On The machine is in interrupt printing mode.
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2.Media and tray
This chapter provides information on how to load originals and print media into your machine.

This chapter includes:

• Loading originals
• Selecting print media
• Loading paper in the tray

• Printing on special media
• Tray setting

  

Loading originals

You can use the scanner glass or the duplex automatic document feeder 
(DADF) to load an original for copying, scanning, and sending a fax.

On the scanner glass
Make sure that no originals are in the DADF. If an original is detected in the 
DADF, the machine gives it priority over the original on the scanner glass. 
To get the best scan quality, especially for colored or gray-scaled images, 
use the scanner glass.

Preparing originals
• Do not load paper smaller than 25 x 25 mm (1.0 x 1.0 inch) or larger 

than 297 x 432 mm (11.7 x 17 inches).
• Make sure any glue, ink, or correction fluid on the paper is 

completely dry before loading.

1. Open the DADF.

2. Place the original face down on the scanner glass and align it with 
the registration guide at the top left corner of the glass.

3. Close the DADF.

 

• Leaving the DADF open while copying may affect copy 
quality and toner consumption.

• Dust on the scanner glass may cause black spots on the 
printout. Always keep it clean.

• If you are copying a page from a book or magazine, lift the 
DADF until its hinges are caught by the stopper and then 
close the lid. If the book or magazine is thicker than 30 mm 
(1 inch), start copying with the lid open.

 

• Be careful not to break the scanner glass. You may get 
hurt.

• Do not put hands on the scanner glass while closing the 
DADF. The DADF may fall on your hands and cause injury.

• Do not look at the light inside of the scanner while copying 
or scanning. It is harmful to eyes.

In the duplex automatic document feeder (DADF)

Preparing originals
• Do not load paper smaller than 140 x 140 mm (5.5 x 5.5 inches) or 

larger than 297 x 432 mm (11.7 x 17 inches).
• The DADF can automatically detect A3, A4 LEF, A4 SEF, B4, B5 

LEF, B5 SEF, A5 LEF, A5 SEF, Ledger, Legal, Letter LEF, Letter 
SEF, Statement LEF, and Statement SEF-sized originals.
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• Do not attempt to load the following types of paper, in order to 
prevent paper jams, low print quality, and machine damage.
- Carbon paper or carbon-backed paper
- Coated paper
- Onion skin or thin paper
- Wrinkled or creased paper
- Curled or rolled paper
- Torn paper

• Remove all staples and paper clips before loading.
• Make sure any glue, ink, or correction fluid on the paper is 

completely dry before loading.
• Do not load originals that include different sizes or weights of paper.
• Do not load booklets, pamphlets, transparencies, or documents with 

other unusual characteristics.

Using the DADF, you can load up to 100 sheets of paper (80 g/m2, 20 lb 
bond) for one job.

1. Flex or fan the edge of the paper stack to separate the pages before 
loading originals.

2. Load the originals face up into the DADF. Make sure that the bottom 
of the original stack matches the paper size marked on the document 
input tray.

3. Adjust the document width guides to the paper size.

 

Dust on the DADF glass may cause black lines on the printout. 
Always keep the glass clean.

Selecting print media

You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meet the guidelines 
for use with your machine. 

Guidelines to select print media
Print media that does not meet the guidelines outlined in this user’s guide 
may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size, and weight of the print media for your machine are 

described in print media specifications (see "Print media specifications" 
on page 165).

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

 

• Some print media may meet all of the guidelines in this user’s 
guide and still not produce satisfactory results. This may be the 
result of the sheets characteristics, improper handling, 
unacceptable temperature and humidity levels, or other variables 
over which cannot be controlled.

• Before purchasing large quantities of print media, ensure that it 
meets the requirements specified in this user’s guide. 

 

• Using print media that does not meet these specifications may 
cause problems or require repairs. Such repairs are not covered 
by Samsung’s warranty or service agreements.
The amount of paper put into the tray may differ according to 
media type used (see "Print media specifications" on page 165).

• Make sure not to use the inkjet photo paper with this machine. It 
could cause damage to the machine. 

• Using inflammable print media can cause a fire.
• Use designated print media (see "Print media specifications" on 

page 165).

 

The use of inflammable media or foreign materials left in the printer 
may lead to overheating of the unit and, in rare cases may cause a 
fire.

The amount of paper put into the tray may differ according to media type 
used (see "Print media specifications" on page 165).

Loading paper in the tray

Standard tray / optional dual cassette feeder
Load the print media you use for the majority of your print jobs into the 
standard tray. The standard tray can hold a maximum of 1,040 sheets of 
plain paper. 
You can purchase an optional dual cassette feeder and attach it below the 
standard tray to load an additional 1,040 sheets of plain paper.

 

• Standard tray contains two trays. (Tray 1, Tray 2)
• Optional dual cassette feeder contains two trays. (Tray 3, Tray 4)
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• The process to load paper in tray 1, tray 2, tray 3, and tray 4 is the 
same.

 

Using photographic paper or coated paper may cause problems, that 
require repairs. Such repairs are not covered by the warranty or 
service agreements.

1. Squeeze the lock lever on the handle and pull out the tray.

2. Squeeze the paper length guide, and pull it to the end of the tray.

 1

1 Paper length guide

3. Squeeze the paper width guide, and pull it to the end of the tray.

 1

1 Paper width guide

4. Flex and fan the edge of the paper stack to separate the pages before 
loading papers.

5. Load paper with the print side facing up.
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6. Adjust the paper length guide to the desired paper length.

7. After loading paper into the tray, pinch the paper width guide and move it 
toward the stack of paper until it lightly touches the side of the stack. Do 
not press the guide too tightly to the edge of the paper: the guide may 
bend the paper.

 

• Do not push the paper guide too far causing the media to warp.
• If you do not adjust the paper width guide, it may cause paper 

jams.

 

Do not overload the tray: it may cause paper jams. Make sure that 
the paper is below the maximum paper capacity guide inside the 
tray.

 1

M A X

1 Paper capacity guide
8. Fix the the paper length guide using the locking switch. Release the 

locking switch to load a different sized paper.

 1

1 Locking switch

9. Insert the tray back into the machine.
When you print a document, set the paper type and size for the tray.
For information about setting the paper type and size on the control 
panel (see "Tray setting" on page 47).
The standard tray and optional dual cassette feeder can automatically 
detect various-sized paper (see "Media sizes automatically detected" on 
page 44).
If you set the Tray Confirmation Message ON in Tray Settings, the 
confirmation window appears automatically (see "Setting the tray 
confirmation message" on page 47).
Check if the paper size and type in the tray are detected or not. If you 
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want to set the paper size and type or if the machine cannot detect them, 
you can set the size and type directly in the confirmation window.

 

• If you experience problems with paper feeding, check whether 
the paper meets the media specifications (see "Print media 
specifications" on page 165). Then, try placing one sheet at a 
time in the multi-purpose tray (see "Multi-purpose tray" on 
page 42).

• The settings made from the machine driver override the 
settings on the control panel.
To print from an application:

a) Open an application and start the print menu.
b) Open Printing Preferences (see "Opening printing 

preferences" on page 101).
c) Press the Paper tab in Printing Preferences, and select 

an appropriate paper type, size, and source. 
d) Press OK.
e) Start printing from an application.

Multi-purpose tray
The multi-purpose tray can hold special sizes and types of print material, 
such as postcards, note cards, and envelopes. It is useful for single page 
printing on colored paper.

Tips on using the multi-purpose tray
• Load only one type, size, and weight of print media at a time in the 

multi-purpose tray.
• To prevent paper jams, do not add paper while printing when there is 

still paper in the multi-purpose tray. This also applies to other types 
of print media.

• Print media should be loaded face down with the top edge going into 
the multi-purpose tray first and be placed in the center of the tray.

• Always load only the specified print media to avoid paper jams and 
print quality problems (see "Print media specifications" on page 165).

• Flatten any curl on postcards, envelopes, and labels before loading 
them into the multi-purpose tray.

1. Open the multi-purpose tray and pull out the extention if necessary.

2. Flex or fan the edge of the paper stack to separate the pages before 
loading originals.
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3. Load the paper with the side to be printed on facing down.

4. Squeeze the multi-purpose tray paper width guides and adjust them 
to the width of the paper. Do not force too much, otherwise the paper 
will bend resulting in a paper jam or skew.

5. When you print a document, set the paper type and size for the 
multi-purpose tray (see "Media sizes automatically detected" on 
page 44).
For information about setting the paper type and size on the control 
panel (see "Tray setting" on page 47).

 

The settings made from the machine driver override the 
settings on the control panel.
To print from an application:

a) Open an application, and start the print menu.
b) Open Printing Preferences (see "Opening printing 

preferences" on page 101).
c) Press the Paper tab in Printing Preferences, and select 

an appropriate paper type, size, and source. 
d) Press OK.
e) Start printing from an application.
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Media sizes automatically detected
This machine can automatically detect various sized-paper. Refer to the 
table below.

(●: Detected, o: Not detected, Blank: You cannot load the paper in the tray.)

Printing on special media

The table below shows the available special media for each tray.

 

When using special media, we recommend you feed one piece of 
paper at a time. Check the maximum input number of media for each 
tray (see "Print media specifications" on page 165).

(●: Included, Blank: Not available)

 

The media types are shown in the Printing Preferences. This paper 
type option allows you to set the type of paper to be loaded in the tray. 
This setting appears in the list so that you can select it. This will let you 
get the best quality printout. If not, the desired print quality may not be 
achieved.

sizea

a.This machine can detect paper of similar sizes as the listed paper 
sizes.

Standard tray/ 
optional dual 

cassette feeder

Multi-purpose 
tray

Duplex 
printing

Letter SEFb

b.SEF meaning is Short Edge Feed.

● o Available

Letter LEFc

c. LEF meaning is Long Edge Feed.

● o Available

Ledger ● o Available

Legal ● o Available

Executive SEF o o Available

Executive LEF o Available

Statement SEF ● o Available

Statement LEF o

A3 ● o Available

A4 SEF ● o Available

A4 LEF ● o Available

A5 SEF ● o Available

A5 LEF o

B4 ● o Available

JIS B5 SEF ● o Available

JIS B5 LEF o Available

A6 SEF o

A6 LEF o

ISO B5 SEF o o Available

ISO B5 LEF o

Folio o o Available

Oficio o o Available

8K o o Available

16K o o Available

Types
Standard tray/ 
optional dual 

cassette feeder
Multi-purpose tray

Thick ● ●

Heavy weight ● ●

Extra Heavy weight 1 ● ●

Thin ● ●

Cotton ● ●

Color ● ●

Preprinted ● ●

Recycled ● ●

Bond ● ●

Archive ● ●

Letterhead ● ●

Punched ● ●

Thin Cardstock ● ●

Thick Cardstock ● ●

Thin Glossy ●

Thick Glossy ●

Envelope ●

Labels ●
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Envelope
Successful printing on envelopes depends upon the quality of the 
envelopes. 
To print an envelope, place it with the flap side up.

• When selecting envelopes, consider the following factors:
- Weight: The weight of the envelope paper should not exceed 

90 g/m2 (16 lb) otherwise, a jam may occur.
- Construction: Prior to printing, envelopes should lie flat with less 

than 6 mm (0.25 inches) curl, and should not contain air.
- Condition: Envelopes should not be wrinkled, nicked, or damaged.
- Temperature: Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.

1  Acceptable

2  Unacceptable
• Envelopes with a peel-off adhesive strip or with more than one flap that 

folds over to seal must use adhesives compatible with the machine’s 
fusing temperature of about 170°C (338 °F) for 0.1 second. The extra 
flaps and strips might cause wrinkling, creasing, or jams, and may even 
damage the fuser.

• For the best print quality, position margins no closer than 15 mm (0.6 
inches) from the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Labels
Load the paper with the side to be printed on facing down.
To avoid damaging the machine, use only labels designed for use in laser 
machines.

• When selecting labels, consider the following factors:
- Adhesives: The adhesive material should be stable at your 

machine’s fusing temperature of about 170°C (338 °F) for 0.1 
second.

- Arrangement: Only use labels with no exposed backing between 
them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with no more than 13 mm 
(0.5 inches) of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

• Make sure that there is no exposed adhesive material between labels. 
Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are 
wrinkled, bubbled, or damaged.
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• Do not load paper that does not have space between labels running the 
same direction as the paper is being fed. Otherwise, it could cause 
paper jams.

Card stock/ Custom-sized paper

• Do not print on media smaller than 98 mm (3.8 inches) wide or 148 mm 
(5.8 inches) long.

• In the software application, set margins to at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Letterhead/Preprinted paper

• Preprinted paper must be printed with heat-resistant ink that will not 
melt, vaporize, or release hazardous emissions when subjected to the 
machine’s fusing temperature of about 170°C (338 °F) for 0.1 second.

• Preprinted paper ink must be non-flammable and should not adversely 
affect machine rollers.

• Forms should be sealed in a moisture-proof wrapping to prevent 
changes during storage.

• Before you load preprinted paper, verify that the ink on the paper is dry. 
During the fusing process, wet ink can come off preprinted paper, 
reducing print quality.

Glossy

 

Load a single sheet of paper into the multi-purpose tray at a time, 
glossy side facing down.

• Recommend media: Glossy paper (Letter) for this machine by HP 
Brochure Paper (Product: Q6611A) only.

• Recommend media: Glossy paper (A4) for this machine by HP Superior 
Paper 160 glossy (Product: Q6616A) only.

Single-sided double-sided

Standard tray/
Optional dual 
cassette feeder

Face up Face down

Multi-purpose tray Face down Face up
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Tray setting

After loading paper in the paper tray, set the paper size and type using the 
display screen. For computer printing, select the paper size and type in the 
application program you use on your computer (see "Opening printing 
preferences" on page 101).

 

The settings made from the machine driver override the settings on 
the display screen.

Setting the paper size
1. Press Machine Setup > Tray Settings > Settings > select the tray you 

want from the display screen.

2. Press Paper Size and select the paper size.

• If there is no required size paper or you need to use custom size 
paper, press the Custom Size Button to set the paper size. You can 
also set and save the custom size using Custom Size. You can 
select the custom size whenever you need it.

Setting the paper type
1. Press Machine Setup > Tray Settings > Settings > select the tray you 

want from the display screen.

2. Press Paper Type and select the paper type.

3. Press  to save the selection.

Setting the tray confirmation message
When you load paper into a tray, you can set the confirmation message to 
appear automatically; or not at all. This machine can detect some paper 
sizes and types automatically. If you want to set the paper size and type, or 
the machine cannot detect them, you can set the size and type directly in 
the confirmation window.

1. Press Machine Setup > Tray Settings > Settings > select the tray you 
want from the display screen.
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2. Press the button in Tray Confirmation Message to activate this 
function.

Auto tray switch
This is the option to set if the machine is to continue printing or not when 
any tray becomes empty. For example, both tray 1 and tray 2 are filled with 
the same size paper, the machine automatically prints from tray 2 after the 
tray 1 runs out of paper.

1. Press Machine Setup > Tray Settings > Settings > Auto Tray Switch.

2. Press the button on the right to activate this function.

Auto continue
This option allows you to continue printing when the paper size you have set 
is mismatched with the paper in the tray. When this option is activated, the 
machine continues printing using similar or large size paper. If this option is 
inactivated, the machine waits until the required size paper is loaded in the 
tray.

1. Press Machine Setup > Tray Settings > Settings > Auto Continue.

2. Choose one of the options.

Paper substitution
When the requested paper for a print job is not available in the tray, this 
feature allows you to substitute similar paper size, For example, if the 
requested ledger sized paper is not available in the tray, this machine 
substitutes A3 for the requested paper. 

 

When the paper is substituted, some image loss may occur.

1. Press Machine Setup > Tray Settings > Settings > Paper 
Substitution.

2. Press the button on the right to activate this function.

Tray protection
When you choose this option, the selected tray will be protected. This will be 
used to prevent like paper from being fed if Auto Switching is “ON”. 
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1. Press Machine Setup > Tray Settings > Settings > Tray Protection.

2. Choose tray and press the button to activate this function.

Tray priority setting
When you do not select the tray for printing, the tray selected as in the Tray 
Priority Setting will be used in order. If the tray does not have the paper on 
which you want to print, the machine automatically prints from the trays in 
the priority order set.

1. Press Machine Setup > Tray Settings > Settings > Tray Priority 
Setting.

2. Press a tray, and give priority in the order for printing job using UP and 
Down Arrows.
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3.Copying
This chapter gives you step-by-step instructions for copying documents.

This chapter includes:

• Understanding the copy screen
• Basic copy
• Changing the settings for each copy

• Using special copy features
• Using a program’s setting
• Using the Quick Copy menu

  

Understanding the copy screen

When you press Copy from the display screen, the Copy screen appears 
which has several tabs and lots of copying options. All the options are 
grouped by features so that you can configure your selections easily.

If a different screen is displayed, press ( ) to go to the home display 
screen.

Basic tab

• Copies: Enters the number of copies.
• Paper Source: Selects the paper source tray (see "Selecting the Paper 

Source tray" on page 52).
• Reduce/Enlarge: Reduces or enlarges the size of a copied image (see 

"Reducing or enlarging copies" on page 52).

• Duplex: Sets the machine to print copies on both sides of the paper 
(see "Copying multiple sides" on page 52).

• Color Mode: Selects a color mode for making copies (see "Selecting 
the color mode (CLX-9201 9301 Series only)" on page 53).

• Output: Sets the machine’s various output options (see "Deciding the 
form of copy output" on page 53).

• Darkness: Adjusts the brightness level to make a copy for easier 
reading, when the original contains faint markings and dark images (see 
"Changing the darkness" on page 54).

• Programs: Allows you to save the current settings for future use (see 
"Using a program’s setting" on page 64).

Advanced tab

• Original Size: Selects the actual paper size of the originals (see 
"Selecting the size of originals" on page 55).

• Original Orientation: Selects the orientation of the originals (see 
"Selecting the orientation of originals" on page 55).

• ID Copy: Prints 2-sided originals on one sheet of paper. This feature is 
helpful for copying a small-sized item, such as a business card (see "ID 
card copying" on page 56).

• N-Up: Prints 2 or more original images, reduced to fit onto one sheet of 
paper (see "N-up copying" on page 57).

• Booklet: Allows you to create booklets (see "Booklet copying" on 
page 60).

• Book Copy: Allows you to copy the left or/and right pages of book on 
separate output paper (see "Book copying" on page 60).

• Watermark: Allows you to print a watermark on printouts (see 
"Watermark" on page 61).

• Stamp: Allows you to print with some information such as date and time 
(see "Stamp" on page 62).
Copying_ 50



Image tab

• Original Type: Improves the copy quality by selecting the original’s 
type for the current copy job (see "Selecting the type of originals" on 
page 62).

• Adjust Background: Prints an image with a lighter background.(see 
"Adjusting background" on page 62).

• Erase Backside Image: Prevents copying the original’s image shown 
through on the backside (see "Erasing backside Images" on page 63).

Basic copy

This is the normal and usual procedure for copying your originals.

1. Press Copy from the display screen.

2. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Paper Source, 
Reduce/Enlarge, Duplex and more in the Basic tab (see "Changing the 
settings for each copy" on page 52).

4. Set the copy features in the Advanced or Image tabs, if necessary (see 
"Using special copy features" on page 55).

5. Enter the number of copies using the numeric keypad on the control 
panel, if necessary.

6. Press (Start) from the control panel to begin copying.

 

• To cancel the current copy job, press (Stop) on the control 

panel. 
• You can delete current and pending jobs using Job Status on the 

control panel. Select the job you want to cancel and press Delete 
(see "Job Status button" on page 36).

Copying originals of different sizes
This feature allows you to copy originals of different sizes at once. 

 

• If you want to copy different sized originals at once, select Mixed 
Size under the Original Size option (see "Selecting the size of 
originals" on page 55). Otherwise, it could cause original- 
document jams.

• We recommend the below combinations to be used for copying 
different sized originals. You can use other combinations that are 
not recommended, but it could cause original-document jams. 
Depending on the default paper size (A4 or Letter), the 
combinations are diffent as follows.
If A4 is the default paper size,
- A3 and A4 LEF
- B4 and B5 LEF
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- A4 SEF and A5 LEF
- Letter LEF and Ledger
If Letter is the default paper size,
- A3 and A4 LEF
- B4 and B5 LEF
- Ledger and Letter LEF
- Legal, Letter SEF and Statement LEF

1. Press Copy from the display screen.
2. Place the different sized originals face up in the DADF. When you place 

them in the DADF, align and gently push them to the rear side of the 
DADF width guide.

3. Press the Advanced tab > Original Size > Mixed Size from the display 
screen.

 

The Mixed Size option is activated when the originals are placed 
in the DADF.

4. Adjust the settings for each copy such as Paper Source, Duplex and 
more in the Basic tab (see "Changing the settings for each copy" on 
page 52).

5. Set the copy features in the Advanced or Image tab, if necessary (see 
"Using special copy features" on page 55).

6. Enter the number of copies using the numeric keypad on the control 
panel, if necessary.

7. Press (Start) from the control panel to begin copying.

Changing the settings for each copy

On the Basic tab of the Copy screen, you can select copy features before 
starting to copy.

 

The Basic tab setting is only for the current copy job, which means the 
selected settings do not apply to the next copy job. After finishing the 
current copy job, the machine automatically restores the default 
settings, or when you press the Clear button on the control panel.

Selecting the Paper Source tray
Paper Source sets the tray containing the paper to be used for printing. The 
machine prints the scanned image on the paper in the selected tray. You 
can see the icons that show paper sizes and the remaining amount of paper 
in each tray. 
Press the Basic tab > Paper Source, then press the appropriate paper tray. 
• Auto: Automatically detects the paper size with the paper tray.
• Other preset values: Check the paper size in each tray and press the 

tray containing the paper size you want.

Reducing or enlarging copies
Using the Reduce/Enlarge feature allows you to print an original image 
reducing or enlarging it to fit the paper. You can press the icons that show 
how to reduce and enlarge copies. 
Press the Basic tab > Reduce/Enlarge, then press the appropriate option 
to reduce or enlarge an image on the paper.

 

When you use this option, Booklet in the Advanced tab are inactive.

• Original(100%): Prints texts or images the same size as originals.
• Auto Fit: Reduces or enlarges the original based on the size of the 

output paper.
• Other preset values: Check the image and value on each icon and 

press the one you want to use.

You can select an option by pressing a button in the Reduce and Enlarge 
list. You can also reduce or enlarge by 1% between 25 ~ 400% to print a 
copy using the left/right arrows.
• Custom: You can set and save the custom zoom values (between 25 ~ 

400%) using Custom. You can select custom values whenever you need 
it. 

Copying multiple sides
The duplex feature allows you to copy one-sided or two-sided originals on 
both sides of the paper or divide two-sided originals into multiple one-sided 
copies. Check the available paper using the Duplex feature. You can only 
use this feature with Letter SEF, Letter LEF, Ledger, Legal, Executive SEF, 
Statement SEF, A3, A4 SEF, A4 LEF, A5 SEF, B4, JIS B5 SEF, ISO B5 
SEF, 8K, 16K, and Oficio.

 

• 63 to 163 g/m2 (16~43 lb bond) only

Press the Basic tab > Duplex, then press the appropriate duplex option.

 

If an original is placed on the scanner glass and you press 1 -> 2 
Sided, 2 -> 1 Sided or 2 -> 2 Sided, the message Do you want to 
scan another page? appears after the first page is copied. Load 
another original and press Yes. When you finish, press No on this 
window.

• 1 -> 1 Sided: Scans one side of an original and prints it on one side of 
the paper. This function produces exactly the same printout from the 
originals.

• 1 -> 2 Sided: Scans one side of originals and prints them on both sides 
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of the paper.
• 2 -> 1 Sided: Scans both sides of the originals and prints each one on a 

separate page.
You can select the original binding type: either Book or Calendar. 

• 2 -> 2 Sided: Scans both sides of the original and prints on both sides 
of the paper. This function produces exactly the same printout from the 
originals.
You can select the original and output binding type: either Book or 
Calendar.

Selecting the color mode (CLX-9201 9301 Series 
only)
The machine provides many powerful effects on images without having 
expert editing skills. 
Press the Basic tab > Color Mode, then select the color mode you want. 

If you press the More button, you can see more Color Mode options.
• Auto: Select this setting to automatically detect whether the scanned 

document is in color or black and white, and then select an appropriate 
color setting.

• Full Color: Select this setting to print the same as the original image 
color.
Refer to the sample images below. Depending on the circumstances 
and quality of originals, the printout’s quality could be different from the 
sample image’s.

• B/W: Select this setting to print the copy in black and white, regardless 
whether the scanned document is in color or in black and white.
Refer to the sample images below. Depending on the circumstances 

and quality of originals, the printout’s quality could be different from the 
sample image’s.

Deciding the form of copy output

 

• You can use the copy output options when an optional Inner 
Finisher or a booklet finisher is installed.

• Depending on the direction of paper in the tray (e.g., SEF or LEF), 
certain directions for stapling may not be available.

Press the Basic tab > Output, then select the copy output options you 
want.

• Collated: Printouts in sets to match the sequence of originals.Original Copy

Original Copy
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• Uncollated: Printouts sorted into stacks of individual pages.

• Rotate: Printouts are stacked criss-crossed in sets.

 

• This feature is available only when the standard or booklet 
finisher is not installed.

• This feature is available only with Letter- and A4-sized print 
media.

• Before using this feature, you have to load the paper in the 
trays with SEF (Short edge feed) and LEF (Long edge feed). 
For example, direction of paper feeding in tray 1 is SEF, and 
direction of paper feeding in tray 2 is LEF.

-

Changing the darkness
Press the Basic tab. You can adjust the degree of darkness using the 
left/right arrows. This feature allows dark images to be printed into lighter 
images, or light images into darker images.

Refer to the sample images below. Depending on the circumstances and 
quality of originals, the printout’s quality could be different from the sample 
image’s.

Light Slightly 
light

Original Slightly 
dark

Dark
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Using special copy features

On the Advanced or Image tab of the Copy screen, you can select specific 
copy features.

Selecting the size of originals
Copies can be produced after specifying the document scanning size if the 
document size cannot be detected automatically or if you wish to specify a 
certain document size.

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Paper Source, Duplex and 
more in the Basic tab (see "Changing the settings for each copy" on 
page 52).

4. Press Advanced tab > Original Size from the display screen.
5. Select the original size.

 

You can change the paper list on the display screen pressing Inch 
Size or mm Size. The paper list is divided into the available A/B 
size type and letter size type paper in this machine.

• Custom: If there is no required paper size or you need to use 
custom sized paper, press the cardinal point arrows to set the 
original size. You can also set and save the custom size using 
Custom Size. You can then select the custom size whenever you 
need it.

 

The custom size available is different depending on where the 
originals are placed.

• Auto: Automatically detects the size of originals, but this option is 
supported only when originals are A3, A4 LEF, A4 SEF, B4, B5 LEF, 
B5 SEF, A5 LEF, A5 SEF, Ledger, Legal, Letter LEF, Letter SEF, 
Statement LEF and Statement SEF-sized. 
If you use non-standard-sized paper, image loss could occur. In this 
case, you need to select the appropriate paper size before you print.

• Mixed Size: Allows the use of both of Letter and Legal-sized papers 
together, and the machine uses the proper-sized paper from several 

trays. For example, if the originals total 3 pages, the 1st page is 
letter-sized paper, the 2nd page is legal-sized paper, and the 3rd 
page is letter-sized paper, then the machine prints the output first 
letter, legal, and letter in order from several trays.

 

Mixed Size is activated when the originals are placed in the 
DADF.

• Other preset values: You can select the size of originals directly by 
pressing the buttons.

6. Press OK from the display screen.
7. Press Start on the control panel to begin copying.

Selecting the orientation of originals
When copying double-sided documents or making double-sided copies or 
combined copies, specify the document orientation; otherwise, the copies 
may not be printed in the correct page order or correct front and back page 
arrangement.

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Press Advanced tab > Original Orientation from the display screen.
4. Select the orientation of the original document.

• Upright Images: Select this setting for an original document loaded 
with the top toward the back of the machine.

• Sideways Images: Select this setting for an original document 
loaded into the DADF with the top of the original document toward 

In the DADF On the scanner glass

Minimum size 128 x 128 mm 
(5 x 5 inches)

25 x 25 mm 
(1.0 x 1.0 inches)

Maximum size 297 x 432 mm 
(11.7 x 17.0 inches)

297 x 432 mm 
(11.7 x 17.0 inches)

Using the DADF Using the scanner 
glass

Icon
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the left side of the machine or an original document placed on the 
scanner glass with the top of the original document toward the right 
side of the machine.

5. Press Start on the control panel to begin copying.

ID card copying
The machine prints one side of the original on the upper half of the paper 
and the other side on the lower half without reducing the size of the original.
This feature is helpful for copying a small-sized item, such as a business 
card.

 

• This copy feature is available only when you place originals on the 
scanner glass.

• The size of the 2-sided originals should be smaller than A5, if not, 
some of it won’t be copied. 

1. Press Copy from the display screen.

2. Press the Advanced tab > ID Copy from the display screen.

3. Select a tray in Paper Source.
4. Follow the steps on the display screen.
5. Place the front side of an original facing down on the scanner glass as 

shown below, and close the DADF. 

 

When you place an original on the scanner glass, leave a little 
space between the edge of the scanner glass and the original. 
Otherwise, part of original may not be printed.

6. Press Start on the control panel. Then the machine starts scanning.
7. Turn the original over and place it on the scanner glass as shown below, 

and then close the DADF.

 

When you place an original on the scanner glass, leave a little 
space between the edge of the scanner glass and the original. 
Otherwise, part of original may not be printed.

Using the DADF Using the scanner 
glass

Icon
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8. Press Start on the control panel to begin copying.

 

• If the original is larger than the printable area, some portions may 
not be printed.

• If you do not press the Start button, only the front side will be 
copied.

• If you press the Stop button, the machine cancels the copy job 
and returns to ready mode.

N-up copying
The machine reduces the size of the original images and prints 2 - 9 pages 
onto one sheet of paper.

 

• When you use this option Auto Fit, ID Copy, Booklet and Book 
Copy in the Advanced tab are inactivated.

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Press Advanced tab > N-Up from the display screen.
4. Press an option according to how many images to copy onto one page.

• Off: Copies an original onto one sheet of paper.
• 2Up - 9Up: Copies corresponding numbers of separate originals to 

one page.

 

Depending on original document size, output paper size, and the 
reduced rate of image, some options may be inactivated.

5. Select a tray in Paper source.
6. Press the appropriate page order.

• Depending on the options you select, the result will vary. Refer to the 
below table before using the 2Up option.
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Original orientation 
(DADF/Scanner glass) 

Original orientation
(display screen)

Direction of paper 
feeding in the tray

Available 
orientation

Result

In the DADF

On the scanner glass

Upright Images LEFa or SEFb Left-to-Right
or

Right-to-Left

Left-to-Right

Right-to-Left

In the DADF

On the scanner glass

Sideways Images LEF or SEF
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• All other page order options of N-up are the same except for the 2Up. You can press Right-to-Down, Left-to-Down, Down-to-Left, and Down-to-Right.

In the DADF

On the scanner glass

Sideways Images LEF or SEF Top-to-Down
or

Down-to-Top

Top-to-Down

Down-to-Top

In the DADF

On the scanner glass

Upright Images LEF or SEF

a.LEF meaning is Long Edge Feed.

b.SEF meaning is Short Edge Feed.

Original orientation 
(DADF/Scanner glass) 

Original orientation
(display screen)

Direction of paper 
feeding in the tray

Available 
orientation Result
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7. Press Start on the control panel to begin copying.
If an original is placed on the scanner glass, the machine shows the 
window asking if you want to place another page. Load another original 
and press Yes. When you finish, press No on this window.

Booklet copying
The machine automatically prints on one or both sides of the paper, which 
are then folded to produce a booklet with all the pages in the correct 
sequence.
The machine will also reduce and correctly adjust the position of each 
image to fit on the selected paper. 

 

• When you use this option , ID copyOriginal Orientation, N-Up, 
Book Copy, and watermark in in the Advanced tab are disabled.

• This feature is possible only with Letter, Legal, A4, JIS B5, 
Statement, Executive, A5, 8K, 16K, Ledger, A3, and JIS B4 sized 
print media.

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Duplex and more in the Basic 
tab (see "Changing the settings for each copy" on page 52).

4. Press the Advanced tab > Booklet from the display screen.
5. Select a tray in Paper Source.
6. Press the appropriate option.

• Off: Disables this feature.

• 1-Sided Original: Copies from one side of the original to one page 
of a booklet.

• 2-Sided Original Book: Copies each side of an original to one page 
of a booklet.

• 2-Sided Original Calendar: Copies each side of an original to one 
page of a booklet. The second side of each original is rotated 180 
degrees so the text will be upright in the booklet.

Book copying
Use this feature to copy a book. If the book is too thick, lift the DADF until its 
hinges are engaged by the stopper and then close the DADF. If the book or 
magazine is thicker than 30 mm (1.18 inches), start copying with the DADF 
open.

 

• This copy feature is available only when you place originals on the 
scanner glass.

• When you use this option, Original Orientation, N-Up and 
Booklet in the Advanced tab are disabled.
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1. Press Copy from the display screen.
2. Place a book page face down on the scanner glass (see "Loading 

originals" on page 38).

 

• When you place a book on the scanner glass, leave a little 
space (about 10 mm) between the top or bottom edge of the 
scanner glass and the book.

• Some books may not be available in this feature such as a 
hard-cover book, poorly bound book, etc.

3. Adjust the settings for each copy such as Paper Source, Duplex and 
more in the Basic tab (see "Changing the settings for each copy" on 
page 52).

4. Press the Advanced tab > Book Copy from the display screen.
5. Press the appropriate option.

• Off: Disables this feature.
• Left Page: Prints only the left page of the book.

• Right Page: Prints only the right page of the book.

• Both Pages(From Left):  Prints both facing pages from the left 
page.

• Both Pages(From Right):  Prints both facing pages from the right 
page. 

• Book Center & Edge Erase: Erases shadows of a binding or book 
edge from the center and side edges of copies.

6. Press Start on the control panel to begin copying.

Watermark
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

 

This feature may not be available depending on models or option kits 
installed.

There are several predefined watermarks that come with the machine. You 
can also enter a personalized watermark. 

 

When you use this option, Booklet in the Advanced tab is disabled.

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Paper Source, 
Reduce/Enlarge, Duplex and more in the Basic tab (see "Changing the 
settings for each copy" on page 52).

4. Press the Advanced tab > Watermark from the display screen.
5. Press the appropriate option.

• Off: Disables this feature.
• Other preset values: Allows you to easily select values commonly 

used.
• Custom: Allows you to enter a text message using the pop-up 

keyboard.
6. Set the Watermark settings.

• Pages: Select to print the option on all pages or only the first page.
• Text Color/Size: Select the text message color and size.
• Position: Select the printed position of the text message.

7. Press Start on the control panel to begin copying.
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Stamp
Prints the date and time, IP address, device information, and the entered 
comment on printouts. 

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Paper Source, Duplex and 
more in the Basic tab (see "Changing the settings for each copy" on 
page 52).

4. Press the Advanced tab > Stamp from the display screen.
5. Check the button on the right.
6. Press the checkbox on the right.

• IP Address: This option allows you to print a IP Address on the 
printouts.

• ID: This option allows you to print a user ID on the printouts.
• Device information: This option allows you to print a device 

information on the printouts.
• Comment: This option allows you to print your comment on the 

printouts.
• Time & Date: This option allows you to print time and date stamps 

on the printouts.
7. Press OK from the display screen.
8. Press Start on the control panel to begin copying.

Selecting the type of originals
The original type setting is used to improve copy quality by selecting 
document types for current copy jobs.

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Paper Source, 
Reduce/Enlarge, Duplex and more in the Basic tab (see "Changing the 
settings for each copy" on page 52).

4. Press the Image tab > Original Type from the display screen.
5. Press the appropriate option.

• Text: Use for originals containing mostly text.
• Text/Photo (Text & Printed Photo): Use for originals containing 

text mixed with photographs.
• Photo: Use for photographs.
• Copied Original: Use for copied documents.
• Map: Use for maps.
• Light Original: Use for light documents.

6. Press Start on the control panel to begin copying.

Adjusting background
This feature is helpful when copying originals containing color in the 
background, such as in newspapers or catalogs.

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Paper Source, 
Reduce/Enlarge, Duplex and more in the Basic tab (see "Changing the 
settings for each copy" on page 52).

4. Press the Image tab > Adjust Background.
5. Press the appropriate option.

• Off: Disables this feature.
• Auto: Optimizes the background.
• Enhance: The higher the number is, the more vivid the background. 
• Erase: The higher the number is, the lighter the background. 

6. Press Start on the control panel to begin copying.
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Erasing backside Images
When the original is thin and backside images show through, you can use 
this feature to remove the backside images.

1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Paper Source, 
Reduce/Enlarge, Duplex and more in the Basic tab (see "Changing the 
settings for each copy" on page 52).

4. Press the Image tab > Erase Backside Image.
5. Press the appropriate option.

• Off: Disables this feature.
• Erase: The higher the number is, the lighter the backside image is. 

6. Press Start on the control panel to begin copying.
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Using a program’s setting

This option allows you to save the current settings for future use. You can 
also use the previous settings from the last job.

Saving Programs
1. Press Copy from the display screen.
2. Adjust the settings for each copy such as Paper Source, Duplex and 

more in the Basic tab (see "Changing the settings for each copy" on 
page 52).

3. Set the copy features in the Advanced or Image tabs, if necessary (see 
"Using special copy features" on page 55).

4. Press the Basic tab or Back.
5. Enter the number of copies using the numeric keypad on the control 

panel, if necessary.
6. Press Programs.
7. Press Save.
8. Press Program Name input area. The pop-up keyboard appears.

Enter the program name you want. Press Done.

 

You can see the values of set Programs by scrolling up or down 
and check the values using the up/down arrows.

9. Press Save. When the confirmation window appears, the settings you 
set are saved. Press OK to check the list or Cancel.

Loading Programs
1. Press Copy from the display screen.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Press Programs > Load.
4. Press a program name you want to use on the list.
5. Press Apply.

The machine is now set to copy according to the setting you selected.
6. Press Start from the control panel to begin copying.

Using the Quick Copy menu

The Quick Copy menu allows you to quickly set copy options without 
having to move to a lower level menu or another tab. But, this menu does 
not provide all copy options. If you need to use other copy options, use the 
copy options in the Copy menu (see "Changing the settings for each copy" 
on page 52 or "Using special copy features" on page 55).

1. Press Quick Copy from the display screen.

2. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Adjust the settings for each copy such as Reduce/Enlarge, 
Duplex/N-Up, Output, Paper Source, etc.

 

You can set the default Quick Copy options from Machine Setup 
> Application Setting > Copy Settings from the display screen. 
Set the most frequently used settings.

4. Enter the number of copies using the numeric keypad on the control 
panel, if necessary.

5. Press (Start) from the control panel to begin copying.
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4.Faxing (optional)
This guide gives you information about using your machine as a fax machine.

This chapter includes:

• Preparing to fax
• Sending a fax from your computer
• Understanding the fax screen
• Sending a fax
• Receiving a fax

• Adjusting the document settings
• Printing a fax report
• Using a programs setting
• Saving and loading documents

  

 

• You cannot use this machine as a fax through the internet phone 
line. For more information ask the internet service provider.

• We recommend you to use traditional analog phone services 
(PSTN: public switched telephone network) when connecting 
telephone lines to use Fax. If you use other Internet services (DSL, 
ISDN, VolP), you can improve the connection quality by using the 
Micro-filter. The Micro-filter eliminates unnecessary noise signals 
and improves connection quality or Internet quality. Since the DSL 
Micro-filter is not provided with the machine, contact your Internet 
Service provider for use on DSL Micro-filter.

1 Line port
2 Micro filter
3 DSL modem / Telephone line

Preparing to fax

Before you send or receive a fax, you need to connect the supplied phone 
line cord to the wall jack. Refer to the optional fax kit Installation Guide for 
how to make a connection. The method of making a telephone connection 
varies from one country to another.

Sending a fax from your computer

You can send a fax from your computer without going to the machine. Make 
sure that your machine and the computer are connected to the same 
network.

Sending a fax (Windows)
To send a fax from your computer, the Samsung Network PC Fax program 
must be installed. This program is installed when you install the printer 
driver. 

1. Open the document to be sent.
2. Select Print from the File menu.

The Print window will be displayed. It may look slightly different 
depending on your application.

3. Select Samsung Network PC Fax from the Print window
4. Click Print or OK.
5. Enter the recipient’s fax number and set the options if necessary.

 

For more information about Samsung Network PC Fax, click 
Help. 

6. Click Send.

Checking the sent fax list (Windows) 
You can check the sent fax list from your computer.
From the Start menu, click Programs or All Programs > Samsung 
Printers > Network PC Fax > Fax Journal. Then, the Fax Journal 
appears with the list of faxes sent.
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For more information about Fax Journal, click Help. 

Sending a fax (MAC)
To send a fax from your computer, the Fax Utilities program must be 
installed. This program is installed when you install the printer driver.
The following steps are based on the Mac OS X 10.5 or 10.6. Depending on 
the OS version, the following steps will be different.

1. Open the document to be sent.
2. Select Print from the File menu.

The Print window will be displayed. It may look slightly different 
depending on your application.

3. Select Samsung CLX-9201 9301 Series fax from the drop-down list in 
Printer.

4. Choose the number of copies and pages.
5. Choose your paper size, orientation, and scale.
6. Enter the recipients’ fax number into To’s input area. You can also use 

Addresses pressing  button, if you have stored frequently used fax 
numbers.

7. If necessary, enter the access code in the Dialing Prefix input area.
8. If necessary, you can send the fax with a cover page: check Use Cover 

Page.
Enter the subject and message of the fax job.

 

You can set more detailed options for cover page options in 
Samsung Fax Cover Page. Select Samsung Fax Cover Page 
from the drop-down list under Orientation.

9. Click Fax.

10. The Fax icon ( ) appears on your MAC dock. Click the icon.
You can see the status of the fax job. You can also delete, hold, resume, 
and pause the fax job.
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Understanding the fax screen

To use the fax feature, press Fax on the display screen.

 

If you want to use this feature, you need to install the optional fax kit 
on your machine.

If a different screen is displayed, press ( ) to go to the home display 
screen.

 Basic tab

• Fax number input area: Enter the recipient's fax number using the 
numeric keypad on the control panel. If you configured the address 
book, press Address Book (see "Setting up an address book using the 
control panel" on page 94 or "Setting up an address book using 
SyncThru™ Web Service" on page 96).

• Resolution: Adjusts the resolution options (see "Changing the 
resolution" on page 72).

• Address Book: Enters the recipient's fax number just by pressing 
stored numbers. You can save frequently used fax numbers using the 
control panel or SyncThru™ Web Service (see "Setting up an address 
book using the control panel" on page 94 or "Setting up an address book 
using SyncThru™ Web Service" on page 96).

• Programs: Allows you to save the current settings for future use (see 
"Using a programs setting" on page 74).

Advanced tab

• Original Size: Selects the size of the original (see "Selecting the size of 
originals" on page 71).

• Duplex: Selects whether the machine sends faxes one side of the 
original or both sides of the original (see "Faxing on both sides of 
originals" on page 71).

• Original Orientation: Selects the orientation of the originals (see 
"Selecting the orientation of originals" on page 72).

• Delay Send: Sets the machine to send a fax at a later time without your 
intervention (see "Delaying a fax transmission" on page 69).

Image tab

• Original Type: Enhances the fax quality based on the type of the 
original document being scanned (see "Selecting the type of originals" 
on page 73).
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Sending a fax

This part explains how to send a fax and the special methods of 
transmission.

 

When you place the originals, you can use either the DADF or the 
scanner glass. If the originals are placed on both the DADF and the 
scanner glass, the machine will read the originals on the DADF first, 
because it has higher priority in scanning.

Setting the fax header
In some countries, you are required by law to indicate your fax number on 
any fax you send. 

1. Press Machine Setup > Application Settings > Fax Settings > 
Machine ID & Fax No from the display screen.

2. Press a fax line if your machine has multiple fax lines.
3. Press the ID Name input area. The pop-up keyboard appears. 

Enter your name or the company name. Press OK.
4. Press the Fax Number input area.

Enter your fax number using the numeric keypad on the control panel.
5. Press OK to save the information.

Sending a fax 
1. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

 

This machine automatically reduces the original document to fit the 
paper size of the recipient’s fax. For example, the origianl 
document size is A3-sized paper and the paper loaded on 
recipient’s fax is A4-sized paper, the original paper get reduced to 
be fit to A4-sized paper.

2. Press Fax from the display screen.
3. Adjust the document settings in the Advanced or Image tab (see 

"Adjusting the document settings" on page 71).
4. Press the Basic tab.
5. Select Resolution (see "Changing the resolution" on page 72).
6. When the cursor is blinking in the input line, enter the fax number using 

the numeric keypad on the control panel, or use Address Book from the 
display screen, if you have stored frequently used fax numbers.

 

• You can send a fax to up to 10 destinations at once.
• To insert a pause, press Pause at the appropriate place while 

entering the fax number. “-” appears on the display at the 
corresponding location.

7. Press Start on the control panel. The machine starts to scan and send a 
fax to the destinations.

 

• You can send a fax directly from your computer (see "Sending a 
fax from your computer" on page 65).

• When you want to cancel a fax job, press Stop on the control 
panel before the machine starts transmission, or press the Job 
Status button on the control panel, and select the job you want to 
delete, then press Delete (see "Job Status button" on page 36).

• If an original is placed on the scanner glass, the machine shows 
the window asking if you want to place another page. Load another 
original and press Yes. When you finish, press No on this window.

• While the machine is sending a fax, you cannot send an email at 
the same time.

Sending a fax using speed dial numbers
When you are prompted to enter a destination number while sending a fax, 
enter the speed dial number you set previously (see "Setting up an address 
book" on page 94).

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Fax from the display screen.
3. Adjust the document settings in the Advanced or Image tab (see 

"Adjusting the document settings" on page 71).
4. Press the Basic tab.
5. Select Resolution (see "Changing the resolution" on page 72).
6. When the cursor is blinking in the input line:

• For a one-digit (0-9) speed dial number, press and hold the 
corresponding digit button using the numeric keypad on the control 
panel.

• For a two- or three-digit speed dial number, press the first digit 
button(s) and then hold down the last digit button using the numeric 
keypad on the control panel.

7. Press Start on the control panel.
The machine starts to scan and send a fax to the destination.

Sending a fax manually using On Hook
This method is sending a fax using On Hook in the Basic tab.

 

When you use Delay Send, Quick Start Fax and Priority Send in the 
Advanced tab, you cannot send a fax using On Hook.

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Fax from the display screen.
3. Adjust the document settings in the Advanced or Image tab (see 

"Adjusting the document settings" on page 71).
4. Press the Basic tab.
5. Select Resolution (see "Changing the resolution" on page 72).
6. Press On Hook on the display screen.
7. When you hear the dial tone, enter a fax number using the numeric 

keypad on the control panel.
8. Press Start when you hear a high-pitched fax signal from the remote fax 

machine.
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Sending a fax manually using an extension 
telephone
This method is sending a fax using an extension telephone. Make sure that 
the extension telephone is connected to the EXT socket of the fax kit on the 
machine.

 

While you are talking over the telephone connected to the EXT socket, 
copy and scan features are not available.

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Fax from the display screen.
3. Adjust the document settings in the Advanced or Image tab (see 

"Adjusting the document settings" on page 71).
4. Press the Basic tab.
5. Select Resolution (see "Changing the resolution" on page 72).
6. Pick up the receiver of the extension telephone.
7. When you hear the dial tone, dial a fax number using the extension 

telephone.
8. Press Start on the control panel when you hear a high-pitched fax signal 

from the extension telephone.

Resending Automatically
When the line you have dialed is busy or there is no answer when you send 
a fax, the machine automatically redials the number.
To change the time interval between redials and/or the number of redial 
attempts, follow the steps below:

1. Press Machine Setup > Application Settings > Fax Settings > Redial 
from the display screen.

2. Press a fax line if your machine has multiple fax lines.
3. Set the Redial Term [1-15] Min option using the up/down arrows.
4. Set the Redial Times [0-13] option using the up/down arrows.

Redialing the last number
Recent: Shows the last 10 fax numbers dialed. Also, you can choose fax 
numbers instead of pressing the number key.

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Fax from the display screen.
3. Adjust the document settings in the Advanced or Image tab (see 

"Adjusting the document settings" on page 71).
4. Press the Basic tab.
5. Select Resolution (see "Changing the resolution" on page 72).
6. Press Recent.
7. Press the fax number you want to redial. Then press OK.

 

• Add to Address: Allows you to add a fax number in the 
Recent results to Address Book.

• Delete: Allows you to delete a fax number in the Recent 
results. Press the fax number you want to delete. Then press 
Delete.

8. Press Start on the control panel. The machine starts to scan and send a 
fax to destinations.

Delaying a fax transmission
You can set your machine to send a fax at a later time when you will not be 
present.

 

• When you use this option, Quick Start Fax and Priority Send in 
the Advanced tab are inactivated.

• When you use this option, you cannot send a fax using the On 
Hook button on the display screen.

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Fax from the display screen.
3. Adjust the document settings in the Advanced or Image tab (see 

"Adjusting the document settings" on page 71).
4. Press the Basic tab.
5. Select Resolution (see "Changing the resolution" on page 72).
6. When the cursor is blinking in the input line, enter the fax number using 

the numeric keypad on the control panel. Or use Address Book from 
the display screen, if you have stored frequently used fax numbers.

7. Press the Advanced tab > Delay Send .

8. Press the Job Name input area. Then the pop-up keyboard appears.
Enter the job name you want. Press Done. 
If you do not enter a job name, the machine assigns the job name as 
'Fax Job Send'.

9. Set the delay sending time.

 

You can set the delay sending time to be greater than 15 minutes 
later than the current time. For example, if it is 1:00, then you can 
set the time starting to be 1:15. If the set time is incorrect, a 
warning message will appear when the machine resets it to the 
current time.

10. Press Start on the control panel. The machine starts to store the 
scanned original data into memory.

 

To cancel delaying a fax, press Off before sending is activated.
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Receiving a fax

This part explains how to receive a fax and the special receiving methods 
available.

Changing the receive modes
Your machine is preset to the Fax mode at the factory. When you receive a 
fax, the machine answers the call on a specified number of rings and 
automatically receives the fax. However, if you want to change the receive 
mode to another mode, follow the steps below:

1. Press Machine Setup > Application Settings > Fax Settings > Fax 
Initial Settings from the display screen.

2. Press a fax line if your machine has multiple fax lines.

3. Press Receive Mode.
4. Press the appropriate option.

• Telephone: Receives a fax by pressing On Hook and then Start. 
• Fax: Answers an incoming fax call and immediately goes into the 

fax reception mode.
• Answering Machine/Fax: Is for when an answering machine is 

attached to your machine. Your machine answers an incoming call, 
and the caller can leave a message on the answering machine. If the 
fax machine senses a fax tone on the line, the machine automatically 
switches to Fax mode to receive the fax.

5. Press OK to save the information.

Receiving manually in Telephone mode
You can receive a fax call by pressing On Hook and then pressing Start 
when you hear a fax tone from the remote machine. The machine begins 
receiving a fax.

Receiving faxes manually using an extension 
telephone
This feature works best when you are using an extension telephone 
connected to the EXT socket on the back of your machine.
When you receive a call on the extension phone and hear fax tones, press 
the key *9* on the extension phone. The machine receives the fax.
Press the buttons slowly in sequence. If you still hear the fax tone from the 
remote machine, try pressing *9* once again.
To change the *9* to, for example, *3*, follow the steps below:

1. Press Machine Setup > Application Settings > Fax Settings > 
Recieve Start Code from the display screen.

2. Press On to activate this feature.
3. Enter the number 3 using the numeric keypad on the control panel

4. Press OK.

Receiving in secure receiving mode
You may need to prevent your received faxes from being accessed by 
unauthorized people. You can turn on secure receiving mode to restrict 
printing of received faxes when the machine is unattended. In secure 
receiving mode, all incoming faxes go into memory.

1. Press Machine Setup > Application Settings > Fax Settings > 
Secure Receive from the display screen.

 

The Secure Receive mode can only be configured by an 
authorized user who has registered an ID and a password on the 
machine. When the machine requests, enter the ID and password.

2. Press a fax line if your machine has multiple fax lines.
3. Press On to active this feature.

 

When the machine receives a fax in this mode, Print will be 
activated. If you want to print the secured faxes, press Print. All 
secured faxes will be printed out.

4. If you want incoming faxes to go into memory always, press Whole Day. 
Otherwise, go to the next step.

5. Set Start Time by pressing the + and - buttons. Press OK.

6. Press End Time, and set the specific end time using the up/down or 
left/right arrows. Then press OK.

7. Press OK from the display screen.

 

To deactivate the Secure Receive feature, press Off. In this case, the 
received fax will be printed out.
Faxing (optional)_ 70



Selecting a received fax output tray
This option allows you to specify the tray where the fax will be printed.

1. Press Machine Setup > Application Settings > Fax Settings > 
Received Fax Printing > Output Tray from the display screen.

2. Press the appropriate tray.

 

• In CLX-9301 Series, the Right Tray (Face-Up) is optional 
device.

• The Finishing Tray and Top Tray are available only when the 
optional Inner Finisher or booklet finisher is installed.

• When the optional Inner Finisher or booklet finisher is installed, 
Center Tray is inactivated.

3. Press OK.

Printing received faxes on both sides of the paper
Set this duplex feature to save paper. When the machine prints the received 
fax data, it prints them on both sides of the paper.

1. Press Machine Setup > Application Settings > Fax Settings > 
Received Fax Printing > Duplex from the display screen.

2. Press the appropriate option.
• Off: Prints on only one side of the paper.
• Long Edge: Prints on both sides of the paper; however, the binding 

will be the long edge.
• Short Edge: Prints on both sides of the paper; however, the binding 

will be the short edge.
3. Press OK.

Printing received faxes to the right tray (face up)
This machine allows you to receive incoming faxes through the right tray 
(face up). When you use the right tray, the received faxes pile up in 
sequence beginning with the first page at the bottom.

1. Press Machine Setup > Application Settings > Fax Settings > 
Received Fax Printing > Output Tray > Right Tray(Face-Up) from the 
display screen.

2. Press OK.

Receiving faxes in memory
Since your machine is a multi-tasking device, it can receive faxes while you 
are making copies or printing. If you receive a fax while you are copying or 
printing, your machine stores incoming faxes in its memory. Then, as soon 
as you finish copying or printing, the machine automatically prints the fax. 

Adjusting the document settings

Before sending a fax, you can adjust the document settings, such as 
resolution, darkness, color, duplex and so on. 

 

The document setting herein is for the current job only. If you want to 
change the default settings on document settings, refer to Machine 
Setup > Application Settings > Fax Settings > Default Value.

Selecting the size of originals
A fax can be sent after specifying the original document size if the original 
document size cannot be detected automatically or if you wish to specify a 
certain document size.

1. Press the Advanced tab > Original Size from the display screen..

2. Press the appropriate option.

 

You can change the paper list on the display screen pressing inch 
Size or mm Size. The paper list is divided into the available A/B 
size type and letter size type paper in this machine.

• Auto: Automatically detects the size of originals, but this option 
supports only when originals are Letter-, Ledger-, Legal-, 
Statement-, A3-, A4-, A5-, B4-, or JIS B5-sized.

• Other preset values: Allows you to easily select values commonly 
used.

3. Press OK from the display screen.

Faxing on both sides of originals
This function is especially intended for two-sided originals. You can select 
whether the machine sends the fax on one side or both sides of the paper. 

1. Press the Advanced tab > Duplex, then set the original orientation.

2. Press the appropriate option.
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• 1 Sided: For originals that are printed on one side only.
• 2 Sided, Book: For originals that are printed on both sides.
• 2 Sided, Calendar: For originals that are printed on both sides, but 

the back is rotated 180 degrees.

 

To use 2 Sided, Book and 2 Sided, Calendar, load the originals 
on the DADF. If the machine cannot detect the original on the 
DADF, it automatically changes the option to 1 Sided.

3. Press OK from the display screen.

Selecting the orientation of originals
When faxing double-sided documents, specify the document orientation. 
Otherwise, the faxes may not be printed in the correct page order or correct 
front and back page arrangement.

1. Press the Advanced tab > Original Orientation, then set the original 
orientation.

2. Press the appropriate option.
• Upright Images: Select this setting for an original document loaded 

with the top toward the back of the machine.

• Sideways Images: Select this setting for an original document 
loaded into the DADF with the top of the original document toward 
the left side of the machine, or an original document placed on the 
scan glass with the top of the original document toward the right side 
of the machine.

3. Press OK from the display screen.

Changing the resolution
The default document settings produce good results when using typical 
text-based originals. However, if you send originals that are of poor quality, 
or contain photographs, you can adjust the resolution to produce a higher 
quality fax. 
Press left/right arrow to toggle the values.
• Standard: Usually recommended for originals with text. This option will 

reduce the transmission time.
• Fine: Recommended for the originals containing small characters, thin 

lines, or text that was printed using a dot-matrix machine. 
• Super Fine: Recommended for originals containing fine detail. This 

option is enabled only if the receiving machine also supports Super Fine 
resolution.

• Ultra Fine: Recommended for originals containing extremely fine detail. 

Using the DADF Using the scanner 
glass

Icon

Using the DADF Using the scanner 
glass

Icon
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This option is enabled only if the receiving machine also supports Ultra 
Fine resolution.

 

When your machine is set to the Super Fine or Ultra Fine resolution 
and the fax machine with which you are communicating does not 
support the Super Fine or Ultra Fine resolution, the machine 
transmits using the highest resolution mode supported by the other fax 
machine.

Selecting the type of originals
You can set the original document type to enhance the quality of a 
document being scanned.

1. Press the Image tab > Original Type from the display screen.

2. Press the appropriate option.
• Text: For originals with text or line art.
• Text/Photo: For originals with both text and photographs together.
• Photo: For originals that are a continuous tone photograph.

Changing the darkness
You can select the degree of darkness of the original document. 

1. Press the Basic tab > Darkness from the display screen.

2. Press left/right arrow to change the level of light and dark.

Printing a fax report

You can set the machine to print a report whether a fax transmission and 
reception is successfully completed or not.

 

If a report contains characters or fonts that the machine do not 
support, Unknown could be printed instead of the characters/fonts in 
the report.

1. Press Machine Setup > Report > Fax Reports > Settings from the 
display screen.

2. Press the appropriate option.
• Multi Fax Transmission Result: Prints a confirmation report when 

you send a fax to multiple locations.
- Off: Disables this feature.
- On: Activates this feature.
- On-Error: Prints a report only when a transmission fails.

• Fax Transmission Result: Prints a confirmation report showing 
whether a transmission was successful, how many pages were sent, 
and other information.
- Off: Disables this feature.
- On: Activates this feature.
- On-Error: Prints a report only when a transmission fails.

• Fax Transmission History: Prints a confirmation report whether a 
transmission was successful, how many pages were sent, and other 
information.
- Off: Disables this feature.
- On: Activates this feature.

• Fax Reception History: Prints a confirmation report whether a 
reception was successful, how many pages were received, and other 
information.
- Off: Disables this feature.
- On: Activates this feature.

3.  Press OK from the display screen.
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Using a programs setting

This option allows you to save the current settings for future use. You can 
also use the previous settings from the previous job.

Saving Programs
1. Press Fax from the display screen.
2. Adjust the document settings in the Advanced or Image tab (see 

"Adjusting the document settings" on page 71).
3. Press the Basic tab.
4. Select Resolution (see "Changing the resolution" on page 72).
5. Press Programs.

6. Press Program Name input area. The pop-up keyboard appears.
Enter the program name you want. Then press OK.

 

You can see the values of set Programs by scrolling up or down 
and check the values using the up/down arrows.

7. Press Save. When the confirmation window appears, the settings you 
set are saved. Click Go to List or Close.

Using Programs
1. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Fax from the display screen.
3. When the cursor is blinking in the input line, enter the fax number using 

the numeric keypad on the control panel, or use Address Book from the 
display screen, if you have stored frequently used fax numbers.

4. Press Programs > List.
5. Press a program name in the list that you want to use.
6. Press OK.
7. Press Yes when the confirmation window appears.

The machine is now set to fax according to the selected setting.
8. Press Start on the control panel. The machine starts scanning and 

sending a fax to destinations.

 

• When you want to cancel a fax job, press Stop on the control 
panel before the machine starts transmission or press the Job 
Status button on the control panel, and select the job you want to 
delete, then press Delete.

• If an original is placed on the scanner glass, the machine shows 
the window asking if you want to place another page. Load another 
original and press Yes. When you finish, press No on this window.

• While the machine is sending a fax, you cannot send an email at 

the same time.

Managing Programs
1. Press Fax from the display screen.
2. Press Programs > List.
3. Press the appropriate option.

• Select All: Selects all programs.
• Detail: Displays detailed information of selected program.
• Edit: Changes a name of selected program.
• Delete: Removes the selected programs.

4. Press Cancel for return to the Basic tab.

Saving and loading documents

This option allows you to save the current settings for future use. You can 
also use the previous settings from the last job.

Saving 
1. Press Scan to Email, Scan to Server , Scan to Shared Folder or 

Scan to USB from the display screen.
2. Set scan features in the Advanced, Image, or Output tabs ("Changing 

the scan feature settings" on page 81).
3. Press the Basic tab.
4. Set the scan quality by Duplex and Resolution.
5. Press Programs > Save.

6. Press Program Name input area. The pop-up keyboard appears.
Enter the program name you want. Then press OK.
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You can see the values of set Programs by scrolling up or down 
and check the values using the up/down arrows.

7. Press Save. 
8. You can check the all settings again. If everything is fine, press Add to 

home to make shortcut in main screen, Save to save current settings or 
cancel to quit without saving.

Loading
1. Press Scan to Email, Scan to Server or Scan to USB from the display 

screen.
2. Press Programs > Load.
3. Press the previous setting you want to use.

The machine is now set to scan according to the setting you selected.
4. Press Add to home to make a shortcut in main screen, Delete to delete 

the current setting or Apply to use the selected setting.
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5.Scanning
Scanning with your machine lets you turn pictures and text into digital files that can be stored on your computer.

This chapter includes:

• Basic scanning method
• Understanding the scan methods
• Scanning originals and sending through email (scan to email)
• Scanning originals and sending via SMB/FTP (Scan to server)
• Scanning originals and sending to a USB memory device (scan to USB)
• Changing the scan feature settings

• Using a programs setting
• Scanning originals and sending to your computer (scan to PC)
• Scanning with TWAIN-enabled software
• MAC scanning
• Linux scanning

  

 

The maximum resolution that can be achieved depends upon various 
factors, including computer speed, available disk space, memory, the 
size of the image being scanned, and bit depth settings. Thus, 
depending on your system and what you are scanning, you may not 
be able to scan at certain resolutions, especially using enhanced 
resolution.

Basic scanning method

You can scan the originals with your machine via the network.
• Easy Printer Manager(EPM): EPM is a Windows-based application 

that combines Samsung device settings into one location. 
• TWAIN: TWAIN is the one of preset imaging applications. Scanning an 

image launches the selected application, enabling you to control the 
scanning process. This feature can be used via a network connection 
(see "Scanning with TWAIN-enabled software" on page 86).

• Easy Document Creator(EDC): This program is accompanying 
software for your machine. You can use this program to scan images or 
documents. (see "Understanding Samsung Easy Document Creator" on 
page 121).

• Email: You can send the scanned image as an email attachment (see 
"Scanning originals and sending through email (scan to email)" on 
page 77).

• Server: You can scan an image and send it to a server such as FTP or 
SMB (see "Scanning originals and sending via SMB/FTP (Scan to 
server)" on page 78).

• USB: You can scan an image and store it to a USB memory device (see 
"Scanning originals and sending to a USB memory device (scan to 
USB)" on page 80).

Understanding the scan methods

To use the scanning feature, press Scan to Email, Scan to USB, Scan to 
Server, Scan to PC, or Scan to Shared Folder on the display screen.

If a different screen is displayed, press ( ) to go to the home display 
screen.

• Scan to Email: Scans and sends scanned output to the destination by 
e-mail (see "Scanning originals and sending through email (scan to 
email)" on page 77).

• Scan to Server: Scans and sends scanned output to the destination 
with SMB or FTP (see "Scanning originals and sending via SMB/FTP 
(Scan to server)" on page 78).

• Scan to USB: Scans and stores scanned output onto a USB memory 
device (see "Scanning originals and sending to a USB memory device 
(scan to USB)" on page 80).

 

If you want to use this feature, you need to insert a USB memory 
device into the USB memory port on your machine.

• Scan to PC: Scans and sends scanned output to a computer (see 
"Scanning originals and sending to your computer (scan to PC)" on 
page 86).

• Scan to Shared Folder: Scans and stores scanned output in the 
shared folder.
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Scanning originals and sending through email 
(scan to email)

You can scan originals and send the scanned image to several destinations 
from the machine by email. 

 

To scan and send an image as an email attachment, you need to set 
up network parameters, SMTP settings and Scan to Email settings 
using the control panel or SyncThru™ Web Service. For details about 
how to set up the network parameters and email settings, refer to the 
Administrator’s Guide on the supplied CD.

Understanding the Scan to Email screen
Press Scan to Email in the display screen.

Basic tab

• Send To Me: Press the Advanced tab > Email Settings, then type 
the sender’s email address. Clcik the checkbox on the right to send 
to yourself. 

• Direct Input: Tap the screen to add recipient’s email addresses.
• File Name: Makes the file name for the file to be sent(see "File 

Policy" on page 84).
• File Format: Select the file format before you proceed with the 

scanning job (see "File Format" on page 84).
• Resolution: Selects scanning resolution value (see "Changing the 

resolution" on page 81).
• Darkness: Adjusts the degree of darkness of scanned output (see 

"Changing Darkness" on page 81).
• Recent: Shows the latest 10 email addresses used. Also, you can 

choose email addresses instead of pressing the pop-up keyboard 
(see "Resending to the last email address" on page 78).

• ( )Favorite: shows the frequently used addresses.

• All: Shows all the addresses.

• ABC: Shows the addresses that contains English characters.
• 123/!@#: shows the addresses that contains numbers or special 

characters.

• Programs: Allows you to save the current settings for future use 
(see "Using a programs setting" on page 85).

Advanced tab

• Original Size: Selects the size of originals (see "Selecting the size 
of originals" on page 83).

• Original Orientation: Selects the orientation of the originals (see 
"Selecting the orientation of originals" on page 82).

• E-mail Setting: Enter the information including From, Subject and 
Message.

• Duplex: Sets the machine to print copies on both sides of the paper.

Image tab
You can move to the next or previous page using the up/down arrows 
located at the bottom left.

• Original Type: Selects whether the original is text, photo, etc (see 
"Selecting the type of originals" on page 83).

• Color Mode: Adjusts the color options of scanned output (see 
"Selecting the color mode" on page 83).

• Adjust Background: Erase the background to some extent by 
adjusting density or brightness (see "Adjusting background" on 
page 83).

• Erase Backside: Prevents scanning the other side’s image shown 
through the original paper (see "Erasing backside Images" on 
page 84).
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Output tab

• Quality: Adjusts the display quality of the scanned output (see 
"Quality" on page 84).

• File Name: Makes the file name for the file to be sent (see "File 
Policy" on page 84).

Resending to the last email address
To resend to the last used email address:

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Scan to Email from the display screen.
3. Set the scan features in the Advanced, Image, or Output tabs (see 

"Changing the scan feature settings" on page 81).
4. Press the Basic tab.
5. Press To’s input area and Recent.
6. Press the email address which you want to re-send.. Then press OK.

 

• Add to Address: Allows you to add an email address in the 
Recent results to the Address Book.

• Delete: Allows you to delete an email address in the Recent 
results. Press the email address you want to delete. Then 
press Delete.

7. Set the scan quality by Duplex and Resolution (see "Scanning from 
both sides of originals" on page 82 and "Changing the resolution" on 
page 81).

8. Press the Start button to scan and send the file.
If an original is placed on the scanner glass, the machine shows the 
window asking if you want to place another page. Load another original 
and press Yes. When you finish, press No on this window.

Printing an email confirmation report
You can set the machine to print a report whether an email transmission is 
successfully completed or not.

 

If a report contains characters or fonts that the machine does not 
support, Unknown could be printed instead of the characters/fonts in 
the report.

1. Press Machine Setup > Application Setting > Scan to Email Settings 
from the display screen.

2. Press the appropriate option in Print Confirmation Sheets.
• On Errors Only: Prints a confirmation report only when an email 

transmission is not successful.
• Always: Always prints a confirmation report whether an email 

transmission is successfully completed or not.
• Never: Never prints a confirmation report.

3. Press  to go back to the previous screen.

Scanning originals and sending via SMB/FTP 
(Scan to server)

You can scan an image and send it to a total of three destinations via SMB 
or FTP. 

 

To scan and send an image to a server, you need to set up network 
parameters using the control panel or SyncThru™ Web Service. For 
details about how to set up the network parameters, refer to the 
Administrator’s Guide on the User’s Guide CD.

Understanding the Scan to Server screen
Press Scan to Server in the display screen.

Basic tab

• Filename: Makes the file name for the file to be sent (see "File 
Policy" on page 84).

• Address Book: Inputs the recipient's address by pressing stored 
addresses. You can save frequently used email addresses using the 
control panel or SyncThru™ Web Service (see "Setting up an 
address book using the control panel" on page 94 or "Setting up an 
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address book using SyncThru™ Web Service" on page 96).
• Recent: Shows the latest 10 email addresses used. Also, you can 

choose email addresses instead of pressing the pop-up keyboard 
(see "Resending to the last email address" on page 78).

• Resolution: Selects scanning resolution value (see "Changing the 
resolution" on page 81).

• Programs: Allows you to save the current settings for future use 
(see "Using a programs setting" on page 85).

• Darkness: Adjusts the degree of darkness of scanned output (see 
"Changing Darkness" on page 81).

Advanced tab

• Original Size: Selects the size of originals (see "Selecting the size 
of originals" on page 83).

• Original Orientation: Selects the orientation of the originals (see 
"Selecting the orientation of originals" on page 82).

• Duplex: Sets the machine to print copies on both sides of the paper.

Image tab
You can move to the next or previous page using the up/down arrows 
located at the bottom left.

• Original Type: Selects whether the original is text, photo, etc. (see 
"Selecting the type of originals" on page 83).

• Color Mode: Adjusts the color options of scanned output (see 
"Selecting the color mode" on page 83).

• Adjust Background: Erase the background to some extent by 
adjusting density or brightness (see "Adjusting background" on 
page 83).

• Erase Backside: Prevents scanning the other side’s image shown 
through the original paper (see "Erasing backside Images" on 
page 84).

Output tab

• Quality: Adjusts the display quality of the scanned output (see 
"Quality" on page 84).

• File Format: Selects the file format of the scanned output (see "File 
Format" on page 84).

Scanning and sending to an SMB/FTP server

 

You can select up to three destinations using SMB, or FTP servers.

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Scan to Server from the display screen
3. Set the scan features in the Advanced, Image, or Output tabs (see 

"Changing the scan feature settings" on page 81).
4. Press the Basic tab.
5. Press the server name input area, you can enter a recipient’s server 

address manually. You cannot enter an address in the second field 
before entering an address in the first field. 
You can also use Address Book to enter the addresses easily (see 
"Setting up an address book" on page 94). 

6. Set the scan quality by Duplex and Resolution (see "Scanning from 
both sides of originals" on page 82 and "Changing the resolution" on 
page 81).

7. Press Start on the control panel.
The machine begins scanning and then sends the scanned image to the 
specified server.
If an original is placed on the scanner glass, the machine shows the 
window asking if you want to place another page. Load another original 
and press Yes. When you finish, press No on this window.

 

• To cancel the current scan job, press Stop on the control panel. Or 
you can delete current and pending jobs using Job Status on the 
control panel. Select the job you want to cancel and press Delete 
(see "Job Status button" on page 36).

• While the machine is sending a scanned data, you cannot use the 
machine to copy or to send a fax.

Resending to the last server address
To resend a file to the server address last sent to:

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Scan to Server from the display screen.
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3. Set the scan features in the Advanced, Image, or Output tabs (see 
"Changing the scan feature settings" on page 81).

4. Press the Basic tab.
5. Press Recent.
6. Press the server address to which you want to resend. Then press OK.

 

• Add to Address: Allows you to add a server address in the 
Recent results to the Address Book.

• Delete: Allows you to delete a server address in the Recent 
results. Press the server address you want to delete. Then 
press Delete.

7. Set the scan quality by Duplex and Resolution (see "Scanning from 
both sides of originals" on page 82 and "Changing the resolution" on 
page 81).

8. Press the Start button to scan and send the file.
If an original is placed on the scanner glass, the machine shows the 
window asking if you want to place another page. Load another original 
and press Yes. When you finish, press No on this window.

Scanning originals and sending to a USB 
memory device (scan to USB)

You can scan a document and save the scanned image onto a USB 
memory device. When you scan a document, the machine uses the default 
settings, such as for resolution. You can also customize your own scan 
settings (see "Changing the scan feature settings" on page 81).

Understanding the Scan to USB screen
Press Scan to USB in the display screen.

Basic tab

• Go to upper: Moves back to the upper level.
• Select: Moves to the selected folder.
• New folder: Makes a new folder in the USB memory device.
• Detail: Displays information of the selected folder or file.
• Edit: Changes the name of the selected folder or file.
• Delete: Deletes the selected folder or file.
• File Name: Makes a file name to store the scan data.
• Resolution: Selects the scanning resolution value (see "Changing 

the resolution" on page 81).
• Programs: Allows you to save the current settings for future use 

(see "Using a programs setting" on page 85).

Advanced tab

• Original Size: Selects the size of originals (see "Selecting the size 
of originals" on page 83).

• Original Orientation: Selects the orientation of the originals (see 
"Selecting the orientation of originals" on page 82).

• E-mail Setting: Enter the information including From, Subject, and 
Message.

• Duplex: Sets the machine to print copies on both sides of the paper.

Image tab
You can move to next or previous pages using the up/down arrows 
located at the bottom left.

• Original Type: Selects whether the original is text, photo, etc. (see 
"Selecting the type of originals" on page 83).

• Color Mode: Adjusts the color options of scanned output (see 
"Selecting the color mode" on page 83).

• Adjust Background: Erase the background to some extent by 
adjusting density or brightness (see "Adjusting background" on 
page 83).

• Erase Backside: Prevents scanning the other side’s image shown 
through the original paper (see "Erasing backside Images" on 
page 84).
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Output tab

• Quality: Adjusts the display quality of the scanned output (see 
"Quality" on page 84).

• File Format: Selects the file format of the scan output (see "File 
Format" on page 84).

• File Policy: Automatically renames or overwrites when the USB 
memory device has a file with same name (see "File Policy" on 
page 84).

Scanning to a USB memory device

 

• The machine cannot detect the unformatted USB memory device. 
Format and then reinsert the USB memory device into the USB 
memory port on your machine.

• The machine could not detect the USB memory device when the 
machine is in power save mode. Wait until the machine returns to 
ready mode, and then reinsert the USB memory device into the 
USB memory port on your machine.

• The machine has two USB memory ports. When a USB memory is 
already inserted to one of the ports, if you try to insert a USB 
memory device into another port, the machine cannot detect the 
second one. Remove the USB memory device that was inserted 
first and then reinsert the USB memory device you want to use into 
the USB memory port on your machine.

1. Insert a USB memory device into the USB memory port on your 
machine.

2. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Press Scan to USB from the display screen.
4. Press the Basic tab.
5. Select a folder for storing the scanned image. If you do not select a 

folder, the scanned image is stored in root directory.
6. Press the File Name input area. The pop-up keyboard appears.
7. Enter a file name to store the scan data. Press Done.
8. Set the File format, Resolution, and Darkness (see "Scanning from 

both sides of originals" on page 82 and "Changing the resolution" on 
page 81).

9. Set the scan features in the Advanced, Image, or Output tabs , if 
necessary (see "Changing the scan feature settings" on page 81).

10. Press the Start button to scan and store the file. 
If an original is placed on the scanner glass, the machine shows the 
window asking if you want to place another page. Load another original 
and press Yes. When you finish, press No on this window.

11. After scanning is complete, you can remove the USB memory device 
from the machine.

Changing the scan feature settings

This section explains how to adjust the document settings for each scan job, 
such as resolution, duplex, original size, type, color mode, darkness, and 
more. The settings you change will be maintained for a certain time, but 
after that period, the options will be reset to default values.

Changing the resolution
You can adjust document resolution.
Press the resolution and choose the values. The higher value you select, 
the clearer the result, but the scanning time may take longer.

The following table shows detailed information for this feature, resolution, 
and file format options.

Changing Darkness
You can select the degree of darkness of the scanned output. If your 
original document is light or faded, move the white bar to the right to make 
the output darker.

Feature Resolution (dpi) File Format

Scan to Email

100, 200, 300, 600 JPEG, PDF, TIFF, XPS
Scan to USB

Scan to Server

Scan to Shared 
Folder
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1. Press the white bar and move it to choose the value.

Scanning from both sides of originals
This feature applies to scanning two-sided original documents. You can 
select whether the machine scans only one side or both sides of the paper. 
Press the Advanced tab > Duplex, then select an option.

• 1 Sided: For originals that are printed on one side only.
• 2 Sided, Book: For originals that are printed on both sides. 
• 2 Sided, Calendar: For originals that are printed on both sides, but the 

back is rotated 180 degrees.

 

If an original is placed on the scanner glass, the machine shows the 
window asking to place another page. Load another original and press 
Yes. When you finish, select No for this option.

Selecting the orientation of originals
1. Press the Advanced tab > Original Orientation, then set the original 

orientation.

2. Press the appropriate option.
• Upright Images: Select this setting for an original document loaded 

with the top toward the back of the machine.

• Sideways Images: Select this setting for an original document 
loaded into the DADF with the top of the original document toward 
the left side of the machine or an original document placed on the 
scanner glass with the top of the original document toward the right 
side of the machine.

3. Press  to go back to the previous screen.

Using the DADF Using the scanner 
glass

Icon

Using the DADF Using the scanner 
glass

Icon
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Selecting the size of originals
1. Press the Advanced tab > Original Size, then select an option.

2. Press the appropriate option.

 

You can change the paper list on the display screen by pressing 
inch Size or mm Size. The paper list is divided into the available 
A/B size type and letter-size type paper in this machine.

• Custom: Selects the copying area of the original. Press the cardinal 
point arrows to set the size. 

 

The custom size is different depending on where the originals 
are placed.

• Auto: Automatically detects the size of originals, but this option 
supports only when originals are Letter, Ledger, Legal, Statement, 
A3, A4, A5, B4, or JIS B5-sized.

3. Press  to go back to the previous screen.

Selecting the type of originals
The original type setting is used to improve the scan quality by selecting the 
document type for the current scanning job.

1. Press the Image tab > Original Type from the display screen.

2. Press the appropriate option.
• Text: Use for originals containing mostly text.

• Text/Photo: Use for originals with mixed text and photographs.
• Photo: Use when originals are photographs.

3. Press  to go back to the previous screen.

Selecting the color mode
Use one of these options to scan the original: Auto, Color, Gray or Mono.

1. Press the Image tab > Color Mode from the display screen. Select the 
appropriate option.

2. Press the appropriate option.
• Auto : Automatically detects the color of the original and scans it.
• Color: Uses color to display an image: 24 bits per pixel, 8 bits for 

each RGB, is used for 1 pixel.
• Gray: Uses the black gradation to display an image: 8 bits per pixel. 

• Mono: Displays an image in black and white. 1 bit per pixel.

3. Press  to go back to the previous screen.

Adjusting background
Adjust the background to some extent by adjusting density or brightness. 
You can lighten, or delete the dark background of colored paper or 
newspaper to be scanned.

 

When you use this option, Erase Backside Image in the Image tab 
are inactivated.

In the DADF On the scanner glass

Minimum size 128 x 128 mm 
(5 x 5 inches)

25 x 25 mm 
(1.0 x 1.0 inches)

Maximum size 297 x 432 mm 
(11.7 x 17.0 inches)

297 x 432 mm 
(11.7 x 17.0 inches)
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1. Press the Image tab > Adjust Background from the display screen.

2. Press the appropriate option.
• Off: Disables this feature.
• Auto: Automatically adjusts background brightness. 
• Enhance: Darkens the background. Use the left/right arrows to 

toggle the values.
• Erase: Lightens the background. Use the left/right arrows to toggle 

the values.

3. Press  to go back to the previous screen.

Erasing backside Images
This feature prevents scanning the other side’s image shown through the 
original paper

 

When you use this feature, Adjust Background in the Image tab are 
deactivated.

1. Press the Image tab > Erase Backside Image from the display screen.

2. Press the appropriate option.
• Off: Turns this option off.
• Erase: Lightens the background. Use the left/right arrow’s to toggle 

the values.

3. Press  to go back to the previous screen.

Quality
You can use this option to produce a high-quality document. The higher 
quality you select, the larger file size you get. 

1. Press the Output tab > Quality from the display screen.

2. Press the appropriate option.
• Best: Produces a high-quality image, but the file size will be larger.
• Normal: Both the image quality and file size will be between Best 

and Draft.
• Draft: Produces a low-quality image, but the file size will be smaller.

3. Press OK from the display screen.

 

When you set Color Mode to Mono in the Image tab, the Quality 
option is grayed out.

File Policy
You can choose the policy for generating file names before you proceed 
with the scan job through the USB memory device. If the USB memory 
device already has the same name entered, you can rename or overwrite it.

1. Press the Output tab > File Policy from the display screen.

2. Press the appropriate option.
• ChangeName: If the USB memory device already has the same 

name when you enter a new file name, the file will be saved as a 
different file name that is automatically generated.

• Cancel: Does not send the scanned file if a file with same name is 
already on the server.

• Overwrite: The sent file overwrites the existing file.

3. Press  to go back to the previous screen.

File Format
You can select the file format before you proceed with the scanning job.
Scanning_ 84



1. Press the Output tab > File Format from the display screen.
2. Press the appropriate option.

• JPEG: Scans originals in JPEG format.
• PDF: Scans originals in PDF format. You can open the file with the 

Adobe Acrobat Reader.
- MultiPage: If you want several originals to be scanned as one 

file, press MultiPage.
- Secure: You can set the password for the PDF file created using 

this option. You can also set whether to allow users to access the 
the created PDF file to print or modify.

- Searchable: The machine detects text in the scanned image 
and creates a searchable PDF for text searching. Press this 
button and select a language that is used in the scanned image. 
Press OK.

 

This option is available only when the optional advanced 
scan kit is installed.

- Compact: You can compress originals to create a small-sized 
file, press Compact. This compression method is different from 
the normal PDF format. Some data parts can be lost during 
compression.

- Add Digital Signature: You can insert a digital signature in the 
PDF with a certificate.

 

Only an administrator can manage the digital certificate on 
Digital Signature in PDF from SyncThru™ Web Service. 
For detailed information about Digital Signature in PDF, 
refer to the Administrator’s Guide on the User’s Guide CD.

• TIFF: Scans originals in TIFF (Tagged Image File Format). If you 
want several originals to be scanned as one file, press MultiPage.

• XPS: Scans originals in XPS (XML Paper Specification). If you want 
several originals to be scanned as one file, press MultiPage.

3. Press  to go back to previous screen.

 

The file format JPEG cannot be selected in the File Format option, if 
Mono has been selected for Color Mode in the Image tab.

Setting job completion notification
When the scan to email or scan to server job is completed, this machine can 
send the completion notification using email. This feature helps when you 
scan and send large quantities of documents. You do not need to wait until 
the scan-to-email or scan-to-server job is completed beside the machine.

 

To receive the job completion notification, you need to set up network 
parameters and email settings using the control panel or SyncThru™ 
Web Service. For details about how to set up the network parameters 
and email settings, refer to the Administrator’s Guide on the supplied 

CD.

1. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

2. Press Scan to Email or Scan to Server from the display screen.
3. Set scan features in the Advanced, Image, or Output tabs (see 

"Changing the scan feature settings" on page 81).
4. Enter the destinations information.
5. Set the scan quality by Duplex and Resolution (see "Scanning from 

both sides of originals" on page 82 and "Changing the resolution" on 
page 81).

6. Press the Advanced tab > Job Completion Notification.
7. Press On to activate this feature. 
8. Press Email Address input area. The pop-up keyboard appears.

Enter the email address to which you want to send the job completion 
notification. Press OK.

 

• You can select the email address pressing Address Book.
• You can enter an email address only.

9. Press Start on the control panel to begin scanning.

Using a programs setting

This option allows you to save the current settings for future use. You can 
also use the previous settings from the last job.

Saving 
1. Press Scan to Email, Scan to Server , Scan to Shared Folder or 

Scan to USB from the display screen.
2. Set scan features in the Advanced, Image, or Output tabs (see 

"Changing the scan feature settings" on page 81).
3. Press the Basic tab.
4. Set the scan quality by Duplex and Resolution (see "Scanning from 

both sides of originals" on page 82 and "Changing the resolution" on 
page 81).
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5. Press Programs > Save.

6. Press Program Name input area. The pop-up keyboard appears.
Enter the program name you want. Then press OK.

 

You can see the values of set Programs by scrolling up or down 
and check the values using the up/down arrows.

7. Press Save. 
8. You can check the settings again. If everything is fine, press Add to 

home to make a shortcut on the main screen, Save to save current 
settings, or Cancel to quit without saving.

Loading
1. Press Scan to Email, Scan to Server or Scan to USB from the display 

screen.
2. Press Programs > Load.
3. Press a previous setting you want to use.

The machine is now set to scan according to the selected setting.
4. Press Add to home to make shortcut in main screen, Delete to delete 

the current setting or Apply to use the selected setting.

Scanning originals and sending to your 
computer (scan to PC)

This option allows you to scan an image on the machine and send it out to 
your network-connected computer.

For a network connected machine
Make sure the scanner driver is installed on your computer.

1. Make sure that your machine and the computer are connected to a 
network.

2. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Press Scan to PC from the display screen.

4. Select your computer name and press OK. If the machine requests a 
password, enter the password using the numeric keypad on the control 
panel.

5. Press the application program you want and press Select.
Default setting is My Documents.

6. Set the scan quality with Duplex and Resolution in the Basic tab.
7. Set the size of original in the Advanced tab. If you are not sure of the 

original size, select Auto.
8. Set the color mode in the Image tab.
9. Set the file format in which the image is to be saved in the Output tab.

 

File Format activates only when you select the application 
program as My Documents.

10. Press Start from the control panel to begin scanning.

 

• Scanned image is saved in the computer’s My Documents > 
My Pictures > Samsung folder.

Scanning with TWAIN-enabled software

If you want to scan documents using other software, you will need to use 
TWAIN-compliant software, such as Adobe Photoshop. 

Follow the steps below to scan with TWAIN-compliant software:

1. Make sure that the machine is connected to your computer and powered 
on.

2. Place the originals face up in the DADF or place a single original face 
down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Open an application, such as Adobe Photoshop.
4. Open the TWAIN window and set the scan options.
5. Scan and save your scanned images.

MAC scanning

You can scan documents using Image Capture program. MAC OS X offers 
Image Capture program. 

Scanning with network
1. Make sure that the machine is connected to your computer and powered 

on.
2. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

3. Start Applications and click Image Capture.
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4. For MAC OS X 10.4 ~10.5
Click Devices and click Browse Devices.
For MAC OS X 10.6
Select your device below SHARED. Skip to step 6.

5. For Mac OS X 10.4
Select your machine in Twain devices option. Make sure that Use 
TWAIN software checkbox is checked, and click Connect.
• If a warning message appears, click Change Port.. to select port. 
• If TWAIN UI appears, from the Preference tab, click Change Port.. 

to select port. 
For Mac OS X 10.5
Make sure that Connected checkbox is checked beside your machine in 
Bonjour Devices.
If you want to scan using TWAIN, refer to the Mac OS X10.4 steps 
above.

6. Set the scan options on this program.
7. Scan and save your scanned image.

 

• For more information about using Image Capture, refer to the 
Image Capture’s help.

• Use TWAIN-compliant softwares to apply more scan options. 
• You can also scan using TWAIN-compliant software, such as 

Adobe Photoshop.
• If scanning does not operate in Image Capture, update Mac OS to 

the latest version. Image Capture operates properly in Mac OS X 
10.4.7 or higher.

Linux scanning

You can scan a document using the Unified Driver Configurator window.

Scanning
1. Double-click the Unified Driver Configurator on your desktop.

2. Click the  button to switch to Scanners Configuration.
3. Select the scanner on the list.

If you use only one device and it is connected to the computer and 
turned on, your scanner appears on the list and is automatically 
selected.
If you have two or more scanners connected to your computer, you can 
select any scanner at any time. For example, while acquisition is in 
progress on the first scanner, you may select the second scanner, set 
the device options and start image acquisition simultaneously.

4. Click Properties.
5. Place the originals face up in the DADF or place a single original face 

down on the scanner glass and close the DADF (see "Loading originals" 
on page 38).

6. From the Scanner Properties window, click Preview.
The document is scanned and the image preview appears in the 
Preview Pane.

7. Drag the pointer to set the image area to be scanned in the Preview 
Pane. 

8. Change the scan options in the Image Quality and Scan Area sections.
• Image Quality: This option allows you to select the color 

composition and the scan resolution for the image.
• Scan Area: This option allows you to select the page size. The 

Advanced button enables you to set the page size manually.
If you want to use one of the preset scan option settings, select the 
option from the Job Type drop-down list (see "Adding Job Type 
Settings" on page 87).
Click Default to restore the default setting for the scan options.

9. When you finish, click Scan to start scanning.
The status bar appears on the bottom left of the window to show you the 
progress of the scan. To cancel scanning, click Cancel.

10. The scanned image appears.
If you want to edit the scanned image, use the toolbar (see "Using the 
Image Manager" on page 88).

11. When you are finished, click Save on the toolbar.
12. Select the file directory where you want to save the image and enter the 

file name.
13. Click Save.

Adding Job Type Settings
You can save your scan option settings for later use.

To save a new Job Type setting:
1. Change the options from the Scanner Properties window.
2. Click Save As.
3. Enter the name for your setting.
4. Click OK. 

Your setting is added to the Saved Settings drop-down list.
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To save a Job Type setting for the next scan job:
1. Select the setting you want to use from the Job Type drop-down list.
2. The next time you open the Scanner Properties window, the saved 

setting is automatically selected for the scan job.

To delete a Job Type setting
1. Select the setting you want to delete from the Job Type drop-down 

list.
2. Click Delete.

The setting is deleted from the list

Using the Image Manager
The Image Manager application provides you with menu commands and 
tools to edit your scanned image.

Use the following tools to edit the image:

For further details about the Image Manager application, refer to the on 
screen help.

Tools Name Function

Save Saves the image.

Undo Cancels your last action.

Redo Restores the action you canceled.

Scroll Allows you to scroll through the image.

Crop Crops the selected image area.

Zoom Out Zooms the image out.

Zoom In Zooms the image in.

Scale Allows you to scale the image size; you can 
enter the size manually, or set the rate to scale 
proportionally, vertically, or horizontally.

Rotate Allows you to rotate the image; you can select 
the number of degrees from the drop-down list.

Flip Allows you to flip the image vertically or 
horizontally. 

Brightness Allows you to adjust the brightness or contrast 
of the image, or to invert the image.

Properties Shows the properties of the image.
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6.Using smarthru workflow, shared folder, and 
stored document
This chapter explains how to use SmarThru Workflow with your machine.

This chapter includes:

• About SmarThru Workflow
• Understanding the SmarThru Workflow screen

• Workform execution

  

About SmarThru Workflow
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SmarThru™ Workflow is a document sending solution that allows users to 
operate devices on the network by performing a set of pre-constructed tasks 
called a “Workform.” These Workforms allow repetitive and time-consuming 
tasks to be automated, making the users’ work days less tedious and more 
productive.

Understanding the SmarThru Workflow screen

To use the SmarThru Workflow feature, press SmarThru Workflow on 
the Main screen.

 

To switch to the other display screen, press the left or right arrow on 
the display screen.

LDAP Server, Domian Server FTP Server

Microsoft Sharepoint Server Fax Server

Network Folder Google Docs

PCFax Server E-mail Server

Database Client Systems

User

SMTP Server
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Workflow Screen

What are “Workform” and “Metadata”?
A “Workform” is a work process created by combining various 
embedded plug-ins together to achieve a desired end result for a 
document.
Metadata is extra information provided by the Workform creator for 
Workforms that use Scan or Direct input plug-ins.

Public Workform Tab
The Public tab shows public Workforms created for user groups by an 
administrator.

• Refresh: Refresh the Workform information.
• Detail: Shows the details of a Workform.
• Select: Select the Workform for job execution

Private Workform Tab
The Private tab shows private Workforms created for a private user by 
the current authenticated user.

• Refresh: Refresh the Workform information.
• Detail: Shows the details of Workform.
• Select: Let users move to next screen for more options.

Workform Creation Screen
Add a new Workform, execute SmaThru Workflow and log in. You can 
create a maximum of 100 public Workforms.

 

SmaThruWorkflow should be installed on the network server. To 
install SmaThruWorkflow refer to the Administrator’s Guide on the 
supplied CD.

Workform Creation
1. Excute SmaThruWorkflow 

(Programs>SmarThru Workflow>SmarThru Workflow).
2. Enter your ID and Password to log into the system. 

3. Select Workform > Workformanager from the main menu.

4. Select whether it will be a Public Workform or Private Workform 
from the left pane.

5. Click Create.
The Workform Creation page opens.

6. Enter the workform’s properties.
7. Drag-and-drop the plug-ins from the left pane to the appropriate 

section in the data pane, or click on the green checkmark that 
appears in the icon’s upper-right corner.
Each task in the workform will be performed in the order in which 
they appear in the workform.

8. Click Save.
The Workform will appear on the Workform Manager page.

9. If the status is Incomplete, a plug-in has not been configured 
completely. Select the workform and click Edit to make changes to 
the Workform.
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Workform execution

Users can operate various jobs with Workforms. 

1. Press SmarThru Workflow on the main screen.

2. Press one of the Workforms in the list and Select.

3. Press metadata and Next. 

• Modify: Allows users to modify the selected metadata information.
• Next: Lets user select next metadata.
• Cancel : Quit without saving.

4. If you want to change the settings, change parameters in the Basic, 
Advanced, Image and Output tabs.

5. Press start on the control panel. The result files will be saved in the 
location that you set up while you created the Workform.

Understanding the Shared Folder screen

This feature allows you to use the machine’s memory as a shared folder. 
The advantage of this feature is that you can conveniently use the shared 
folder through your computer.

 

The administrator can set the ID and password to restrict the user’ s 
access and also set the maximum number of simultaneous users.

Creating a shared folder

1. Press the  icon in the upper-right corner to create a folder.

2. Enter a foldername in the blank field.
3. Press OK.

Using the shared folder

You can use the shared folder in the exact same way as a normal computer. 
Create, edit, and delete the folder or file as a normal Windows folder. You 
also store scanned data in the shared folder. You can directly print files 
stored in the shared folder. You can print TIFF, BMP, JPEG, and PRN files.
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Registering users

You can the shared folder in the exact same way as a normal computer. 
Create, edit, and delete the folder or file as a normal Windows folder. You 
also store scanned data in the shared folder. You can directly print files 
stored in the shared folder. You can print TIFF, BMP, JPEG, and PRN files.

1. Press Stored Document on the main screen.
2. Press Public or Private tab, then you can see the saved files.

 

If there is no file, you can save files from your PC (see "Print 
Mode" on page 105).

3. You can Rename, Delete or Print files. 
4. Select Workform > Workformanager from the main menu.

Understanding the Stored Document screen

You can store documents sent from computers or scanned images in the 
Stored Document. The Stored Document is located on your machine’s 
hard disk drive (HDD), which means the documents are stored on the HDD. 
You can create a password for a certain Stored Document, so unauthorized 
users cannot access it. Also, you can print stored documents by using a 
variety of printing features and send the documents to several destinations 
such as email, server, or fax. You can set a Stored Document and use 
Stored Document feature with SyncThru™ Web Service (see "Setting up an 
address book using SyncThru™ Web Service" on page 96).

 

If important data is stored in the Stored Document, we recommend 
you to backup the data regulary. Samsung disclaims all responsibility 
for damage or loss of data caused by misuse or failure of the machine.

To use the Stored Document feature, press Stored Document on the 
display screen.

Stored Document allows you to store the scanned data on the HDD (your 
machine's hard disk drive) in your machine. The stored data can be sent to 
different destinations like Fax, Email, Server, Box, or USB.

• Public: All users can access the files.
• Private: Set up a password to prevent unauthorized persons from 

accessing. 
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Saving documents in the Stored Document
1. Press Stored Document on the main screen.
2. Press Public or Private tab, then you can see the saved files.

 

If there is no file, you can save files from your PC (see "Print 
Mode" on page 105).

3. You can Rename, Delete or Print files. 
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7.Setting up an address book
This guide gives you guidelines for the address book.

This chapter includes:

• Setting up an address book using the control panel • Setting up an address book using SyncThru™ Web Service
  

Setting up an address book using the control 
panel

You can save frequently used fax numbers, e-mail addresses, SMB server 
addresses, and FTP server addresses in your machine.
• Individual: Stores up to 500 recipients’ information.
• Group: Makes groups when you frequently send the same document to 

several destinations. You can register up to 500 recipients in a group. 
Entries stored here will be available for selection within the sending list 
on the Basic tab of Fax, Scan to Email or Scan to Server. Sending 
Group can be also setup comprising of many Individual entries.

 

You cannot register a group as you register an individual in a 
group.

Storing Individual address (Fax, E-Mail)
1. Press Machine Setup > Application Settings > Address Book > New 

from the display screen

2. Press the Name input area. Then enter the name of the recipient.

 
Check the  (favorite) icon for addresses you often use. You 
can easily find them from the search results.

3. Speed Dial No. is automatically filled with the first free number.

 

Speed Dial No. is the number representing a recipient’s 
information: you can use the numeric keypad on the control panel.

4. Press the Fax No. input area and enter the fax number using the 
numeric keypad on the control panel.

 

• Inserting a pause: with some telephone systems, you must dial 
an access code (9, for example) and listen for a second dial 
tone. In such cases, you must insert a pause in the telephone 
number. 

5. Press the E-mail input area. Then enter the e-mail address of the 
recipient. 

6. Press the OK to save the information.

Storing Individual addresses (SMB, FTP)
1. Press Machine Setup > Application Settings > Address Book > New 

> SMB or FTP >  (individual) icon from the display screen.

2. Press the Name input area. Then enter the name of the individual.

 
Check the  (favorite) icon for addresses you often use. You 
can easily find them from the search results.

3. Press IP or Host, then press the IP Address/Host input area. Then 
enter the server address in dotted decimal notation or a host name.

4. Press the Port No. input area. Then enter the server port number.
5. Press the User Name input area. Then enter the user name. 

 

• In case of SMB or FTP, if you want the server to permit access 
for unauthorized persons. Press the Anonymous box. This 
box is unchecked by default. If you checked the Anonymous 
box, go to step 7.

6. Press the Password input area. Then enter the password. 
7. Press the User Domain input area. Then enter the domain name.

 

If the SMB server you entered is not registered on any domain, 
leave it blank or enter the computer name of the SMB server.

8. Press the Path input area. Then enter the name of file folder where the 
sent files are to be stored. 
Example: /FileFolder/

9. Press the File Name input area. Enter the name of the sent file.
10. Select the File Policy option you want using the arrow. If the server has 

a file with the same name already, the file will get processed by following 
the file policy you selected.
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• Change Name: The sent file is saved as a different file name that is 
automatically generated.

• Cancel: Does not save the sent file.
• Overwrite: The sent file overwrites the existing file.

11. Select the Folder Creation option you want.
• Use Login Name: If you select this option the machine creates a 

sub-folder in the file folder you selected. The sub-folder is named 
using the user name entered in step 5.

 

If the file folder has a sub-folder with the same name already, 
the machine does not create a sub-folder.

• Folder Creation Cycle: You can set the cycle of sub-folder 
creation. The machine create a sub-folder according to this option 
set.

 

If the file folder has a sub-folder with the same name already, 
the machine does not creates a sub-folder.

- Every Day: A sub-folder is created every day. The sub-folder 
name format is YYYY-MM-DD (e.g. 2012-01-01).

- Every Month: A sub-folder is created every month. The 
sub-folder name format is YYYY-MM (e.g. 2012-01).

- Every Year: A sub-folder is created every year. The sub-folder 
name format is YYYY (e.g. 2012).

• Create Folder For Multiple Files: If you select this option and 
scanned multiple files, the machine creates a sub-folder in the file 
folder you selected, and the sent files will be stored in the sub-folder.

 

If all folder creation options are enabled at the same time, the sent 
file(s) will be stored as shown below.
• When a single scanned file is sent:

\\folder\user name\2012-01-01\DOC.jpg
• When multiple scanned files are sent:

\\folder\user name\2012-01-01\DOCJPEG\DOC000.jpg
\\folder\user name\2012-01-01\DOCJPEG\DOC001.jpg
\\folder\user name\2012-01-01\DOCJPEG\DOC002.jpg

12. Press OK to save the information.

Editing Individual address
1. Press Machine Setup > Application Setting > Address Book from the 

display screen.

2. Press the name of the individual you want to edit. Press the  (edit) 
icon.

 

If you want to delete an individual address, select the checkbox for 

the address you want to delete and press the  (delete) icon.

3. Press the input area you want to change. Then change the contents 
using the pop-up keyboard, or numeric keypad on the control panel. If 
you use the pop-up keyboard.

4. Press the  icon to save the information.

Storing Group address

1. Press Machine Setup > Application Settings > Address Book >  

(new) icon >  (group) icon from the display screen.

2. Press the Group Name input area. Then enter the group name.
3. Press the Add Member. Select the checkbox for the individual address 

to include and press the  icon.

 

If you are not sure of the name, you can use the Input Address 

area. Enter the first few letters or just press the  (search) icon. 
The machine shows the individual list. Select the checkbox you 

want include an individual address and press the  icon.

4.  Press the  icon to save the information.

Editing Group address
1. Press Machine Setup > Application Settings > Address Book from 

the display screen.

2. Press the name of group you want to edit. Press the  (edit) icon.

 

If you want to delete an group address, select the checkbox you 
want to delete and press the  (delete) icon.

3. Press the Group Name input area. Change the group name.
4. Press the Add Member. Select the checkbox for the individual address 

to include and press the  icon.

 

If you are not sure of the name, you can use the Input Address 

area. Enter the first few letters or just press the  (search) icon. 
The machine shows the individual list. Select the checkbox you 

want include an individual address and press the  icon.

5. If you want to delete an individual address, select the checkbox you 

want to delete and press  (delete) icon. The name of the individual 
will be deleted from the group.

6. Press the  icon to save the information.

Searching the Address Book for an entry
You can search the addresses that are currently stored in the address book. 

1. Press Machine Setup > Application Setting > Address Book > 
upper’s left button from the display screen.

2. Press the specific category you want. 
You can find addresses in a specific category such as All, Individual, 
Group, Favorite, or Email.

3. The machine shows the search results.

 

If you are not sure of the name, you can use the Input Address 

area. Enter the first few letters or just press the  (search) icon.

Deleting an entry in an Address Book
You can delete the selected address currently stored in an address book. 
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1. Press Machine Setup > Application Setting > Address Book from the 
display screen.

2. Select the address’s checkbox you want to delete and press the  
(delete) icon.

3. Press the  icon when the confirmation window appears.
The selected address will be deleted from the list.

Checking Address Book for an entry
You can see an individual’s or group’s address information. 

1. Press Machine Setup > Application Setting > Address Book from the 
display screen.

2. Press the address you want to see.
The display screen shows all the information for the address.

 

You can edit the address directly pressing  (edit) icon in the 
detail’s screen, or if you select a group address, you can also see 
the individual addresses in the group address.

Setting up an address book using SyncThru™ 
Web Service

You can store addresses conveniently from a networked computer using 
SyncThru™ Web Service. Only users registered in the machine can store 
addresses through login SyncThru™ Web Service.

Storing on your local machine
This method means that you store addresses on your machine’s hard drive. 
You can add addresses, as well as group them in particular categories.

Adding addresses in Individual Address Book
1. Turn your networked computer on and open the web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access the SyncThru™ Web Service 

shows. 

 

If necessary, you can change the language in the upper corner 
of SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain you log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click AddressBook. 
8. Click Add.
9. Enter the name to be added, and select the speed dial number in 

General.

 

• Speed Dial Number is the number representing a 
recipient’s information, you can use the numeric keypad on 
the control panel.

• Check Favorite for addresses you often use. You can 
easily find them from the search results.

10. Enter the email address in E-mail.
11. Enter the fax number in Fax.

12. Check the enable SMB box in SMB. You can enter the SMB 
information after checking this checkbox.

13. Enter the server address in decimal notation or a host name in SMB 
Server Address.

14. Enter the server port number in SMB Server Port.
15. Enter the login name in Login Name.

 

In case of SMB or FTP, if you want the server to permit access 
for unauthorized persons. Press the Anonymous box. This 
box is unchecked by default. If you checked the Anonymous 
box, go to step 18.

16. Enter the password in Password, and re-enter the password in 
Confirm Password.

17. Enter the domain name in Domain.

 

If the SMB server you entered is not registered on any domain, 
leave it blank or enter the computer name of the SMB server.

18. Enter the scan file folder for storing scanned images in Path. 
Example: /sharedFolder/

19. Select the Scan folder creating policy option you want.
• Create new folder using login name: If you select this option, 

the machine creates a sub-folder in the file folder you selected. 
The sub-folder is named using the user name you entered in step 
15.

 

If the file folder has a sub-folder with the same name 
already, the machine does not create a sub-folder.

• Create new folder every: You can set the cycle of sub-folder 
creation. The machine creates a sub-folder according to this 
option set.

 

If the file folder has a sub-folder with the same name 
already, the machine does not create a sub-folder.

- Day: A sub-folder is created every day. The sub-folder name 
format is YYYY-MM-DD (e.g. 2012-01-01).

- Month: A sub-folder is created every month. The sub-folder 
name format is YYYY-MM (e.g. 2012-01).

- Year: A sub-folder is created every year. The sub-folder 
name format is YYYY (e.g. 2012).

• Create new folder only if scan output consist of several 
files: If you select this option and scanned multiple files, the 
machine creates a sub-folder in the file folder you selected, and 
the sent files will be stored in the sub-folder.

 

If all folder creation options are enabled at the same time, the 
sent file(s) will be stored as below.
• When single scanned file is sent:

\\folder\user name\2012-01-01\DOC.jpg
• When multiple scanned files are sent:

\\folder\user name\2012-01-01\DOCJPEG\DOC000.jpg
\\folder\user name\2012-01-01\DOCJPEG\DOC001.jpg
\\folder\user name\2012-01-01\DOCJPEG\DOC002.jpg

20. Select the policy for generating file name in Filing Policy. If the 
server has a file with the same file name already, the file will get 
processed by following the file policy you selected.
• Change Name: The sent file is saved as a different file name 

that is automatically generated.
• Cancel: Does not save the sent file.
• Overwrite: The sent file overwrites the existing file.
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21. Enter the file name in File Name, which is to be stored in the server.
22. Click Test to check the server’s information,.
23. Enter FTP server information almost same as you do for SMB. 
24. Click Apply.

 

Press Undo to delete the information you entered. If you press 
Cancel, the Add window is closed.

Editing addresses in an Individual Address Book
1. Turn your networked computer on and open a web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access SyncThru™ Web Service. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click Address Book. 
8. Check an address you want to edit and press Edit.
9. Change the address information.
10. Click Apply.

 

Press Undo to delete the information you entered. If you press 
Cancel, the Edit window is closed.

Deleting addresses in an Individual Address Book
1. Turn your networked computer on and open a web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access SyncThru™ Web Service. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
it automatically gets logged out.

7. Click Address Book. 
8. Check an address you want to delete and click Delete.

If you select the column headers’ checkbox, all addresses are 
checked.
Click OK when the confirmation window appears.

Searching addresses in an Individual Address Book
1. Turn your networked computer on and open the web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access SyncThru™ Web Service. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click Address Book. 

 

You can change the arrangement by clicking each column 
header. For example, clicking Speed No., you can see the 
addresses in the order of speed dial number. If you click 
Speed No. again, you can see them in the reversed order.

8. Enter the name for which you want to search in the search input 
area. 

 

You can find addresses in a specific category such as Fax 
Number, E-mail, SMB, etc.
For example, if you want to find the fax number, click drop 

down list next to the  and select Fax Number.

9. Click the . Then the search result appears.

 

You can see the addresses in a specific category such as Fax 
Number, E-mail, SMB, etc.
For example, if you want to see the addresses which are 
included fax number, click drop down list below LDAP and 
select Fax Number.

Importing an Individual Address Book
You can import an address book file from a server or computer. The file 
should have the file extension ‘csv’. Also you can import addresses from 
a LDAP server. Before importing the addresses to your machine, an 
LDAP server administrator should store the addresses.

1. Turn your networked computer on and open a web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access the SyncThru™ Web Service 

shows. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click Address Book. 
8. Select Import.
9. Select URL or Desktop, and enter the address or folder name where 

the file is stored.
10. Click OK.

Exporting an Individual Address Book
You can export an address book file to your computer for backup of the 
file or to another Samsung machine. 
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1. Turn your networked computer on and open a web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access SyncThru™ Web Service. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click AddressBook. 
8. Select Export.
9. Click Export. Then the address book file is stored in your computer.

Grouping addresses in Groups Address Book
1. Turn your networked computer on and open a web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access SyncThru™ Web Service. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click AddressBook. 
8. Click Groups. 
9. Click Add Group.
10. Enter the group name to be added in Group Name.
11. Check Add individual(s) after this group is created.

 

If you do not want to add individual addresses to the group 
address you made, skip this step. You can add individual 
addresses next time by pressing Group Details.

12. Click Apply.
13. Check the addresses you want to add to Group Address Book from 

Individual Address Book.
14. Click the arrow in the middle. The selected addresses are added to 

Group Address Book.
15. Click Apply.

Editing Group addresses in Groups Address Book
1. Turn your networked computer on and open a web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access the SyncThru™ Web Service 

shows. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click AddressBook. 
8. Click Groups. 
9. Check the group address you want to edit and press Edit Group. 
10. Change the group address information.
11. Click Apply.

 

Press Undo to delete the information you entered. If you press 
Cancel, the Edit window closes.

Deleting Group addresses in a Groups Address Book
1. Turn your networked computer on and open a web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access SyncThru™ Web Service. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click AddressBook. 
8. Click Groups. 
9. Check the group addresses you want to delete.
10. Click Delete Group.

Click OK when the confirmation window appears.

Checking Group Addresses
You can see information for group addresses. You can also add or 
delete individual addresses in the Group Details window.

1. Turn your networked computer on and open a web browser.
2. Enter your machine’s IP address as the URL in a browser.

(Example, http://123.123.123.123)
3. Press Enter or click Go to access SyncThru™ Web Service. 

 

If necessary, you can change the language in the upper right 
corner of the SyncThru™ Web Service.

4. Click Login.
5. Enter the ID and password, and select a domain to log into the 

machine.
6. Click Login.

 

If you do not use the SyncThru™ Web Service for five minutes, 
you will be automatically logged out.

7. Click AddressBook. 
8. Click Groups. 
9. Press the group address you want to see. Press Group Details.
Setting up an address book_ 98



 

• You can add individual addresses directly. Check the 
addresses you want to add to Group Address Book from 
Individual Address Book.

• You can delete individual addresses directly. Check the 
addresses you want to delete and press Delete in Group 
Address Book.
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8.Printing
This chapter explains common printing tasks.

This chapter includes:

• Printer driver features
• Basic printing
• Opening printing preferences
• Using help
• Setting Device Options
• Using special print features
• Using direct printing utility

• Changing the default print settings
• Setting your machine as a default machine
• Printing to a file (PRN)
• MAC printing
• Linux printing
• UNIX Printing

  

 

The procedures in this chapter are mainly based on Windows XP.

Printer driver features

Your printer drivers support the following standard features:
• Paper orientation, size, source, and media type selection
• Number of copies

You can also use various special printing features. The following table 
shows a general overview of features supported by your printer drivers:

 

Some models or operating systems may not support all feature(s) 
shown in the following table.

(●: Supported, Blank: Not supported)Feature

PCL/PSa/X
PS

PS

Windows MAC Linux Unix

Machine quality 
option

● ● ● ●

Poster printing ●

Multiple pages per 
sheet 

● ● ● ●

Booklet printing ● ● ● ●

Fit to page printing ● ●

Reduce and enlarge 
printing

● ●

Different source for 
first page

● ●

Cover page options ● ● ● ●

Raster compression ● 
(PCL only)

Finishing options ● ● ● ●

Output options ● ● ● ●

Watermark ●

Overlay ●
(PCL only)

Double-sided printing 
(duplex)

● ● ● ●

a.The PostScript driver is recommended for best print quality from 
PostScript-based applications such as Acrobat Reader®, Adobe 
Illustrator®, Adobe Photoshop®, etc.

Feature

PCL/PSa/X
PS

PS

Windows MAC Linux Unix
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Basic printing

 

• MAC printing (see "MAC printing" on page 110).
• Linux printing (see "Linux printing" on page 113).
• UNIX printing (see "UNIX Printing" on page 114).

The following Printing Preferences window is for Notepad in Windows 7. 
Your Printing Preferences window may differ, depending on your 
operating system or the application you are using. 

1. Open the document you want to print.
2. Select Print from the File menu.
3. Select your machine from the Select Printer list.

The basic print settings, including the number of copies and print range, 
are selected within the Print window. 

 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print 
window to change the print settings (see "Opening printing 
preferences" on page 101).

4. To start the print job, click OK or Print in the Print window.

Canceling a print job
If the print job is waiting in the print queue or print spooler, cancel the job as 
follows:
• You can access this window by simply double-clicking the machine icon 

( ) in the Windows task bar. 

• You can also cancel the current job by pressing (Stop) on the 

control panel.

Opening printing preferences

 

When you select an option in Printing Preferences, you may see a 

warning mark,  , or  . An exclamation mark ( ) means you 

can select that certain option, but it is not recommended, and  ( ) 
mark means you cannot select that option due to the machine’s 
settings or environment.

1. Open the document you want to print.
2. Select Print from the File menu.
3. Select your printer driver from the Select Printer list. 

4. Click Properties or Preferences. 

 

You can check the machine’s current status pressing the Printer 
Status button .

Favorites tab
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Basic tab

Orientation
This option allows you to select the direction in which information is 
printed on a page. 

Layout Options
This option allows you to select various ways to layout your document.
• Single Page Per Side: This option is a basic layout option. This 

option allows you to print a page on one side of a sheet of paper. 
• Multiple Pages Per Side: see "Printing multiple pages on one 

sheet of paper" on page 106.
• Poster Printing: see "Printing posters" on page 107.
• Page Border: This option allows you to print your documents with 

border lines. This option is not available for Poster Printing and 
Booklet Printing.

Double-Sided Printing
This option allows you to print on both sides of a sheet of paper (see 
"Printing on both sides of the paper" on page 107).

Finishing Options
This option allows you to specify the number of staples.

 

• The Staple option is available only when the optional Inner 
Finisher is installed.

Paper tab
Use the Paper tab options to set the basic paper handling specifications. 
Click the Paper tab to display the options shown below.

Copies
This option allows you to choose the number of copies to be printed. 
You can select 1 to 9999 copies. 

Paper Options
• Original Size: This option allows you to set the actual paper size of 

the originals.
• Output Size: This option allows you to scale your print job to any 

selected paper size regardless of the original’s size (see "Fitting your 
document to a selected paper size" on page 107).
- Percentage: This option allows you to change the size of a 

page’s contents to appear larger or smaller on the printed page 
by entering a percentage for reduction or enlargement (see 
"Change the size of your document" on page 107).

• Source: Make sure that Source is set to the corresponding paper 
tray. Use MP Tray when printing on special materials, such as 
envelopes and transparencies. 

• Type: This option allows you to set the type of paper to be loaded in 
the tray. This will let you get the best quality printout. If not, the 
desired print quality may not be achieved.

• Special Pages: This option is allows you to make special pages 
such as covers. You can add, delete, or update the special page 
settings to the list.
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Graphics tab
Use the Graphic tab options to adjust the print quality for your specific 
printing needs.

Document Type
You can the document’s type. This option allows you to set the actual 
type of the originals.

Color Mode
You can choose color options. Setting this option to Color typically 
produces the best possible print quality for color documents. If you want 
to print a color document in grayscale, select Grayscale. 
To adjust color manually, click Advanced. Simply slide the color 
balance slider in the Levels tab to adjust color, or click the Matching tab 
for driver provided color correction for general image processing.

Click the question mark ( ) in the upper-right corner of the window 
and click on any option for more information.

 

• If you click Reset, settings in the Levels or Matching return to 
the default setting.

• You can change the image which is in the Advanced option. 
Click the Import Image button and select a different image.

Font/Text
Select Clear Text to print text darker than in a normal document.
Check All Text Black to print in solid black, regardless of the color it 
appears on the screen.

Advanced

Click the question mark ( ) in the upper-right corner of the window 
and click on any option for more information.

• For the PCL printer driver:

• For the PS printer driver:

 

If you click Reset, settings in the Advanced option return to the 
default setting.

Finishing tab

• Sort Options: This option allows you to sort out the printouts easily.

- None: Disables this option.
- Offset: When printing multiple copies, this option shifts the output 

position of each set.

 

This feature is available only when the Inner Finisher is 
installed.
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- Rotate: When printing multiple copies, the printouts are stacked 
criss-crossed in sets.

 

• This feature is available only when the standard or booklet 
finisher is not installed.

• This feature is available only with Letter- and A4-sized print 
media.

• Before using this feature, you have to load the paper in the 
trays with SEF (Short edge feed) and LEF (Long edge 
feed). For example, direction of paper feeding in the tray 1 
is SEF, and direction of paper feeding in the tray 2 is LEF.

• Staple Options: This option allows you to specify the number of 
staples and the staple position. This option is available only when the 
optional Inner Finisher is installed.

• Output Tray Options: This option allows you to specify the tray where 
to output the printed documents (see "Tray setting" on page 47”).

Advanced tab
Use the Advanced tab to set various printing options. 

Watermark
see "Using watermarks" on page 108.

Overlay
see "Using overlay" on page 108. 

Output options
• Print Order: This options allows you to set the sequence in which 

the pages will print. Print Odd Pages and Print Even Pages are 
available only when you use the PCL printer driver.

• Skip Blank Pages: This option allows you to specify not to print 
blank pages in the original data. 

• Manual Margin: This option allows you to specify the binding 
margin. Binding margin adjusts the binding position. This option is 
not available when you use the PS printer driver.

• PostScript Options: These options are available only when you 

use the PS printer driver. Click the question mark ( ) in the 
upper-right corner of the window and click on any option you want to 
know about.

 

If you click Reset, settings in the Advanced option return to the 
default setting.

Security
Encrypts printing data first, and transmits it to the machine. This feature 
protects the print information even though the data is snatched on a 
network. Job Encryption feature is enabled only when the hard drive is 
installed. The hard drive is used to decrypt the print data.

Job Accounting
This option allows you to print with the given permission.
• User permission: If you check this option, only users with user 

permission can start a print job.
• Group permission: If you check this option, only groups with group 

permission can start a print job.

 

• Click the question mark ( ) in the upper-right corner of the 
window and click on any option for more information.

• Administrators can enable job accounting and configure 
permissions in the control panel or SyncThru™ Web Service. 
For detailed information about them, refer to the 
Administrator’s Guide.
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Eco tab
The Eco tab allows you to save print resources and lead you to eco-friendly 
printing. When you select Eco Printing, you can see the eco image 
( )on some options. Also, Some options are not available in eco mode.

Eco Options
• Printer Default: If you select this option, this feature is determined 

by the setting you’ve made on the control panel of the machine.
• None: Disables this option.
• Eco Printing: Eco mode gets activated. Select Double-Sided 

Printing, Layout, Color Mode, and Skip Blank Pages you want to 
use in eco mode. As long as you do not change the options from the 
other tabs, the document will be print out as set in the eco mode.

• Password: If the administrator sets On-Forced in Default Eco 
Mode for this machine, the eco mode is always set by this machine’s 
eco setting, while the Eco Options in the printer driver is disabled. If 
you need to change the print settings, click Password and enter the 
password or contact your administrator.

Result Simulator
Result Simulator shows the result of reduced emission of carbon 
dioxide, used electricity, and the amount of saved paper in accordance 
with the settings you selected.

 

• The results are calculated on the basis that the total number of 
printed paper is one hundred without a blank page when eco 
mode is disabled.

• Refer to the calculation coefficient about CO2, energy, and 
paper from IEA, the index of Ministry of Internal Affairs and 
Communication of Japan and www.remanufacturing.org.uk. 
Each model has a different index. 

• The power consumption in printing mode refers to the average 
printing power consumption in this machine. 

• The actual saved or reduced amount may differ depending on 
the operating system used, computing performance, 
application software, connection method, media type, media 
size, job complexity, etc.

Samsung tab
Use the Samsung tab to display the copyright and the version number of 
the driver. If your computer is connected to the Internet, you can have 
access to additional device services.

Print Mode
This option allows you to choose how to print or save the print file by using 
the HDD in your machine. The default Print Mode is Normal which is for 
printing without storing the printing file on the HDD. You can also use this 
option in other tabs.

• Normal: This mode prints without storing your document.
• Confidential: This mode is used for printing confidential documents. 

You need to enter a password to print using it .
• Store: This mode is used only for storing documents on the HDD. If 

necessary, you can load and print the stored documents. You can find 
the stored file in the Stored Document. First, choose a Stored 
Document in Save Location and then set Options.

• Store and Print: This mode is used when printing and storing 
documents at the same time. If necessary, you can load and print the 
stored documents. You can find the stored file in the Stored Document 
. First, choose a Stored Document in Save Location and then set 
Options.

 

• Job Name: This option is used when you need to find a stored file 
using the control panel.

• User ID: This option is used when you need to find a stored file 
using the control panel. The user name automatically appears as 
the user name that you use to log on Windows.

• Enter Password: If the Property of the Stored Document you 
selected is Secured, you have to enter the password for the 
Stored Document. This option is used for loading a stored file 
using the control panel. 

• Confirm Password: Re-enter the password to confirm it.

Using a favorite setting
The  Favoritesoption, which is visible on each preferences tab except for 
Samsung tab, allows you to save the current preferences settings for future 
use. 
To save a Favorites item:
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1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Favorites input box. 

3. Click . Then all current driver settings are saved. If you want to 

update the setting you made, select more options and click .

To use a saved setting, select it from the Favorites drop-down list. The 
machine is now set to print according to the setting you selected.
To delete a saved setting, select it from the Favorites drop-down list 

and click . 

You can also restore the printer driver’s default settings by selecting  
Default Favorites from the Favorites drop-down list.

Using help

Click the question mark in the upper-right corner of the window and click on 
any option for more information. Then a pop-up window appears with 
information about that option's feature which is provided from the driver.

If the question mark does not appear, select the option you want to know 
about and press F1 on your keyboard.

If you want to search information via a keyword, click the Samsung tab in 
the Printing Preferences window, and enter a keyword in the input line of 
the Help option.

Setting Device Options

When you install the optional devices such as optional dual cassette feeder, 
Inner Finisher, etc, this machine automatically detects and sets the optional 
devices. If you cannot use the optional devices you installed in this driver, 
you can set the optional devices in Device Options. Job Accounting allows 
you to print with the given permission.

1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers.
3. Right-click your machine. 
4. For Windows XP/2003/2008/Vista, press Properties.

• For the PS driver, select the PS driver and right-click to open 
Properties.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printer properties.

 

If Printer properties item has a ► mark, you can select other 
printer drivers connected with the selected printer.

5. Select Device Options. 

 

The Properties window may differ depending on the driver or 
operating system you are using.

6. Select the appropriate option.
• Tray Options: Select the optional tray you installed. You can select 

the Tray 3,4 (dual cassette feeder). 
• Finisher Options: Select the optional finisher you installed.
• Administrator Settings: You can select the Printer Status and 

EMF Spooling.
• Advanced: Select one of the options. This option is available only 

when you use the PS printer driver. Click the question mark ( ) in 
the upper-right corner of the window and click on any option you 
want to know about.

 

If you click Reset, settings in the Advanced returns to the 
default setting.

• Font Substitution: Displays the font substitution table and options 
for changing the TrueType-to-printer font mapping. This option is 
available only when you use the PS printer driver.

• Admin Job Accounting: Allows you to associate user and account 
identification information with each document you print.
- User permission: If you check this option, only users with user 

permission can start a print job.
- Group permission: If you check this option, only groups with 

group permission can start a print job.

 

• If you want to encrypt job accounting password, check Job 
Accounting Password Encryption.

• Administrators can enable job accounting and configure 
permissions in the control panel or SyncThru™ Web 
Service. For the detailed information about them, refer to 
the Administrator’s Guide.

7. Click OK until you exit the Properties or Printer properties window.

Using special print features

Special print features include:
• "Printing multiple pages on one sheet of paper" on page 106.
• "Printing posters" on page 107.
• "Printing on both sides of the paper" on page 107.
• "Change the size of your document" on page 107.
• "Fitting your document to a selected paper size" on page 107.
• "Using watermarks" on page 108.
• "Using overlay" on page 108.

Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet. 

1. To change the print settings from your software application, access 
Printing Preferences (see "Opening printing preferences" on 
page 101).

2. Click the Basic tab, select Multiple Pages per Side in the Type 
drop-down list.

3. Select Page Border to print a border around each page on the sheet.
4. Select the number of pages you want to print per sheet  

(2, 4, 6, 9, or 16) in the Pages per Side drop-down list.
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5. Select the page order from the Page Order drop-down list, if necessary. 
6. Click the Paper tab, select the Original size, Source, and Type.

7. Click OK or Print until you exit the Print window.

Printing posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form one 
poster-size document.

1. To change the print settings from your software application, access 
Printing Preferences (see "Opening printing preferences" on 
page 101).

2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.

Specification of the page layout:
4. Select the Poster Overlap value. Specify Poster Overlap in millimeters 

or inches by selecting the radio button on the upper right of Basic tab to 
make it easier to paste the sheets together.

5. Click the Paper tab, select the Original size, Source, and Type.

6. Click OK or Print until you exit the Print window.

7. You can complete the poster by pasting the sheets together.

Printing on both sides of the paper
You can print on both sides of a paper; duplex. Before printing, decide how 
you want your document oriented. You can only use this feature with Letter-, 
Legal-, Oficio-, US Folio-, A4-, ISO B5-, JIS B5-, Statement-, Executive-, 
A5-, 8K-, 16K-, Ledger- or JIS B4-sized paper.

 

Do not print on both sides of the special media, such as labels, 
envelopes, or thick paper. It may cause a paper jam or damage the 
machine. 

1. To change the print settings from your software application, access 
Printing Preferences (see "Opening printing preferences" on 
page 101).

2. Click the Basic tab.
3. From the Double-Sided Printing section, select the binding option you 

want.   
• Printer Default: If you select this option, this feature is determined 

by the setting you’ve made on the control panel of the machine. This 
option is available only when you use the PCL printer driver.

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in 
bookbinding.

• Short Edge: This option is the conventional layout used in 
calendars.

• Reverse Double-Sided Printing: Check this option to reverse the 
print order when duplex printing.

4. Click the Paper tab, select the Original size, Source, and Type.

5. Click OK or Print until you exit the Print window.

Change the size of your document
You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage for reduction or enlargement.

1. To change the print settings from your software application, access 
Printing Preferences (see "Opening printing preferences" on 
page 101).

2. Click the Paper tab.
3. Select the actual paper size of the originals from the Original Size.
4. Enter the scaling rate in the Percentage input box.

You can also click the up/down arrows to select the scaling rate. 

 

You cannot use this feature when you select a size of paper from 
the Output Size.

5. Select the Source and Type.

6. Click OK or Print until you exit the Print window.

Fitting your document to a selected paper size
This printer feature allows you to scale your print job to any selected paper 
size regardless of the document size. This option can be useful when you 
want to check fine details on a small document.
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1. To change the print settings from your software application, access 
Printing Preferences (see "Opening printing preferences" on 
page 101).

2. Click the Paper tab.
3. Select actual paper size of the originals from the Original Size.
4. Select the size of paper to be printed in the tray from the Output Size.
5. Select the Source and Type.

6. Click OK or Print until you exit the Print window.

Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1. To change the print settings from your software application, access 

Printing Preferences (see "Opening printing preferences" on 
page 101).

2. Click the Advanced tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3. Click OK or Print until you exit the print window. 

Creating a watermark
1. To change the print settings from your software application, access 

Printing Preferences (see "Opening printing preferences" on 
page 101).

2. From the Advanced tab, select Edit... from the Watermark 
drop-down list. 

3. Enter a text message in the Watermark Message box. You can 
enter up to 256 characters. The message displays in the preview 
window.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4. Select watermark options. 
You can select the font name, style, color, size, and shade from the 
Font Attributes section, as well as set the angle of the watermark 
from the Message Angle section. 

5. Click Add to add a new watermark to the Current Watermaks list.   
6. When you finish editing, click OK or Print until you exit the Print 

window.
To stop printing the watermark, select None from the Watermark 
drop-down list. 

Editing a watermark
1. To change the print settings from your software application, access 

Printing Preferences (see "Opening printing preferences" on 
page 101).

2. Click the Advanced tab, select Edit... from the Watermark 
drop-down list.

3. Select the watermark you want to edit from the Current Watermarks 
list and change the watermark message and options. 

4. Click Update to save the changes.
5. Click OK or Print until you exit the Print window. 

Deleting a watermark
1. To change the print settings from your software application, access 

Printing Preferences (see "Opening printing preferences" on 
page 101).

2. Click the Advanced tab, select Edit... from the Watermark 
drop-down list.

3. Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4. Click OK or Print until you exit the Print window.

Using overlay
This option is available only when you use the PCL printer driver.

What is an overlay?
An overlay is text and/or images stored on the computer’s hard drive 
(HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather 
than using a preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print 
a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine: just print the letterhead 
overlay on your document.

Creating a new page overlay
To use a page overlay, you must create a new page overlay containing 
your logo or image.

1. Create or open a document containing text or an image for use in a 
new page overlay. Position the items exactly as you wish them to 
appear when printed as an overlay.

2. To save the document as an overlay, access Printing Preferences 
(see "Opening printing preferences" on page 101).

3. Click the Advanced tab, and select Edit... from the Text drop-down 
list.

4. In the Edit Overlay window, click Create. 
5. In the Save As window, type a name (up to eight characters) in the 

File name box. Select the destination path, if necessary (the default 
is C:\Formover).

6. Click Save. The name appears on the Overlay List. 

7. Click OK or Print until you exit the Print window.

8. The file is not printed. Instead, it is stored on your computer’s hard 
disk drive.
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The overlay document size must be the same as the document 
you print with the overlay. Do not create an overlay with a 
watermark.

Using a page overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay with a document:

1. Create or open the document you want to print.
2. To change the print settings from your software application, access 

Printing Preferences (see "Opening printing preferences" on 
page 101).

3. Click the Advanced tab. 
4. Select the desired overlay from the Text drop-down list. 
5. If the overlay file you want does not appear in theText drop-down 

list, select Edit... from the list and click Load. Select the overlay file 
you want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Load 
window. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6. If necessary, check the Confirm Page Overlay When Printing box. 
If this box is checked, a message window appears each time you 
submit a document for printing, asking you to confirm printing an 
overlay on your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7. Click OK or Print until you exit the Print window. 
The selected overlay prints on your document. 

 

The resolution of the overlay document must be the same as that 
of the document you will print with the overlay.

Deleting a page overlay
You can delete page overlays that you no longer use. 

1. In the Printing Preferences window, click the Advanced tab. 
2. Select Edit... in the Text drop down list. 
3. Select the overlay you want to delete from the Overlay List box. 
4. Click Delete. 
5. When a confirmation message window appears, click Yes.
6. Click OK or Print until you exit the Print window.

Using direct printing utility

This chapter explains how to use the Direct Printing Utility to print PDF files 
without open the files.

 

• A HDD should be installed on your machine, to print PDF files 
using this program. 

• You cannot print PDF files that are restricted to print. Deactivate 
the printing restriction feature, and retry printing.

• You cannot print PDF files that are restricted by a password. 
Deactivate the password feature, and retry printing.

• Whether or not a PDF file can be printed using the Direct Printing 
Utility program depends on how the PDF file was created.

• The Direct Printing Utility program supports the PDF version 
1.7 and below. For a higher version, you must open the file to print 
it.

What is Direct Printing Utility?
Direct Printing Utility is a program that sends a PDF file directly to your 
machine to print without having to open the file. It sends data through the 
Windows spooler using the port of the printer driver. It only supports PDF 
format.
To install this program, select Advanced Installation -> Custom 
Installation and put a check mark for this program when you install the 
printer driver.

Printing
There are several ways you can print using the Direct Printing Utility.

From the Direct Printing Utility window
1. From the Start menu select Programs or All Programs > Samsung 

Printers > Direct Printing Utility > Direct Printing Utility.

2. Select your machine from the Select Printer drop-down list and click 
Browse.

3. Select the PDF file you wish to print and click Open.
The PDF file is added in the Select Files section.

4. Customize the machine settings for your needs. 
5. Click Print. The selected PDF file is sent to the machine.
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Using the right-click menu
1. Right-click on the PDF file you wish to print and select Direct Printing.

The Direct Printing Utility window appears with the PDF file added.
2. Select the machine you wish to use.
3. Customize the machine settings for your needs. 
4. Click Print. The selected PDF file is sent to the machine.

Changing the default print settings

 

Most Windows applications will override settings you specify in the 
printer driver. Change all print settings available in the software 
application first, and change any remaining settings using the printer 
driver.

1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers.
3. Right-click your machine.
4. For Windows 2000, XP, 2003, and Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing Preferences.

 

If Printing Preferences item has ► mark, you can select other 
printer drivers connected with selected printer.

5. Change the settings on each tab. 
6. Click OK.

 

If you want to change the settings for each print job, change it in 
Printing Preferences.

Setting your machine as a default machine
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes.
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers.
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers.
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers.
3. Select your machine.
4. Right-click your machine and select Set as Default Printer.

 

For Windows 7 and Windows Server 2008 R2, if Set as default 
printer item has ► mark, you can select other printer drivers 
connected with the selected printer.

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

To create a file:

1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK.

For example c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in 
My Documents, Documents and Settings or Users. The saved 
folder may differ, depending on your operating system or the 
application you are using.

MAC printing

 

Some features may not be available depending on models or options. 

This section explains how to print using a MAC.

Printing a document
When you print with a MAC, you need to check the printer driver setting in 
each application you use. Follow the steps below to print from a MAC:

1. Open the document you want to print.
2. Open the File menu and click Page Setup (Document Setup in some 

applications).
3. Choose your paper size, orientation, scaling, other options, and make 

sure that your machine is selected. Click OK.

4. Open the File menu and click Print. 
5. Choose the number of copies you want and indicate which pages you 

want to print. 
6. Click Print.
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Activating optional devices or accessories
After installing the optional devices or accessories, you need to activate the 
options.

1. Open System Preferences and click Print & Fax.
2. Select your machine and click Options & Supplies....
3. Select Driver and set the necessary options.

Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties window, will differ depending 
on the machine in use. Except for the name, the composition of the printer 
properties window is similar to the following.

 

• The setting options may differ depending on printers and Mac OS 
X version.

• The following panes may differ, depending on your operating 
system or the application you are using.

The following pane is the first pane you will see when you open the printer 
properties pane. Select other advanced features from the drop down list.

Layout
The Layout tab provides options to adjust how the document appears 
on the printed page. You can print multiple pages on one sheet of paper. 
Select Layout from the drop-down list.

• Pages per Sheet: This option determines how many pages are to 
be printed on one page (see "Printing multiple pages on one sheet of 
paper" on page 113).

• Layout Direction: This option allows you to select the printing 
direction on a page similar to the examples in the UI.

• Border: This option allows you to print a border around each page 
on the sheet.

• Two-Sided: This option allows you to print on both sides of a sheet 
of paper (see "Printing on both sides of paper" on page 113).

• Reverse Page Orientation: This option allows you to rotate the 
paper 180 degrees. 

Graphics
The Graphics tab provides options for selecting Quality. Select 
Graphics from the drop-down list.

• Quality: This option allows you to select the printing resolution. The 
higher the setting, the sharper the clarity of printed characters and 
graphics. A higher setting also may increase the time it takes to print 
a document.

• Color Mode: You can set the color options. Setting to Color 
typically produces the best possible print quality for color documents. 
If you want to print a color document in grayscale, select Grayscale.

Job Accounting
This option allows you to print with the given permissions.

• Accounting Type: You can select an accounting type specified by 
your system administrator.
- Accounting: You can enable print authentication by user ID and 

password.
- ID Only: You can enable print authentication by user ID only.

• User permission: If you check this option, only users with user 
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permission can start a print job.
• Group permission: If you check this option, only groups with group 

permission can start a print job.

 

• If you want to encrypt a job accounting password, refer to help 
( ) in the bottom left corner of the printer properties pane.

• Administrators can enable job accounting and configure 
permissions in the control panel or SyncThru™ Web Service. 
For the detailed information about them, refer to the 
Administrator’s Guide.

Job Setting
This option allows you to choose how to print the file by using the hard 
disk drive in your machine.This option allows you to choose how to print 
or save the file by using the HDD in your machine. 

• Print Mode: The default Print Mode is Normal.
- Normal: This mode prints without storing your document.
- Confidential: This mode is used for printing confidential 

documents. You need to enter a password to print it.
- Store: This mode is used only for storing documents on the 

HDD. If necessary, you can load and print the stored documents. 
You can find the stored file in the Stored Document (see 
"Saving documents in the Stored Document" on page 93).

- Store and Print: This mode is used when printing and storing 
documents at the same time. If necessary, you can load and print 
the stored documents. You can find the stored file in the Stored 
Document (see "Saving documents in the Stored Document" on 
page 93).

- Print Schedule: Use this option to enter a specific time to print 
the job. This is useful for printing large amount of data or if you 
want all your job to print at the same time. Select the date and 
time you want to print. User ID and Job Name are used when 
you need to find a stored document using the control panel.

 

• Print At: Select the date and time you want to print.
• User ID: This option is used when you need to find a stored 

file using the control panel. The user name automatically 
appears as the user name that you use to log into Mac OS X.

• Job Name: This option is used when you need to find a stored 
file using the control panel.

Printer Features

• Finishing: You can select the print output options such as staple, 
offset and etc. This option is available only when the optional Inner 
Finisher or booklet finisher is installed.

• Booklet Printing: This feature prints your document on both sides 
of a paper and arranges the pages so that the paper can be folded in 
half after printing to produce a booklet. Some options in Booklet 
Printing are available only when the optional stanard finisher or 
booklet finisher is installed. 

• Front Cover: Prints the document with a front cover. The front 
cover can be a blank paper or the first page in the document.

• Back Cover: Prints the document with a back cover. The back 
cover can be a blank paper or the last page in the document.

• Front and Back Cover: Prints the document with a front cover and 
a back cover. The covers can be blank papers or the first and the last 
pages in the document.

• Paper Type: This option allows you to correspond to the paper 
loaded in the tray from which you want to print. This will let you get 
the best quality printout. If you load a different type of print material, 
select the corresponding paper type.

• Edge Enhancement: This option allows you to emphasize edges of 
texts and fine lines for improving readability.

• RGB Color Simulator: This setting determines how colors are 
rendered. Standard is the most widely used setting which the color 
tone of this mode is the closest to that of standard monitor (sRGB 
Monitor). Vivid mode is appropriate for printing presentation data 
and charts. The color tone of Vivid mode produces more Vivid color 
images than that of Standard mode. Device mode is best used for 
printing fine lines, small characters and color drawings. The color 
tone of Device mode may be different from that of monitor, the pure 
toner colors are used for printing cyan, magenta and yellow colors. 
Corporate Imaging is most common color setting used in the 
corporate environment.
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Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.

1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. In the Pages 

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3. Select the other options you want to use.
4. Click Print, then machine prints the selected number of pages you want 

to print on one sheet of paper.

Printing on both sides of paper
You can print on both sides of the paper. Before printing in the duplex mode, 
decide on which edge you will be binding your finished document. The 
binding options are as follows:
• Long-Edge Binding: This option is the conventional layout used in 

book binding.
• Short-Edge Binding: This option is the type often used with calendars.

1. From your MAC application, select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. 

3. Select a binding orientation from Two-Sided option.
4. Select the other options you want to use.
5. Click Print and; the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy 
might print on the same sheet of paper. Avoid printing on both sides of 
paper when you are printing more than 1 copy. 

Linux printing

 

Some features may not be available depending on models or options.

Printing from applications
There are a lot of Linux applications that allow you to print using Common 
UNIX Printing System (CUPS). You can print on your machine from any 
such application.

1. Open an application, and select Print from the File menu
2. Select Print directly using LPR.
3. In the LPR GUI window, select the model name of your machine from 

the printer list and click Properties.

4. Change the print job properties using the following four tabs displayed at 
the top of the window.

• General: This option allows you to change the paper size, the paper 
type, and the orientation of the documents. It enables the duplex 
feature, adds start and changes the number of pages per sheet.

• Text: This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

• Graphics: This option allows you to set image options that are used 
when printing image files, such as color options, image size, or 
image position.
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• Advanced: This option allows you to set the print resolution, paper 
source, and destination.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your 

print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the 
standard CUPS, directly from the command line interface. The CUPS LPR 
utility allows you to do that, but the drivers package replaces the standard 
LPR tool with a much more user-friendly LPR GUI program.
To print any document file:

1. Type lpr <file_name> from the Linux shell command line and press 
Enter.
When you type only “LPR” and press Enter, the Select file(s) to print 
window appears first. Just select any files you want to print and click 
Open.

2. In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3. Click OK to start printing.

Configuring Printer Properties
Using the Printer Properties window provided by the Printers 
configuration, you can change the various properties for your machine as 
a printer.

1. Open the Unified Driver Configurator.
If necessary, switch to Printers configuration.

2. Select your machine from the available printers list and click Properties.
3. The Printer Properties window appears.

The following five tabs display at the top of the window:
• General: This option allows you to change the printer location and 

name. The name entered in this tab displays on the printer list in 
Printers configuration.

• Connection: This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

• Driver: This option allows you to view or select another machine 
driver. By clicking Options, you can set the default device options.

• Jobs: This option shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

• Classes: This option shows the class of your machine. Click Add to 
Class to add your machine to a specific class or click Remove from 
Class to remove the machine from the selected class.

4. Click OK to apply the changes and close the Printer Properties 
window.

UNIX Printing 

 

Some features may not be available depending on models or options. 

Proceeding the print job
After installing the printer, choose any of the image, text, or PS files to print.

1. Execute “printui <file_name_to_print>” command.
For example, if you are printing “document1”
printui document1
This will open the UNIX Printer Driver Print Job Manager in which the 
user can select various print options.

2. Select a printer that has been already added.
3. Select the printing options from the window such as Page Selection.
4. Select how many copies are needed in Number of Copies.

 

To take advantage of the printer features provided by your printer 
driver, press Properties.

5. Press OK to start the print job.

Changing the machine settings
The UNIX printer driver Print Job Manager in which the user can select 
various print options in printer Properties.
The following hot keys may also be used: “H” for Help, “O” for OK, “A” for 
Apply, and “C” for Cancel.

General tab
• Paper Size: Set the paper size as A4, Letter, or other paper sizes, 

according to your requirements.
• Paper Type: Choose the type of the paper. Options available in the 

list box are Printer Default, Plain, and Thick.
• Paper Source: Select from which tray the paper is used. By default, 

it is Auto Selection.
• Orientation: Select the direction in which information is printed on a 

page.
• Duplex: Print on both sides of a sheet of paper to save paper.

 

Automatic/manual duplex printing may not be available 
depending on models. You can alternatively use the lpr printing 
system or other applications for odd-even printing.

• Multiple pages: Print several pages on one side of a paper.
• Page Border: Choose any of the border styles (e.g., Single-line 

hairline, Double-line hairline)

Image tab
In this tab, you can change the brightness, resolution, or image position 
of your document.

Text tab
Set the character margin, line space, or the columns of the actual print 
output.
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Margins tab
• Use Margins: Set the margins for the document. By default, 

margins are not enabled. The user can change the margin settings 
by changing the values in the respective fields. Set by default, these 
values depend on the page size selected.

• Unit: Change the units to points, inches, or centimeters.

Printer-Specific Settings tab
Select various options in the JCL and General frames to customize 
various settings. These options are specific to the printer and depend on 
the PPD file.
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9.Using a usb memory device
This chapter explains how to use a USB memory device with your machine.

This chapter includes:

• Understanding the USB screen
• About USB memory device

• Printing from a USB memory device
• Managing USB memory

  

Understanding the USB screen

To use the USB feature, press USB on the display screen.

 

If you want to use this feature, you need to insert a USB memory 
device into the USB memory port on your machine.

• USB Display: Displays information of the folder or file.

• : Moves back to the upper level.

• : Makes a new folder in the USB memory device.

• : Changes the name of the selected folder or file.

• : Deletes the selected folder or file.

• : Formats the USB memory device.

• : You can directly print files stored on a USB memory device. You 
can print TIFF, JPEG, PDF, and PRN files (see "Printing from a USB 
memory device" on page 117).

• : Sends to Scan to USB (see "Scanning to a USB memory device" 
on page 81).

About USB memory device

A B

USB memory devices are available with a variety of memory capacities to 
give you more room for storing documents, presentations, music and 
videos, high resolution photographs, or whatever other files you want to 
store or move.

You can do the following on your machine using a USB memory device:
• Scan documents and save them on a USB memory device.
• Print data stored on a USB memory device.
• Format the USB memory device.

Your machine supports USB memory devices with FAT16/FAT32 and 
sector size of 512 bytes. 

Check your USB memory device’s file system from your dealer.

You must use only an authorized USB memory device with an A plug type 
connector.

Use only a USB memory device with metal-shielded connector.

Only use a USB memory device that has obtained compatibility certification; 
otherwise, the machine might not recognize it.
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Insert a USB memory device into the USB memory port on your machine.

 

Do not insert the USB memory device into other ports except the ports 
shown in the image below. If you insert the USB memory into other 
ports, the machine shows a warning message on the display screen.

 

• Do not remove the USB memory device while it is in use. The 
machine warranty does not cover damage caused by a user’s 
misuse. 

• If your USB memory device has certain features, such as security 
settings and password settings, your machine may not 
automatically detect it. For details about these features, see the 
USB memory device’s User’s Guide.

Printing from a USB memory device

You can directly print files stored on a USB memory device. You can print 
TIFF, JPEG, and PRN files. You can select 50 files and print selected the 
files at once.

USB print option supported file types: 
• PRN: Only files created by provided driver with your machine are 

compatible. PRN files can be created by selecting the Print to file check 
box when you print a document. The document will be saved as a PRN 
file, rather than printed on paper. Only PRN files created in this fashion 
can be printed directly from USB memory device (see "Printing to a file 
(PRN)" on page 110).

• TIFF: TIFF 6.0 Baseline
• JPEG: JPEG Baseline
• PDF: PDF 1.7 and below
• XPS: .

 

 In case of 8-bit CMYK JPEG files, the job could be cancelled.

To print a document from a USB memory device:

1. Insert a USB memory device into the USB memory port on your 
machine. 
Your machine automatically detects the device and reads data stored on 
it (see "About USB memory device" on page 116).

 

• The machine cannot detect an unformatted USB memory 
device. Format, and then reinsert the USB memory device into 
the USB memory port on your machine.

• The machine can not detect the USB memory device when the 
machine is in power save mode. Wait until the machine returns 
to ready mode, and then reinsert the USB memory device into 
the USB memory port on your machine.

• The machine has two USB memory ports. When a USB 
memory device is already inserted in one of the port, if you try 
to insert a USB memory device in another ports, the machine 
cannot detect second one. Remove the USB memory device 
that was inserted first and then reinsert the USB memory 
device you want to insert into the USB memory port on your 
machine.

2. Press USB from the display screen.

3. The machine shows all the files in the USB memory device.

Select the file you want to print. You can also select multiple files if you 
want to print multiple files.

 

• If the file is in a folder, press the folder name. Then press 
Select.
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• If the PDF file you selected is secured with a password, you 
have to know the password for printing. Enter the password 
when the machine requires the secure password. If you do not 
know the password, the print job will be cancelled.

4. Press Print.
5. Press the appropriate option.

• Copies: Selects the number of copies.
• Color Mode: Selects the color mode of copies.
• Duplex: Selects the machine to print copies on both sides of the 

paper.
• Auto fit: Allows you to scale your print job to the selected paper size 

in the tray regardless of the document size. Select a tray, and press 
On. 

• Paper Source: Selects a tray that contains the paper to be printed.
• Output: Sets the machine’s various output options such as copy 

output option (see "Deciding the form of copy output" on page 53).
6. Press Start button to print the file.

7. Press  to go back to the previous screen.

8. After printing is completed, you can remove the USB memory device 
from the machine. Press USB.

Managing USB memory

You can delete image files stored on a USB memory device one-by-one or 
all at once by reformatting the device.

 

After deleting files or reformatting a USB memory device, files cannot 
be restored. Confirm that you no longer need the data before deleting 
it.

Formatting a USB memory device
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press USB from the display screen.
3. Press Format.
4. Press OK when the confirmation window appears.

Deleting an image file
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press USB from the display screen.
3. The machine shows all files in the USB memory device.

Press the file you want to delete.

 

If the file is in a folder, press the folder name. Then press Select.

4. Press Delete.
5. Press OK when the confirmation window appears.
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10.management tools
This chapter introduces management tools provided to help you make full use of your machine. 

This chapter includes:

• Easy Capture Manager
• Samsung AnyWeb Print
• Easy Eco Driver
• Using Samsung Easy Printer Manager

• Using Samsung Printer Status
• Using Samsung Easy Document Creator
• Using the Linux Unified Driver Configurator

  

Easy Capture Manager

 

Available for Windows OS users only.

Capture your screen and launch Easy Capture Manager by simply pressing 
the Print Screen key. Now you can easily print your captured screen as 
captured or edited.

Samsung AnyWeb Print

 

Available for Windows and Mac OS X users only.

This tool helps you screen-capture, preview, scrap, and print Windows 
Internet Explorer pages more easily, than when you use an ordinary 
program. Click Start > All programs > Samsung Printers > Samsung 
AnyWeb Print > Download the latest version to link to the website where 
the tool is available for download.

Easy Eco Driver

 

Available for Windows OS users only.

With the Easy Eco Driver, you can apply Eco features to save paper and 
toner before printing. To use this application, Start Easy Eco Driver before 
printing job checkbox in the printer properties should be checked. 

Easy Eco Driver also allows you simple editing such as removing images 
and texts, changing fonts, and more. You can save frequently used settings 
as a preset.

How to use: 

1. Open a document to print.
2. Print the document.
3. Select the options you want to apply to the document.

You can see the preview of the applied features.
4. Click Print.

Using Samsung Easy Printer Manager 

 

• This feature may not be available depending on model or optional 
goods.

• Available for Windows and Mac OS X users only.
• Microsoft Internet Explorer 6.0 or higher is the minimum 

requirement for Samsung Easy Printer Manager.

Samsung Easy Printer Manager is an application that combines Samsung 
machine settings into one location. Samsung Easy Printer Manager 
combines device settings as well as printing environments, settings/actions, 

and launching. All of these features provide a gateway to conveniently use 
your Samsung machine. Samsung Easy Printer Manager provides two 
different user interfaces for the user to choose from: the basic user interface 
and the advanced user interface. Switching between the two interfaces is 
easy: just click a button.

Understanding Samsung Easy Printer Manager
To open the program: 
For Windows,
Select Start > Programs or All Programs > Samsung Printers > 
Samsung Easy Printer Manager > Samsung Easy Printer Manager.
For MAC,
Open the Applications folder > Samsung folder > Samsung Easy Printer 
Manager.
The Samsung Easy Printer Manager interface is comprised of various basic 
sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are 
using.

 

1
Printer list The Printer List displays printers installed on your 

computer and network printers added by network 
discovery (Windows only).
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Select the Help menu or click the  button from the window and click 
on any option for more information.

Advanced settings user interface overview
The advanced user interface is intended to be used by the person 
responsible for managing the network and machines.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

Device Settings
You can configure various machine settings such as machine setup, 
paper, layout, emulation, network, and print information.

Scan to PC Settings
This menu includes settings to create or delete scan to PC profiles. 
• Scan Activation: Determines whether or not scanning is enabled 

on the device.
• Basic tab:  Contains settings related general scan and device 

settings.
• Image tab:  Contains settings related to image altering.

Fax to PC Settings
This menu includes settings related to the basic fax functionality of the 
selected device. 
• Disable: If Disable is On, incoming faxes will not be received on 

this device.
• Enable Fax Receiving from Device: Enables faxing on the device 

and allows more options to be set.

Alert Settings (Windows only)
This menu includes settings related to error alerting. 
• Printer Alert: Provides settings related to when alerts will be 

received.
• Email Alert: Provides options relating to receiving alerts via email.
• Alert History:  Provides a history of device and toner related alerts.

Job Accounting
Provides querying of quota information of the specified job accounting 
user. This quota information can be created and applied to devices by 
job accounting software such as SyncThru™ or CounThru™ admin 
software.

Using Samsung Printer Status 

The Samsung Printer Status is a program that monitors and informs you of 
the machine status. 

 

• The Samsung Printer Status window and its contents shown in this 
user’s guide may differ depending on the machine or operating 
system in use.

• Check the operating system(s) that are compatible with your 
machine (see "System requirements" on page 167).

• Available for Windows OS users only.

Samsung Printer Status overview
If an error occurs while operating, you can check the error from Samsung 
Printer Status. Samsung Printer Status is installed automatically when you 
install the machine software. 
You can also launch Samsung Printer Status manually. Go to the Printing 
Preferences, click the Basic tab > Printer Status button.
These icons appear on the Windows task bar:

 

2

Printer 
information

This area gives you general information about your 
machine. You can check information, such as the 
machine’s model name, IP address (or Port name), 
and machine status.

 

You can view the online User’s Guide.
 Troubleshooting button: This button 
opens the Troubleshooting Guide when an 
error occurs. You can directly open the 
necessary section in the user’s guide. 

 

3

Application 
information

Includes links for changing to the advanced 
settings, preference, help, and about.

 The  button is used to change the user 
interface to the advanced settings user 
interface (see "Advanced settings user 
interface overview" on page 120).

 

4

Quick links Displays Quick links to machine specific functions. 
This section also includes links to applications in 
the advanced settings.

 

If you connect your machine to a network, the 
SyncThru™ Web Service icon is enabled.

 

5

Contents area Displays information about the selected machine, 
remaining toner level, and paper. The information 
will vary based on the machine selected. Some 
machines do not have this feature.

 

6
Order supplies Click on the Order button from the supply ordering 

window. You can order replacement toner 
cartridge(s) from online.

Icon Mean Description

Normal The machine is in ready mode and 
experiencing no errors or warnings.

Warning The machine is in a state where an error 
might occur in the future. For example, it 
might be in toner low status, which may 
lead to toner empty status. 

Error The machine has at least one error.
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1

 

2

 

3

 

4  

This button opens the Troubleshooting 
Guide when an error occurs. You can 
directly open the troubleshooting section in 
the user’s guide. 

 

5

Using Samsung Easy Document Creator

Samsung Easy Document Creator is an application to help users scan, 
compile, and save documents in multiple formats, including .epub format. 
These documents can be shared via social networking sites or fax. Whether 
you’re a student needing to organize research from the library or a 
stay-at-home mom sharing scanned pictures from last year’s birthday party, 
Easy Document Creator will provide you with the necessary tools.

 

• Availabe for Windows OS users only.
• Windows XP or higher and Internet Explorer 6.0 or higher is the 

minimum requirement for Samsung Easy Document Creator.
• Samsung Easy Document Creator is installed automatically when 

you install the machine software. 

 

Click the Help ( ) button from the upper-right corner of the window 
and click on any option you want to know about. 

Understanding Samsung Easy Document Creator
To open the program: 
Select Start > Programs or All Programs > Samsung Printers > 
Samsung Easy Document Creator > Samsung Easy Document Creator.
The Samsung Easy Document Creator interface is comprised of various 
basic sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are 

using.
Toner Level You can view the level of toner remaining in each 

toner cartridge. The machine and the number of 
toner cartridge(s) shown in the above window 
may differ depending on the machine in use. 
Some machines do not have this feature.

Option You can set printing job alert related settings. 

Order Supplies You can order replacement toner cartridge(s) 
from online.

User’s Guide You can view the online User’s Guide.

Close Close the window.

 

1

 

(Information)

Click the information button to see the 
program’s version information. 

 (Help)

Click the help button to get the information of 
any option you want to use.

 

2

Quick Scan Automatically scans with the settings 
provided in Configuration. You can pre-set 
the options such as image type, document 
size, resolution, or file type (see "Quick 
Scanning" on page 122).

 

3

Scan Provides more in-depth options for scanning 
documents on a one-by-one basis (see 
"Scanning" on page 122).

 

Text Converting will only be available 
after installing the optical character 
recognition (OCR) software proivided in 
a separate installation file.

• Image Scanning: Use for scanning 
single or mulitple pictures.

• Document Scanning: Use for scanning 
documents with text or text and images.

• Text Converting:  Use for scanning 
documents that need to be saved in an 
editable text format.

• Book Scanning:  Use for scanning 
books with the flatbed scanner.

• Favorites:  User-created favorites for 
frequently-used scan settings.
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Click the Help ( ) button from the upper-right corner of the window 
and click on any option you want to know about. 

Using features

Scanning
1. Place a single document face down on the document glass, or load 

the documents face up into the document feeder.
2. Click Scan from the home screen.
3. Select the type of scanning or a favorites then click Start.
4. Make adjustments to the image (Scan Settings and More Options).
5. Click Scan to scan a final image or Prescan to get another preview 

image.
6. Select to Save to Location, Send to E-mail, or Send to SNS.
7. Click on Save (Saving a Scan), Send ( E-mailing a Scan), or Share ( 

Uploading).

 

If there is room on the document glass, more than one item can be 

scanned at the same time. Use the   tool to make multiple 

selection areas.

Quick Scanning

Configuring Quick Scan
To set up the Quick Scan options:

1. Click Configuration from the home screen.
2. Click on Default to use the default settings, or select your own 

options.
3. Click Apply to save changes.

Using Quick Scan
1. Place a single document face down on the document glass, or load 

the documents face up into the document feeder.
2. Click Quick Scan from the home screen.
3. Select a save location for the scanned images.
4. Click Save to save the image.

 

Click Scan More to scan another image with the same settings.

Scanning to a Social Networking Site

Scan Directly
1. Place a single document face down on the document glass, or load 

the documents face up into the document feeder. 
2. Click SNS Upload from the home screen.
3. Click Scan to SNS > Start.
4. Click Scan.

Upload Existing File
1. Click SNS Upload from the home screen.
2. Click Existing File to SNS > Start.
3. Select the site and click Add Image to find the file to upload.
4. Select a social networking site to send the image and click Next. 
5. Follow the instructions in each social networking site.

 

 If there are some problems on accessing or uploading to each 
SNS site due to a network environment issue, it's needed to check 
security limitations established in your network with network 
administrator. To guarantee correct functioning of SNS upload in 
Samsung Easy Document Creator, unrestricted network 
environment is needed for HTTPS communication.

Converting to an E-Book

Scan Directly
1. Place a single document face down on the document glass, or load 

the documents face up into the document feeder.
2. Click E-Book Conversion from the home screen.
3. Click Scan to E-Book > Start.
4. Enter a name and author to be used as metatag information for the 

.epub file, a file name, and select a save location.
5. Click Save.

Convert Existing Files
1. Click E-Book Conversion from the home screen.
2. Click Existing File to E-Book > Start.
3. Click Add Image to find the file to convert.
4. Enter a name and author to be used as metatag information for the 

.epub file, a file name, and select a save location.
5. Click Save.

 

4

SNS Upload Provides an easy and quick way to upload 
files to a variety of social networking sites 
(SNS). Scan an image directly or select an 
existing image to upload to Facebook, Flickr, 
Picasa, Google, or Twitter (see "Scanning to 
a Social Networking Site" on page 122).

 

SNS Upload will only be available after 
Microsoft™.NET Framework 3.5 
Service Pack 1 has been installed 
(http://www.microsoft.com/download/en
/details.aspx?id=22) and Windows XP 
or higher and Internet Explorer 7.0 or 
higher are required

 

5

E-Book 
Conversion

Provides the ability to scan multiple 
documents in as one e-book or convert 
existing files into an e-book format (.epub 
file) (see "Converting to an E-Book" on 
page 122).

 

6

Send Fax Provides the ability to directly fax a document 
from Easy Document Creator if the Samsung 
Network PC Fax driver is installed (see 
"Sending a fax from your computer" on 
page 65).

 

If the Samsung Network PC Fax driver 
is not installed, this will be grayed out.

 

7
Configuration Provides the options for a Common and 

Quick Scan.
 

8
Device Name Shows the scanning/faxing device ready to 

use.

 

9

Search If you cannot see any device ready to use, 
click this button to find a device.

 

Click Search Now to automatically 
search for all devices to which you 
have access.
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Sending a Fax
1. Place a single document face down on the document glass, or load 

the documents face up into the document feeder.
2. Click Send Fax from the home screen.
3. Click add file and locate the file to fax.
4. Click Send Fax.
5. Enter the fax information (recipient’s number, cover page 

information, etc).
6. Click Send.

Plug-ins
Easy Document Creator will also create new plug-ins for Microsoft 
PowerPoint, Word, and Excel. These new plug-ins will be in a new Easy 
Document Creator menu on the applications’ menu bars: Scan to Office, 
Send Fax, and E-Book.

Using the Linux Unified Driver Configurator

Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified 
Driver Configurator. Refer to the Administrator’s Guide.

After the driver is installed on your Linux system, the Unified Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2. Click each button on the left to switch to the corresponding configuration 
window.  

1 Printers 
Configuration 

2 Scanners 
Configuration 

 

 To use the on screen help, click Help.

3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.

Printers configuration
Printers configuration has the two tabs: Printers and Classes.

Printers tab

 

1
 

2
 

3

View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

The printer control buttons are, as follows:
• Refresh: Renews the available machines list.
• Add Printer: Allows you to add a new machine.
• Remove Printer: Removes the selected machine.
• Set as Default: Sets the current selected machine as a default 

machine.
• Stop/Start: Stops/starts the machine.
• Test: Allows you to print a test page to ensure the machine is 

working properly.
• Properties: Allows you to view and change the printer properties. 

Switches to Printers configuration.

Shows all of the installed machine.

Shows the status, model name and URI of your machine.
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Classes tab

 

1

 

2

The Classes tab shows a list of available machine classes.

• Refresh: Renews the classes list.
• Add Class: Allows you to add a new machine class.
• Remove Class: Removes the selected machine class.

Scanners configuration

 

1
 

2
 

3

In this window, you can monitor the activity of scanner devices, view a list of 
installed Samsung machine devices, change device properties, and scan 
images.

• Properties: Allows you to change the scan properties and scan a 
document. 

Ports configuration

 

1
 

2
 

3

In this window, you can view the list of available ports, check the status of 
each port, and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

• Refresh: Renews the available ports list.
• Release port: Releases the selected port.

Sharing Ports Between Printers and Scanners
Your machine may be connected to a host computer via a parallel port 
or USB port. Since the machine contains more than one device (printer 
and scanner), it is necessary to organize proper access of “consumer” 
applications to these devices via the single I/O port.
The Unified Linux Driver package provides an appropriate port sharing 
mechanism that is used by Samsung printer and scanner drivers. The 
drivers talk to their devices via so-called machine ports. The current 
status of any machine port can be viewed via the Ports configuration. 
The port sharing prevents you from accessing one functional block of 
the machine device, while another block is in use.
When you install a new machine onto your system, it is strongly 
recommended you do this with the assistance of an Unified Driver 
Configurator. In this case you will be asked to choose I/O port for the 
new device. This choice will provide the most suitable configuration for 
machine’s functionality. For machine scanners, I/O ports are being 
chosen by scanner drivers automatically, so proper settings are applied 
by default.

Shows all of the machine classes.

Shows the status of the class and the number of machines in the 
class.

Switches to Scanners configuration.

Shows all of the installed scanners.

Shows the vendor, model name, and type of your scanner. 

Switches to Ports configuration.

Shows all of the available ports.

Shows the port type, device connected to the port, and status
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11.Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.

This chapter includes:

• Redistributing toner
• Replacing the toner cartridge
• Cleaning paper dust stick and chargers of imaging units
• Replacing the imaging unit
• Replacing the waste toner container

• Clearing original document jams
• Tips for avoiding paper jams
• Clearing paper jams
• Understanding display messages
• Solving other problems

  

 

If you cannot solve problems using this chapter, contact your 
administrator or service center. You can see the contact information 
from Machine Setup > Others > Contact Information. This 
information is configured by the machine’s administrator.

Redistributing toner

When the toner cartridge is near the end of its life:
• White streaks or light printing occurs. 
• Toner low related message appears on the display.
• The status LED blinks red. 

If this happens, you can temporarily improve print quality by redistributing 
the remaining toner in the cartridge. In some cases, white streaks or light 
printing will still occur even after you have redistributed the toner.

 

Click this link to open an animation about redistributing toner.

1. Open the front door.

CLX-92x1 / 93x1 Series SCX-812x Series

 

Toner particles can be released inside the machine but it does not 
mean the machine is damaged. Contact a service representative 
when print quality problems occur.

2. Pull the corresponding toner cartridge out from the machine.

 1

 2

 1

 2

CLX-92x1 / 93x1 Series SCX-812x Series

3. Thoroughly shake the cartridge five or six times to distribute the toner 
evenly inside the cartridge.

CLX-92x1 / 93x1 Series SCX-812x Series

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.
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4. Hold the toner cartridge and align it with the corresponding slot inside 
the machine. Insert it back into its slot until it locks in place.

CLX-92x1 / 93x1 Series SCX-812x Series

5. Close the front door. Ensure that the door is securely closed. 

CLX-92x1 / 93x1 Series SCX-812x Series

 

If the front door is not completely closed, the machine will not 
operate.

Replacing the toner cartridge

The machine uses four colors and has a different toner cartridge for each 
one: yellow(Y), magenta(M), cyan(C), and black(K).

When the toner cartridge is totally empty
• The status LED turns red on and the display screen shows the error 

message of replacing toner. 
• The machine stops printing and incoming faxes are saved in memory. 

However, when the color toner cartridges are empty, but there is toner 
left in the black toner cartridge, you can still print black-and-white print 
jobs (the submitted job must be in black and white).

• Check the type of the toner cartridge for your machine (see "Supplies 
and accessories" on page 160).

At this stage, the toner cartridge needs to be replaced.

 

Click this link to open an animation about replacing the toner cartridge.

1. Open the front door.

CLX-92x1 / 93x1 Series SCX-812x Series

2. Pull the corresponding toner cartridge out from the machine.

 1

 2

 1

 2

CLX-92x1 / 93x1 Series SCX-812x Series
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3. Remove the new toner cartridges from its bag.

CLX-92x1 / 93x1 Series

SCX-812x Series

4. Thoroughly roll the cartridge five or six times to distribute the toner 
evenly inside the cartridge.

CLX-92x1 / 93x1 Series SCX-812x Series

5. Carefully pull the sealing tape out of the toner cartridge..

CLX-92x1 / 93x1 Series

SCX-812x Series

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

6. Hold the toner cartridge and align it with the corresponding slot inside 
the machine. Insert it back into its slot until locks in place.

CLX-92x1 / 93x1 Series SCX-812x Series

7. Close the front door. Ensure that the door is securely closed. 

CLX-92x1 / 93x1 Series SCX-812x Series

 

If the front door is not completely closed, the machine will not 
operate.
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Cleaning paper dust stick and chargers of 
imaging units

The paper dust stick and the charger of imaging unit will need to be cleaned 
after the specified number of pages is printed out. When the message that 
tells you to clean the charger appears, you have to clean the paper dust 
stick first, then clean the charger. The time when the message appears 
depends on environmental factors like altitude, temperature, humidity, and 
so on. You need to clean the paper dust stick and the charger to maintain 
printing quality. If cleaning is done, the message will disappear 
automatically.

Follow the cleaning procedure below.

1. Open the front door.

CLX-92x1 / 93x1 Series SCX-812x Series

2. Hold the left/right locking levers and push inward at the same time. Then 
remove the waste toner container.

 1

 2

 1

CLX-92x1 / 93x1 Series SCX-812x Series

3. Pull the paper dust stick out.

SCX-812x SeriesCLX-92x1 / 93x1 Series

4. Remove the paper dust. 

5. Insert the paper dust stick back.

SCX-812x SeriesCLX-92x1 / 93x1 Series

6. Pull and push the corresponding charger cleaner completely as shown 
below (SCX-812x Series only).

 

Do not pull the charger cleaner too hard to prevent it from 
separating from the machine. It can cause damage to the 
machine.

SCX-812x Series

Repeat step.6 five times.
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7. Insert the waste toner container until it locks in place.

SCX-812x SeriesCLX-92x1 / 93x1 Series

8. Close the front door. Ensure that the door is securely closed. 

CLX-92x1 / 93x1 Series SCX-812x Series

If the message still appears, do the step.7 and step.8 again.

Replacing the imaging unit

The machine uses four colors and has a different imaging unit for each one: 
yellow(Y), magenta(M), cyan(C), and black(K).

When the life of the imaging unit expires totally
• The status LED turns red on and the display screen shows the error 

message for replacing imaging unit. 

• Check the type of the imaging unit for your machine.(see "Supplies and 
accessories" on page 160)

At this stage, the imaging unit needs to be replaced.

1. Open the front door.

CLX-92x1 / 93x1 Series SCX-812x Series

2. Push the left/right locking levers and push inward at the same time as 
shown below. Then remove the waste toner container.

 1

 2

 1

CLX-92x1 / 93x1 Series SCX-812x Series

3. Pull the corresponding imaging unit out from the machine.

CLX-92x1 / 93x1 Series
SCX-812x Series

1

2

3
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4. Remove the new imaging unit from its package.

SCX-812x Series

CLX-92x1 / 93x1 Series

 

Do not use sharp objects, such as a knife or scissors, to open the 
imaging unit package. You could damage the surface of the 
imaging unit.

5. Go to step.9 (CLX-92x1 Series only).
6. Pull out the protecting pad (SCX-812x Series only).

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

 

• Be careful not to scratch the surface of the imaging unit.
• To prevent damage, do not expose the imaging unit to light for 

more than a few minutes. Cover it with a piece of paper to 
protect it if necessary.

7. Pull the rubber stopper out of the developer (SCX-812x Series only).

8. Remove the tape on the imaging unit (SCX-812x Series only).

9. Remove the paper protecting the imaging unit.

SCX-812x SeriesCLX-92x1 / 93x1 Series

10. Hold the handles on the new imaging unit, and push the imaging unit 
until it locks into place.

CLX-92x1 / 93x1 Series
SCX-812x Series

2

1
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11. Take out the LSU window cleaning stick (CLX-92x1 Series only).

12. Locate the LSU window cleaning hole and insert the LSU window 
cleaning stick. Slowly push and pull the LSU window cleaning stick 4 or 
5 times to clean the LSU window (CLX-92x1 Series only).

13. Insert the LSU window cleaning stick back into its place (CLX-92x1 
Series only).

14. Insert the waste toner container until it locks in place.

SCX-812x SeriesCLX-92x1 / 93x1 Series

15. Close the front door. Ensure that the door is securely closed. 

CLX-92x1 / 93x1 Series SCX-812x Series

 

If the front door is not completely closed, the machine will not 
operate.
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Replacing the waste toner container

When the life of the waste toner container expires totally, the display screen 
shows the error message of replacing waste toner container.

At this stage, the waste toner container needs to be replaced.
• Check the type of the waste toner container for your machine (see 

"Supplies and accessories" on page 160).

1. Open the front door.

CLX-92x1 / 93x1 Series SCX-812x Series

2. Push the left/right locking levers and push outward as shown below. 
Then remove the waste toner container.

 1

 2

 1

CLX-92x1 / 93x1 Series SCX-812x Series

3. Remove the new waste toner container from its package.
4. Insert the new waste toner container until it locks in place.

SCX-812x SeriesCLX-92x1 / 93x1 Series

5. Close the front door. Ensure that the door is securely closed. 

CLX-92x1 / 93x1 Series SCX-812x Series

 

If the front door is not completely closed, the machine will not 
operate.
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Clearing original document jams

When an original jams while passing through the duplex automatic 
document feeder (DADF), a warning message appears on the display 
screen.

 

To avoid tearing the document, remove the jammed document slowly 
and gently.

 

To prevent document jams, use the scanner glass for thick, thin, or 
mixed paper-type originals.

Original paper jam in front of scanner
1. Remove any remaining pages from the DADF.
2. Open the DADF cover.

3. Gently remove the jammed paper from the DADF.

4. Close the DADF cover.
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Original paper jam inside of scanner
1. Remove any remaining pages from the DADF.
2. Open the DADF cover.

3. Gently remove the jammed paper from the DADF. If you can not grasp 
the jammed paper, use lever as shown in the picture below. 

If you do not see paper in this area, go to the next step.
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4. Open the DADF input tray.

5. Pull the jammed paper gently out of the DADF.

If you do not see paper in this area, go to the next step.
6. Close DADF cover and DADF input tray.

7. Open the DADF.
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8. Grasp the misfed paper, and remove the paper from the feed area by 
carefully pulling it using both hands.

If you do not see paper in this area, go to the next step.
9. Close the DADF.

Tips for avoiding paper jams

By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the next guidelines. 
• Ensure that the adjustable guides are positioned correctly (see "Loading 

paper in the tray" on page 39).
Do not overload the tray. Ensure that the paper level is below the paper 
capacity mark on the inside of the tray.

• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media (see "Tray setting" on page 47).
• Ensure that the recommended side of the print media is facing up in the 

tray, or facing down in the multi-purpose tray.
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Clearing paper jams

When a paper jam occurs, a warning message appears on the display 
screen. 

 

To avoid tearing the paper, pull the jammed paper out slowly and 
gently. Follow the instructions in the following sections to clear the 
jam. 

Paper jam in tray 1, 2

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the right door.

 1

 2

2. Remove the jammed paper by gently pulling it straight out.

Close the right door.
If you do not see paper in this area, go to the next step.

3. Pull out tray 1 or 2.

4. Remove the jammed paper from the machine.

5. Insert tray 1 or 2 back into the machine until it locks into place. Printing 
automatically resumes.
Troubleshooting_ 137

../common/swf/jam_tray2.htm


Paper jam in tray 3, 4

 

Click this link to open an animation about clearing a jam.

1. Open the right bottom door of the dual cassette feeder.

2. Remove the jammed paper by gently pulling it straight out.

Close the dual cassette feeder right bottom door.
If you do not see paper in this area, go to the next step.

3. Pull out tray 3 or 4.

4. Remove the jammed paper from the machine.

5. Insert tray 3 or 4 back into the machine until it locks into place. Printing 
automatically resumes.
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Paper jam in the multi-purpose tray

 

Click this link to open an animation about clearing a jam.

1. If the paper is not feeding properly, pull the paper out of the machine.

2. Open and close the front door to resume printing.

Paper jam inside the machine (Jam feed 1, Jam feed 
2)

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the right door.

 1

 2

2. Remove the jammed paper by gently pulling it straight out.

3. Close the right door.
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Paper jam inside the machine (Jam feed 3, Jam feed 
4)

 

Click this link to open an animation about clearing a jam.

1. Open the right bottom door of the dual cassette feeder.

2. Remove the jammed paper by gently pulling it straight out.

3. Close the dual cassette feeder right bottom door.

Paper jam inside the machine (Jam Registration)

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the right door.

 1

 2

2. Remove the jammed paper by gently pulling it straight out.

3. Close the right door.
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Paper jam inside of the machine (Jam at Fuser out)

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the right door.

 1

 2

2. Open the fuser cover. Then remove the jammed paper by gently pulling 
it straight out.

1

2

3. Close the fuser cover and the right door.

Paper jam at the top of duplex path (Jam Duplex 
Return, Jam Duplex 1)

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the right door.

 1

 2

2. Remove the jammed paper by gently pulling it straight out.

1

2

3. Close the right door.
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Paper jam at the inside of duplex path (Jam Duplex 
2)

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the right door.

 1

 2

2. Remove the jammed paper by gently pulling it straight out.

3. Close the right door.

Paper jam bottom of duplex path (Jam Duplex Regi.)

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Open the right door.

 1

 2

2. Remove the jammed paper by gently pulling it straight out.

1

2

3. Close the right door.
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Paper jam in exit area (Jam Exit Face down)

 

Click this link to open an animation about clearing a jam.

1. Gently pull the paper out of the output tray.

2. Open and close the front door. Printing automatically resumes.

 

If the optional Inner Finisher or booklet finisher is installed, remove the 
jammed paper as shown below.

If this paper jam persists, make sure the bin full sensor is unfolded. 

The bin full sensor is located in front of the output tray.

Paper jam at finisher’s exit

 

Click this link to open an animation about clearing a jam.

1. Gently pull the paper out of the finisher’s exit.

2. Open and close the finisher front door. Printing automatically resumes.
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Paper jam inside of finisher

 

Click this link to open an animation about clearing a jam.

1. Lift up the finisher top cover.

2. Let the jammed paper move out by rotating the paper roller gear.

3. Gently pull the jammed paper out. Close the top cover

4. Open and close the finisher front door. Printing automatically resumes.
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Understanding display messages

Messages appear on the display screen to indicate the machine’s status or 
errors. Some error messages are shown with graphics to help you 
troubleshoot problem. Refer to the tables below to understand the 
messages and their meaning, and correct the problem, if necessary. 
Messages and their explanations are listed in alphabetical order.

 

• If a message is not in the table, reboot the power and try the 
printing job again. If the problem persists, call for service.

• When you call for service, provide the service representative with 
the contents of display message.

• Some messages may not appear in the display depending on 
options or models.

• [color] indicates the color of toner or imaging unit.
• [tray number] indicates the tray number.
• [media type] indicates the media type.
• [media size] indicates the paper size.
• [error number] indicates the error number.

Message Meaning Suggested solutions

Actuator Fan 
Failure [error 
number]:Please 
open/close door.

There is a problem in 
the actuator fan. 

Open and close the front 
door. If the problem 
persists, call for service.

Actuator Fan 
Signal Failure 
[error 
number]:Please 
open/close door.

There is a problem in 
the actuator fan. 

Open and close the front 
door. If the problem 
persists, call for service.

Actuator Motor 
Failure [error 
number]:Please 
open/close door.

There is a problem in 
the actuator motor. 

Open and close the front 
door. If the problem 
persists, call for service.

Actuator Sensor 
Failure [error 
number]:Please 
open/close door.

There is a problem in 
the actuator sensor. 

Open and close the front 
door. If the problem 
persists, call for service.

ADF System 
Failure [error 
number]:Call for 
service if the 
problem persists.

There is a problem in 
the dual automatic 
document feeder.

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Booklet maker 
Error [error 
number]:Please 
open/close door.

There is a problem in 
the booklet maker.

Open and close the 
booklet finisher front 
door. If the problem 
persists, call for service.

[color] Imaging 
Unit Failure [error 
number]:Install 
[color] imaging 
unit again.

There is a problem in 
the imaging unit.

Reinstall the imaging 
unit. If the problem 
persists, call for service.

[color] Imaging 
Unit Failure [error 
number]:Please 
open/close door.

There is a problem in 
the imaging unit. 

Open and close the front 
door. If the problem 
persists, call for service.

[color] Imaging 
Unit Failure [error 
number]:Turn off 
then on.

There is a problem in 
the imaging unit. 

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

[color] imaging 
unit is not 
compatible. Check 
user's guide.

The imaging unit you 
have installed is not 
for your machine.

Install a 
Samsung-genuine 
imaging unit designed for 
your machine (see 
"Available supplies" on 
page 160).

[color] imaging 
unit is not 
installed. Install it.

The imaging unit is 
not installed or the 
imaging unit is not 
properly installed.

Install the imaging unit. If 
it is already installed, try 
to reinstall the imaging 
unit. If the problem 
persists, call for service.

[color] imaging 
unit is not original 
Samsung. Check 
user's guide.

The imaging unit you 
have installed is not 
for your machine.

Install a 
Samsung-genuine 
imaging unit, designed 
for your machine (see 
"Available supplies" on 
page 160).

[color] imaging 
unit requires 
charger's cleaning. 
Clean the unit.

The charger of 
imaging unit need to 
clean after the 
specified number of 
paper is printed out.

Clean the charger of 
imaging unit (see 
"Cleaning paper dust 
stick and chargers of 
imaging units" on 
page 128).

[color] LSU Unit 
Failure [error 
number]:Turn off 
then on.

There is a problem in 
the LSU (Laser 
Scanning Unit).

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

[color] toner 
cartridge Failure 
[error 
number]:Install 
[color] toner 
cartridge again.

There is a problem in 
the toner cartridge.

Reinstall the toner 
cartridge. If the problem 
persists, call for service.

[color] toner 
cartridge Failure 
[error number]: 
Install [color] toner 
cartridge again.

The toner cartridge 
you have installed is 
not for your machine.

Install a 
Samsung-genuine toner 
cartridge designed for 
your machine (see 
"Check the type of the 
toner cartridge for your 
machine (see "Supplies 
and accessories" on 
page 160)." on 
page 126).

Message Meaning Suggested solutions
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[color] toner 
cartridge Failure 
[error number]: 
Please open/close 
door.

The toner cartridge 
does not supply 
enough toner.

• Thoroughly roll the 
cartridge five or six 
times to distribute the 
toner evenly inside the 
cartridge (see 
"Redistributing toner" 
on page 125).

• Open and close the 
front door. Or check 
whether the sealing 
tape of the toner 
cartridge is removed or 
not (see "Replacing 
the toner cartridge" on 
page 126).

• If the problem persists, 
call for service.

[color] toner 
cartridge is not 
compatible. Check 
user's guide.

The toner cartridge 
you have installed is 
not for your machine.

Install a 
Samsung-genuine toner 
cartridge designed for 
your machine (see 
"Check the type of the 
toner cartridge for your 
machine (see "Supplies 
and accessories" on 
page 160)." on 
page 126).

[color] toner 
cartridge is not 
installed. Install it.

The toner cartridge is 
not installed or the 
cartridge is not 
properly installed.

Install the toner cartridge. 
If it is already installed, 
try to reinstall the toner 
cartridge. If the problem 
persists, call for service.

DCF Failure [error 
number]:
Check internal DCF 
connection.

There is a problem in 
the dual capacity 
feeder. 

Open and close the dual 
capacity feeder, or check 
the dual capacity feeder 
connection with the 
machine. If the problem 
persists, call for service.

DCF Failure [error 
number]:
Please open/close 
[tray number].

There is a problem in 
the dual capacity 
feeder. 

Open and close the tray. 
If the problem persists, 
call for service.

End of life, Replace 
with new [color] 
imaging unit.

The life of the imaging 
unit expires totally.

Replace the imaging unit 
with a Samsung-genuine 
imaging unit (see 
"Replacing the imaging 
unit" on page 129).

End of life, Replace 
with new [color] 
toner cartridge.

The toner cartridge 
has run out. The 
machine stops 
printing. Some 
amount of toner may 
remain in the cartridge 
even when the 
machine stops 
printing.
.

This message appears 
when the toner is 
completely empty, and 
your machine stops 
printing. Replace the 
toner cartridge with a 
Samsung-genuine toner 
cartridge (see "Replacing 
the toner cartridge" on 
page 126).

Message Meaning Suggested solutions

End of life, Replace 
with new transfer 
belt unit.

The life of the transfer 
belt unit expires 
totally.

Replace the transfer belt 
unit with a 
Samsung-genuine 
transfer belt unit, call for 
service.

Engine System 
Failure [error 
number]:Please 
open/close door.

There is a problem in 
the engine system. 

Open and close the front 
door. If the problem 
persists, call for service.

Engine System 
Failure [error 
number]:Turn off 
then on.

There is a problem in 
the engine system. 

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Fax modem card is 
not installed. 
Install the card.

The optional fax kit is 
not installed.

Install the optional fax kit. 
If it is already installed, 
try to reinstall the optional 
fax kit. If the problem 
persists, call for service.

Fax System Failure 
[error 
number]:Turn off 
then on.

There is a problem in 
the fax system.

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

FDI device is not 
installed. Install 
the device.

The FDI optional FDI 
kit is not installed.

Install the optional FDI 
kit. If it is already 
installed, try to reinstall 
the optional FDI kit. If the 
problem persists, call for 
service.

Feed door is 
opened. Close it.

The door is not 
securely latched.

Close the door until it 
locks into place.

Finisher door is 
open. Close it.

The finisher door is 
not securely latched.

Close the door until it 
locks into place.

Finisher Error 
[error 
number]:Please 
open/close door.

There is a problem in 
the finisher.

Open and close the 
finisher door. If the 
problem persists, call for 
service.

Finisher Error 
[error 
number]:Turn off 
then on.

There is a problem in 
the finisher.

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Finisher System 
Failure [error 
number]:Please 
open/close door.

There is a problem in 
the finisher.

Open and close the 
finisher door. If the 
problem persists, call for 
service.

Finisher System 
Failure [error 
number]:Turn off 
then on.

There is a problem in 
the finisher.

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Front door is open. 
Close it.

The door is not 
securely latched.

Close the door until it 
locks into place.

Fuser Unit Failure 
[error 
number]:Turn off 
then on.

There is a problem in 
the fuser unit. 

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Message Meaning Suggested solutions
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Fusing unit is not 
compatible. Check 
user's guide.

The fuser unit you 
have installed is not 
for your machine.

Install a 
Samsung-genuine fuser 
unit, designed for your 
machine, call for service.

Fuser unit is not 
installed correctly. 
Install it.

The fuser unit is not 
properly installed.

Reinstall the fuser unit. If 
the problem persists, call 
for service.

HDD is almost 
full-1. Check user’s 
guide.

HDD is almost full in 
the machine.

Check Address Book or 
User Profile. If 
necessary, remove the 
data which is unused in 
Address Book or User 
Profile.

HDD is almost 
full-2. Check user’s 
guide.

HDD is almost full in 
the machine.

Check Stored 
Document, or Secured 
Job in Job Status. If 
necessary, remove the 
data which is unused in 
Stored Document or 
Secured Job.

HDD is almost 
full-3. Check user’s 
guide.

HDD is almost full in 
the machine.

Check System Log at 
Security in SyncThru™ 
Web Service. If 
necessary, remove the 
data in System Log.

HDD is almost 
full-4. Check user’s 
guide.

HDD is almost full in 
the machine.

• Print or remove the 
jobs on the queue 
which are waiting for 
its turn. You can check 
the jobs pressing Job 
Status (see "Job 
Status button" on 
page 36).

• Print or remove the 
received fax jobs in 
Secure Receive (see 
"Receiving in secure 
receiving mode" on 
page 70).

HDD is almost 
full-5. Check user’s 
guide.

HDD is almost full in 
the machine.

There is a problem in the 
machine. Check the error 
message on the display 
screen and resolve the 
problem.

HDD is almost 
full-6. Check user’s 
guide.

HDD is almost full in 
the machine.

There is a problem in the 
machine. Check the error 
message on the display 
screen and resolve the 
problem.

HDD System 
Failure [error 
number]:Turn off 
then on.

There is a problem in 
the hard disk. 

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Message Meaning Suggested solutions

Input System 
Failure [error 
number]:Pull [tray 
number] out and 
insert it.

There is a problem in 
the tray. 

Open and close the tray. 
If the problem persists, 
call for service.

Image transfer belt 
cleaning unit is not 
compatible. Check 
user's guide.

The image transfer 
belt cleaning unit you 
have installed is not 
for your machine.

Install a 
Samsung-genuine image 
transfer belt cleaning 
unit, designed for your 
machine, call for service.

Image transfer belt 
unit is not original 
Samsung. Check 
user's guide.

The image transfer 
belt you have installed 
is not for your 
machine.

Install a 
Samsung-genuine image 
transfer belt, designed for 
your machine, call for 
service.

ITB Unit Failure 
[error 
number]:Turn off 
then on.

There is a problem in 
the image transfer belt 
unit. 

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

MSOK System 
Failure [error 
number]:Turn off 
then on.

There is a problem in 
the engine system.

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Network cable is 
disconnected. 
Check it.

The machine is not 
connected with a 
network cable. 

Connect the machine to 
the network with a 
network cable.

Option Feed door 
is opened. Close it.

The door is not 
securely latched.

Close the door until it 
locks into place.

Original paper jam 
in front of scanner

The originals are 
jammed in duplex 
automatic document 
feeder.

Clear the jam (see 
"Original paper jam in 
front of scanner" on 
page 133).

Original paper jam 
inside of scanner

The originals are 
jammed in duplex 
automatic document 
feeder.

Clear the jam (see 
"Original paper jam inside 
of scanner" on 
page 134).

Output tray(face 
down) is full. 
Remove printed 
media

The output tray (face 
down) is full.

Remove papers from the 
output tray (face down), 
the machine resumes 
printing.

Output tray(face 
up) is full. Remove 
printed media

The output tray (face 
up) is full.

Remove papers from the 
output tray (face up), the 
machine resumes 
printing.

Paper is empty in 
[tray number]. 
Load paper.

There is no paper in 
the tray.

Load paper in the tray.

Paper is empty in 
tray MP. Load 
paper.

There is no paper in 
the multi-purpose tray.

Load paper in the 
multi-purpose tray.

Paper is low in 
[tray number]. 
Load paper.

Running out of paper 
in the tray.

Load paper in the tray.

Message Meaning Suggested solutions
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Paper jam at 
entrance of 
finisher 

Paper has jammed 
during finishing.

Clear the jam (see "Paper 
jam inside of finisher" on 
page 144).

Paper jam at exit of 
finisher 

Paper has jammed 
during finishing.

Clear the jam (see 
"Paper jam at finisher’s 
exit" on page 143).

Paper Jam at the 
bottom of duplex 
path

Paper has jammed 
during duplex printing.

Clear the jam (see "Paper 
jam bottom of duplex 
path (Jam Duplex Regi.)" 
on page 142).

Paper Jam at the 
inside of duplex 
path

Paper has jammed 
during duplex printing.

Clear the jam (see "Paper 
jam at the inside of 
duplex path (Jam Duplex 
2)" on page 142).

Paper Jam at the 
return of duplex 
path

Paper has jammed 
during duplex printing.

Clear the jam (see "Paper 
jam at the top of duplex 
path (Jam Duplex Return, 
Jam Duplex 1)" on 
page 141).

Paper Jam at the 
top of duplex path

Paper has jammed 
during duplex printing.

Clear the jam (see "Paper 
jam at the top of duplex 
path (Jam Duplex Return, 
Jam Duplex 1)" on 
page 141).

Paper jam inside of 
finisher

Paper has jammed 
during finishing.

Clear the jam (see "Paper 
jam inside of finisher" on 
page 144).

Paper Jam inside 
of machine

Paper has jammed 
inside of the machine.

Clear the jam (see "Paper 
jam inside the machine 
(Jam feed 1, Jam feed 2)" 
on page 139 or "Paper 
jam inside the machine 
(Jam feed 3, Jam feed 4)" 
on page 140 or "Paper 
jam inside the machine 
(Jam Registration)" on 
page 140 or "Paper jam 
inside of the machine 
(Jam at Fuser out)" on 
page 141).

Paper jam in tray 1 Paper has jammed in 
the feeding area of the 
tray.

Clear the jam (see "Paper 
jam in tray 1, 2" on 
page 137).

Paper jam in tray 2 Paper has jammed in 
the feeding area of the 
tray.

Clear the jam (see "Paper 
jam in tray 1, 2" on 
page 137).

Paper jam in tray 3 Paper has jammed in 
the feeding area of the 
tray.

Clear the jam (see "Paper 
jam in tray 3, 4" on 
page 138).

Paper jam in tray 4 Paper has jammed in 
the feeding area of the 
tray.

Clear the jam (see "Paper 
jam in tray 3, 4" on 
page 138).

Message Meaning Suggested solutions

Paper jam in MP 
tray

Paper has jammed in 
the feeding area of the 
tray.

Clear the jam (see "Paper 
jam in the multi-purpose 
tray" on page 139).

Prepare new 
[color] imaging 
unit.

The estimated life of 
the imaging unit is 
close.

Prepare a new imaging 
unit for a replacement.

Prepare new 
[color] toner 
cartridge.

Small amount of toner 
is left in the indicated 
cartridge. The 
estimated cartridge 
life of toner is close.

Prepare a new cartridge 
for a replacement. You 
may temporarily increase 
the printing quality by 
redistributing the toner 
(see "Redistributing 
toner" on page 125).

Prepare new fuser 
unit.

The estimated life of 
the fuser unit is close.

Prepare a new fuser unit 
for a replacement, call for 
service.

Prepare new 
transfer belt 
cleaning unit.

The estimated life of 
the transfer belt 
cleaning unit is close.

Prepare a new transfer 
belt cleaning unit for a 
replacement, call for 
service.

Prepare new 
transfer belt unit.

The estimated life of 
the transfer belt is 
close.

Prepare a new transfer 
belt for a replacement, 
call for service.

Prepare new 
Transfer roller.

The estimated life of 
the transfer roller is 
close.

Prepare a new transfer 
roller for a replacement, 
call for service.

Remove sealing 
tape of [color] 
imaging unit and 
reinstall.

The sealing tape of 
the imaging unit is not 
removed.

Remove the sealing tape 
of the imaging unit (see 
"Replacing the imaging 
unit" on page 129).

Replace with new 
[color] imaging 
unit.

The indicated imaging 
unit has almost 
reached its estimated 
imaging unit life. The 
machine will stop 
printing.

Replace the imaging unit 
with a Samsung-genuine 
imaging unit (see 
"Replacing the imaging 
unit" on page 129).

Replace with new 
fuser unit.

The life of the fuser 
unit expires totally.

Replace the fuser unit 
with a Samsung-genuine 
fuser unit, call for service.

Replace with new 
Transfer roller.

The life of the transfer 
roller expires totally.

Replace the transfer 
roller with a 
Samsung-genuine 
transfer roller, call for 
service.

Replace with new 
[tray number] 
pickup roller.

The life of the tray 
pickup roller expires 
totally.

Replace the tray pickup 
roller with a 
Samsung-genuine pickup 
roller, call for service.

Replace with new 
MP pickup roller.

The life of the MP 
pickup roller expires 
totally.

Replace the MP pickup 
roller with a 
Samsung-genuine MP 
pickup roller, call for 
service.

Message Meaning Suggested solutions
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Right door is open. 
Close it.

The door is not 
securely latched.

Close the door until it 
locks into place.

Scanner locked or 
another problem 
occurred.

The CCD (Charged 
Couple Device) lock 
has been locked. 

Unlock the CCD lock . Or 
turn the machine off and 
back on again. If the 
problem persists, call for 
service. Scanner 

Scan System 
Failure [error 
number]:Turn off 
then on.

There is a problem in 
the scan system.

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Second fax modem 
card is not 
installed. Install 
the card.

The second optional 
fax multiline kit is not 
installed.

Install the optional fax 
multiline kit. If it is already 
installed, try to reinstall 
the optional fax multiline 
kit. If the problem 
persists, call for service.

Shake [color] toner 
cartridge.

Small amount of toner 
is left in the indicated 
cartridge.

You may temporarily 
increase the printing 
quality by redistributing 
the toner (see 
"Redistributing toner" on 
page 125).

Side feeder door is 
open. Close it.

The door is not 
securely latched.

Close the door until it 
locks into place.

Staple cartridge is 
empty. Replace it.

The staple cartridge 
has reached the end 
of its lifespan.

This message appears 
when the staple cartridge 
is completely empty. 
Replace the staple 
cartridge.

Staple cartridge is 
low. Replace 
cartridge.

Small amount of 
staple cartridge is left. 
The estimated life of 
staple cartridge is 
close.

Prepare a new staple 
cartridge for a 
replacement.

Staple cartridge is 
not installed. 
Install it in finisher.

The staple cartridge is 
not installed or the 
staple cartridge is not 
properly installed.

Install the staple 
cartridge. If it is already 
installed, try to reinstall 
the staple cartridge. If the 
problem persists, call for 
service.

Staple cartridge of 
booklet I is empty. 
Replace cartridge.

The staple cartridge of 
booklet has reached 
the end of its lifespan.

This message appears 
when the staple cartridge 
is completely empty. 
Replace the staple 
cartridge.

Staple cartridge of 
booklet I is low. 
Replace cartridge.

Small amount of 
staple cartridge of 
booklet is left. The 
estimated life of staple 
cartridge is close.

Prepare a new staple 
cartridge for a 
replacement.

Message Meaning Suggested solutions

Staple cartridge of 
booklet I is not 
installed. Install 
the cartridge.

The staple cartridge of 
booklet is not installed 
or the staple cartridge 
is not properly 
installed.

Install the staple 
cartridge. If it is already 
installed, try to reinstall 
the staple cartridge. If the 
problem persists, call for 
service.

The clock became 
initial time. Set a 
time again.

The time setting of 
machine is initialized.

Set the time setting in 
Machine Setup.

Too much media in 
the center tray. 
Remove printed 
media.

The center tray is full. Remove printouts from 
the center tray, the 
machine resumes 
printing.

Too much media in 
booklet tray. 
Remove printed 
media.

The booklet tray is full. Remove printouts from 
the booklet tray, the 
machine resumes 
printing.

Too much media in 
finisher tray. 
Remove printed 
media.

The finishing tray is 
full.

Remove printouts from 
the finishing tray, the 
machine resumes 
printing.

Top door of 
scanner is open.

The duplex automatic 
document feeder 
cover is not securely 
latched.

Close the cover until it 
locks into place.

Transfer belt 
cleaning unit is not 
installed. Install it.

The transfer belt 
cleaning unit is not 
installed.

Power off/on, if the 
problem persists, call for 
service.

Transfer belt is not 
installed. Install it.

The transfer belt is not 
installed.

Power off/on, if the 
problem persists, call for 
service.

Transfer belt 
cleaning unit is 
worn. Replace with 
new one.

The life of the transfer 
belt cleaning unit 
expires totally.

Replace the transfer belt 
cleaning unit with a 
Samsung-genuine 
transfer belt cleaning 
unit, call for service.

Transfer belt unit 
is worn. Replace it.

The life of the transfer 
belt unit expires 
totally.

Replace the transfer belt 
unit with a 
Samsung-genuine 
transfer belt unit, call for 
service.

[tray number] 
cassette is pulled 
out. Insert it 
properly.

The tray is not 
securely latched.

Close the tray until it 
locks into place.

[tray number] door 
is open. Close it.

The tray is not 
securely latched.

Close the tray until it 
locks into place.

UI System Failure 
[error 
number]:Turn off 
then on.

There is a problem in 
the UI system.

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Message Meaning Suggested solutions
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Solving other problems

The following chart lists some trouble conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, contact a service representative.

Other problems include:
• see "Power and cable connecting problems" on page 150.
• see "Display screen problem" on page 150.
• see "Paper feeding problems" on page 151.
• see "Printing problems" on page 151.
• see "Printing quality problems" on page 153.
• see "Copying problems" on page 155.
• see "Scanning problems" on page 156.
• see "Fax problems (optional)" on page 156.
• see "Common PostScript problems" on page 157.
• see "Common Windows problems" on page 157.
• see "Common Linux problems" on page 158.
• see "Common MAC problems" on page 159.

Power and cable connecting problems

 

Click this link to open an animation about 
solving power problems.

 

Click this link to open an animation about 
solving connection problems.

Display screen problem

Video System 
Failure [error 
number]:Turn off 
then on.

There is a problem in 
the CPU. 

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Waste Motor does 
not operate. Turn 
off then on.

There is a problem in 
the waste motor.

Turn the machine off and 
back on again. If the 
problem persists, call for 
service.

Waste toner 
container is almost 
full. Order new 
one.

The estimated life of 
the waste toner 
container is close.

Prepare a new waste 
toner container for a 
replacement.

Waste toner 
container is full. 
Replace it.

The life of the waste 
toner container 
expires soon.

Replace the waste toner 
container with a 
Samsung-genuine waste 
toner container (see 
"Replacing the waste 
toner container" on 
page 132).

Waste toner 
container is not 
installed. Install it.

The waste toner 
container is not 
installed.

Install the waste toner 
container. If it is already 
installed, try to reinstall 
the waste toner 
container. If the problem 
persists, call for service.

Message Meaning Suggested solutions

Condition Suggested solutions

The machine is 
not receiving 
power, 
or the connection 
cable between the 
computer and the 
machine is not 
connected 
properly.

• Plug in the power cord and turn on the power 
switch (see "Turning the machine on" on 
page 33).

• Disconnect the machine cable and reconnect it 
(see "Connecting a printer cable" on page 34).

Condition Suggested solutions

The display screen 
does not show 
anything.

• Adjusts the brightness of the display screen.
• Turn the machine off and back on again. If the 

problem persists, call for service.
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Paper feeding problems Printing problems

Condition Suggested solutions

Paper jams during 
printing.

Clear the paper jam (see "Clearing paper jams" 
on page 137).

Paper sticks 
together.

• Check the maximum paper capacity of the 
tray (see "Print media specifications" on 
page 165).

• Make sure that you are using the correct type 
of paper (see "Print media specifications" on 
page 165).

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together.

Multiple sheets of 
paper do not feed.

• Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

• If multiple sheets have caused a paper jam, 
clear the paper jam (see "Clearing paper 
jams" on page 137).

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine (see "Print media specifications" on 
page 165).

• If an original does not feed into the machine, 
the DADF rubber pad may require to be 
replaced. Contact a service representative.

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the multi-purpose 
tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine (see "Print media 
specifications" on page 165).

• There may be debris inside the machine. 
Open the front door and remove any debris.

• If an original does not feed into the machine, 
the DADF rubber pad may need to be 
replaced. Contact a service representative.

Transparencies stick 
together in the paper 
exit.

Use only transparencies specifically designed 
for laser printers. Remove each transparency as 
it exits from the machine.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.

Condition Possible cause Suggested solutions

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord 
connections. Check the 
power switch and the power 
source.

The machine is not 
selected as the 
default machine.

Select your machine as your 
default machine in your 
Windows.

Check the machine for the following:
• The front door is not closed. Close the front 

door.
• Paper is jammed. Clear the paper jam (see 

"Clearing paper jams" on page 137).
• No paper is loaded. Load paper (see "Loading 

paper in the tray" on page 39).
• The toner cartridge or the imaging unit is not 

installed. Install the toner cartridge or imaging 
unit.

If a system error occurs, contact your service 
representative.

The connection 
cable between the 
computer and the 
machine is not 
connected properly.

Disconnect the machine 
cable and reconnect it.

The connection 
cable between the 
computer and the 
machine is 
defective.

If possible, attach the cable 
to another computer that is 
working properly and print a 
job. You can also try using a 
different machine cable.

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has 
more than one port, make 
sure that the machine is 
attached to the correct one.

The machine may 
be configured 
incorrectly. 

Check the Printing 
Preferences to ensure that 
all of the print settings are 
correct (see "Opening 
printing preferences" on 
page 101).

The printer driver 
may be incorrectly 
installed.

Repair the machine 
software.

The machine is 
malfunctioning.

Check the display message 
on the control panel to see if 
the machine is indicating a 
system error. Contact a 
service representative.
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(Continued) The 
machine does not 
print. 

The document size 
is so big that the 
hard disk space of 
the computer is 
insufficient to 
access the print job.

Get more hard disk space 
and print the document 
again.

The machine 
selects print 
materials from 
the wrong paper 
source.

The paper option 
that was selected in 
the Printing 
Preferences may 
be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Paper tab within 
the Printing Preferences. 
Select the correct paper 
source. see the printer driver 
help screen (see "Opening 
printing preferences" on 
page 101).

A print job is 
extremely slow.

The job may be 
very complex.

Reduce the complexity of 
the page or try adjusting the 
print quality settings.

Half the page is 
blank.

The page 
orientation setting 
may be incorrect.

Change the page orientation 
in your application. see the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver 
settings matches the paper 
selection in the software 
application settings you use.

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The machine cable 
is loose or 
defective.

Disconnect the machine 
cable and reconnect. Try a 
print job that you have 
already printed successfully. 
If possible, attach the cable 
and the machine to another 
computer that you know 
works and try a print job. 
Finally, try a new machine 
cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and back on again.

If you are in a DOS 
environment, the 
font setting for your 
machine may be 
set incorrectly.

Change the language 
setting.

Condition Possible cause Suggested solutions

Pages print, but 
they are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary. 
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such 
as the controller or 
the board, may be 
defective.

Contact a service 
representative.

The machine 
does not print 
PDF file correctly. 
Some parts of 
graphics, text, or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may enable the file to 
print. Turn on Print As 
Image from the Acrobat 
printing options. 

 

It will take longer to 
print when you print a 
PDF file as an image.

The print quality 
of photos is not 
good. Images are 
not clear.

The resolution of 
the photo is very 
low. 

Reduce the photo size. If 
you increase the photo size 
in the software application, 
the resolution will be 
reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

The machine 
does not print 
special- sized 
paper, such as 
billing paper.

Paper size and 
paper size setting 
do not match.

Set the correct paper size in 
the Custom Paper List in 
the Paper tab in the 
Printing Preferences (see 
"Paper tab" on page 102).

Your machine 
has an odd smell 
during initial use.

The oil used to 
protect the fuser is 
evaporating.

After printing about 100 
color pages, there will be no 
more smell. It is a temporary 
issue.

Condition Possible cause Suggested solutions
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
there might be a reduction in print quality. see the table below to clear the 
problem. 

Condition Suggested Solutions

Light or faded print • If a vertical white streak or faded area 
appears on the page, the toner supply is low. 
You may be able to temporarily extend the 
toner cartridge life. If this does not improve 
the print quality, install a new toner cartridge.

• The color tone might not be adjusted. Adjust 
the color tone.

• The paper may not meet paper specifications; 
for example, the paper may be too moist or 
rough (see "Print media specifications" on 
page 165).

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. see the help screen of 
the printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning. Contact a service representative.

• The surface of the LSU part inside the 
machine may be dirty. Clean the LSU, contact 
a service representative.

Toner specks • The paper may not meet specifications; for 
example, the paper may be too moist or rough 
(see "Print media specifications" on 
page 165).

• The transfer roller may be dirty. Clean the 
inside of your machine. Contact a service 
representative.

• The paper path may need cleaning. Contact a 
service representative.

• Check the location of the machine. If the area 
is not well-ventilated, this problem may occur.

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper (see "Print 
media specifications" on page 165).

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go 
to Printing Preferences, click Paper tab, 
and set type to thick paper (see "Opening 
printing preferences" on page 101).

• If these steps do not correct the problem, 
contact a service representative.

White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, so the transfer roller may be dirty. 
Clean the inside of your machine. Cleaning 
the inside or contact a service 
representative.

• The paper path may need cleaning. Cleaning 
the inside or contact a service 
representative.

Vertical lines If black vertical streaks appear on the page:
• The drum inside the printer has probably 

been scratched. Remove the imaging unit 
and install a new one. Contact a service 
representative.

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty. Cleaning the inside or 
contact a service representative.

If vertical streaks appear on the page:
• The surface of the scanner glass and its 

white sheet may be dirty. Cleaning the inside 
or contact a service representative.

Color or Black 
background

If the amount of background shading becomes 
unacceptable:
• Change the image transfer belt if it has 

reached its lifespan. Contact a service 
representative.

• Check the environmental conditions: very 
dry conditions (low humidity) or a high level 
of humidity (higher than 80% RH) can 
increase the amount of background shading.

• Remove the old toner cartridge and install a 
new one.

Toner smear If toner smears on the page: 
• Clean the inside of the machine. Cleaning 

the inside or contact a service 
representative.

• Check the paper type and quality (see "Print 
media specifications" on page 165).

• Remove the imaging unit and install a new 
one. Contact a service representative.

• Change the image transfer belt if it has 
reached its lifespan. Contact a service 
representative.

Condition Suggested Solutions
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Vertical repetitive 
defects

A

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The imaging unit may be damaged. If a 

repetitive mark occurs on the page, run a 
cleaning sheet through several times to 
clean the imaging unit. Cleaning the inside. If 
you still have the same problems, remove 
the imaging unit and install a new one. 
Contact a service representative.

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Background 
scatter

Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a different batch of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print resolution through your software 
application or in Printing Preferences (see 
"Opening printing preferences" on 
page 101).

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try different paper (see 
"Print media specifications" on page 165).

• If characters are improperly formed and 
producing a wavy effect, the scanner unit may 
need service. Cleaning the scan unit or 
contact a service representative.

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality (see "Print 

media specifications" on page 165).
• Ensure that the paper or other material is 

loaded correctly and the guides are not too 
tight or too loose against the paper stack.

• Ensure that the standard tray right bottom 
door, dual cassette feeder right bottom door 
or high capacity feeder right bottom door is 
securely closed. If the bottom doors are not 
completely closed, open and close the bottom 
doors.

Condition Suggested Solutions

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl (see "Print media specifications" on 
page 165).

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or 
creases

A

• Ensure that the paper is loaded properly.
• Check the paper type and quality (see "Print 

media specifications" on page 165).
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.
• Ensure that the standard tray right bottom 

door, dual cassette feeder right bottom door 
or high capacity feeder right bottom door is 
securely closed. If the bottom doors are not 
completely closed, open and close the bottom 
doors.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the 
machine. Cleaning the inside or contact a 
service representative.

Solid Color or 
Black pages

• The imaging unit may not be installed 
properly. Remove the imaging unit and 
reinsert it.

• The imaging unit may be defective and need 
replacing. Remove the imaging unit and 
install a new one. Contact a service 
representative.

• The machine may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the machine. Cleaning the 
inside or contact a service representative.

• Check the paper type and quality (see "Print 
media specifications" on page 165).

• Remove the imaging unit and install a new 
one. Contact a service representative.

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Condition Suggested Solutions
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A
Copying problems

Character Voids Character voids are white areas within parts of 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface of 
the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper 
specifications (see "Print media 
specifications" on page 165).

Horizontal stripes If horizontally aligned black streaks or smears 
appear:
• The imaging unit may be installed 

improperly. Remove the imaging unit and 
reinsert it.

• The imaging unit may be defective. Remove 
the imaging unit and install a new one. 
Contact a service representative.

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to Printing Preferences, click Paper tab, 
and set type to thin paper (see "Opening 
printing preferences" on page 101).

An unknown image 
repetitively 
appears on a few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your machine is probably being used at an 
altitude of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality, 
such as loose toner or light imaging. Change the 
correct altitude setting to your machine.

Condition Suggested Solutions

Condition Suggested solution

Copies are too light 
or too dark

Use Light and Dark arrows to lighten or darken 
the backgrounds of copies in the Basic tab of 
the Copy menu.

Smears, lines, 
marks, or spots 
appear on copies.

• If the defects are on the original, press 
left/right arrow to lighten the background of 
your copies in the Basic tab of the Copy 
menu (see "Changing the darkness" on 
page 54).

• If there are no defects on the original, clean 
the scan unit. Cleaning the scan unit or 
contact a service representative.

Copy image is 
skewed.

• Ensure that the original is face down on the 
scanner glass or face up in the DADF.

• Check that the copy paper is loaded correctly.
• If the problem persists, the machine may 

require repair. Contact a service 
representative.

Blank copies print 
out.

Ensure that the original is face down on the 
scanner glass or face up in the DADF.

Image rubs off the 
copy easily.

• Replace the paper in the tray with paper from 
a new package.

• In high humidity areas, do not leave paper in 
the machine for extended periods of time.

Frequent copy paper 
jams occur.

• Fan the stack of paper, then turn it over in the 
tray. Replace the paper in the tray with a fresh 
supply. Check/adjust the paper guides, if 
necessary.

• Ensure that the paper is the proper paper 
weight.

• Check for copy paper or pieces of copy paper 
remaining in the machine after a paper jam 
has been cleared.

Toner cartridge 
produces fewer 
copies than 
expected before 
running out of toner.

• Your originals may contain pictures, solids, or 
heavy lines. For example, your originals may 
be forms, newsletters, books, or other 
documents that use more toner.

• The DADF may be left open while copies are 
being made.

• The machine may be turned on and off 
frequently.
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Scanning problems Fax problems (optional)

Conditon Suggested solutions

The scanner does not 
work. 

• Make sure that you place the original to be 
scanned face down on the scanner glass, or 
face up in the DADF.

• There may not be enough available memory 
to hold the document you want to scan. Try 
the Prescan function to see if that works. 
Try lowering the scan resolution rate.

• Check that the machine cable is connected 
properly.

• Make sure that the machine cable is not 
defective. Switch the cable with a known 
good cable. If necessary, replace the cable.

• Check that the scanner is configured 
correctly. Check scan setting in the Easy 
Document Creator or the application you 
want to use to make certain that the scanner 
job is being sent to the correct port (for 
example, USB001).

The unit scans very 
slowly. 

• Check if the machine is printing received 
data. If so, scan the document after the 
received data has been printed.

• Graphics are scanned more slowly than text.
• Communication speed slows in scan mode 

because of the large amount of memory 
required to analyze and reproduce the 
scanned image. Set your computer to the 
ECP printer mode through BIOS setting. It 
will help to increase the speed. For details 
about how to set BIOS, refer to your 
computer user’s guide.

Message appears on 
your computer 
screen:
• Device can’t be 

set to the H/W 
mode you want.

• Port is being used 
by another 
program. 

• Port is Disabled.
• Scanner is busy 

receiving or 
printing data. 
When the current 
job is completed, 
try again.

• Invalid handle.
• Scanning has 

failed.

• There may be a copying or printing job in 
progress. Try your job again when that job is 
finished.

• The selected port is currently being used. 
Restart your computer and try again.

• The machine cable may be improperly 
connected or the power may be off.

• The scanner driver is not installed or the 
operating environment is not set up properly.

• Ensure that the machine is properly 
connected and the power is on, then restart 
your computer.

• The USB cable may be improperly 
connected or the power may be off.

condition suggested solutions

The machine is not 
working, there is no 
display, or the 
buttons are not 
working.

• Unplug the power cord and plug it in again.
• Ensure that there is power being supplied to 

the electrical outlet.

No dial tone sounds. • Check that the phone line is properly 
connected.

• Check that the phone socket on the wall is 
working by plugging in another phone.

The numbers stored 
in memory do not 
dial correctly.

Make sure that the numbers are stored in 
memory correctly (see "Setting up an address 
book" on page 94).

The original does 
not feed into the 
machine.

• Make sure that the paper is not wrinkled and 
you are inserting it in correctly. Check that the 
original is the right size, not too thick or thin.

• Make sure that the DADF is firmly closed.
• The DADF rubber pad may need to be 

replaced. Contact a service representative.

Faxes are not 
received 
automatically.

• The receiving mode should be set to fax.
• Make sure that there is paper in the tray.
• Check to see if the display shows any error 

message. If it does, clear the problem

The machine does 
not send.

• Make sure that the original is loaded in the 
DADF or on the scanner glass. 

• Check the recipient’s fax machine (if it has a 
problem).

The incoming fax 
has blank spaces or 
is of poor-quality.

• The fax machine sending you the fax may be 
faulty. 

• A noisy phone line can cause line errors.
• Check your machine by making a copy.
• The toner cartridge may be empty. Replace 

the toner cartridge.

Some of the words 
on an incoming fax 
are stretched.

The fax machine sending the fax had a 
temporary document jam. 

There are lines on 
the originals you 
sent.

Check your scan unit for marks and clean it. 
Cleaning the scan unit.
Troubleshooting_ 156



Common PostScript problems
The following situations are PS language specific and may occur when 
several printer languages are used.

Common Windows problems

 

Refer to Microsoft Windows 2000/XP/2003/Vista User’s Guide that 
came with your computer for further information on Windows error 
messages.

The machine dials a 
number, but the 
connection with the 
other fax machine 
fails.

The other fax machine may be turned off, out of 
paper, or cannot answer incoming calls. Speak 
with the other machine operator and ask her/him 
to solve out the problem.

Faxes do not store in 
memory.

There may not be enough memory space to 
store the fax. If the display indicating the 
memory status shows, delete any faxes you no 
longer need from the memory, and then try to 
store the fax again.

Blank areas appear 
at the bottom of 
each page or on 
other pages, with a 
small strip of text at 
the top

You may have chosen the wrong paper settings 
in the user option setting. For details about 
paper settings (see "Tray setting" on page 47).

Problem Possible cause Solution

PostScript file 
cannot be printed.

The PostScript 
driver may not be 
installed correctly.

• Install the PostScript 
driver.

• Print a configuration 
page and verify that 
the PS version is 
available for printing.

• If the problem persists, 
contact a service 
representative.

“Limit Check Error” 
message appears.

The print job was 
too complex.

You might need to 
reduce the complexity of 
the page or install more 
memory.

A PostScript error 
page prints.

The print job may 
not be PostScript.

Make sure that the print 
job is a PostScript job. 
Check to see whether 
the software application 
expected a setup or 
PostScript header file to 
be sent to the machine.

The optional dual 
cassette feeder (tray 
3, tray 4) is not 
selected in the 
driver.

The printer driver 
has not been 
configured to 
recognize the 
optional dual 
cassette feeder 
(tray 3, tray 4).

Open the PostScript 
driver properties, select 
the Device Options tab, 
and set the tray option of 
the Tray Options 
section.

When printing a 
document in MAC 
with Acrobat Reader 
6.0 or higher, colors 
print incorrectly.

The resolution 
setting in the printer 
driver may not be 
matched with the 
one in Acrobat 
Reader.

Make sure that the 
resolution setting in your 
printer driver matches 
the one in Acrobat 
Reader.

condition suggested solutions

Condition Suggested solutions

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the printer’s startup group, then 
restart Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.
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Common Linux problems

condition Suggested solutions

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator and 
switch to the Printers tab in Printers 
configuration window to look at the list of 
available machines. Make sure that your 
machine is displayed on the list. If not, open 
Add new printer wizard to set up your 
device.

• Check if the machine is started. Open 
Printers configuration and select your 
machine on the printers list. Look at the 
description in the Selected printer pane. If its 
status contains Stopped string, press the 
Start button. After that normal operation of 
the machine should be restored. The 
“stopped” status might be activated when 
some problems in printing occurred. For 
instance, this could be an attempt to print a 
document when the port is claimed by a 
scanning application.

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
user applications to the same port is possible. 
To avoid possible conflicts, only one of them 
at a time is allowed to gain control over the 
device. The other user will encounter “device 
busy” response. You should open ports 
configuration and select the port assigned to 
your machine. In the Selected port pane you 
can see if the port is occupied by some other 
application. If this is the case, you should 
either wait for completion of the current job or 
press the Release port button, if you are sure 
that the present application is not functioning 
properly.

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter, then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

• The CUPS (Common Unix Printing System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp (Internet 
Printing Protocol) printing.Use the socket 
printing instead of ipp or install a later version 
of CUPS (cups-1.1.22 or higher).

The machine does 
not print whole 
pages, and output is 
printed on half the 
page.

It is a known problem that occurs when a color 
machine is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript 
Bug 688252.The problem is solved in AFPL 
Ghostscript v. 8.52 or above. Download the 
latest version of AFPL Ghostscript from 
http://sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.

I cannot scan via 
Gimp Front-end.

Check if Gimp Front-end has Xsane: Device 
dialog on the Acquire menu. If not, you should 
install Xsane plug-in for Gimp on the your 
computer. You can find Xsane plug-in package 
for Gimp on Linux distribution CD or Gimp home 
page. For the detailed information, refer to the 
Help for Linux distribution CD or Gimp Front-end 
application. 
If you wish to use another kind of scan 
application, refer to application’s Help.

I encounter the 
“Cannot open port 
device file” error 
when printing a 
document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS server break the print 
job whenever print options are changed and 
then try to restart the job from the beginning. 
Since Unified Linux Driver locks the port while 
printing, the abrupt termination of the driver 
keeps the port locked and unavailable for 
subsequent print jobs. If this situation occurs, try 
to release the port by selecting Release port in 
Port configuration window.

The machine does 
not appear on the 
scanners list.

• Ensure your machine is attached to your 
computer, connected properly via the USB 
port, and is turned on.

• Ensure the scanner driver for your machine is 
installed in your system. Open Unified Linux 
Driver configurator, switch to Scanners 
configuration, then press Drivers. Make 
sure that driver with a name corresponding to 
your machine's name is listed in the window. 

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
user applications to the same port is possible. 
To avoid possible conflicts, only one of them 
at a time is allowed to gain control over the 
device. The other user will encounter “device 
busy” response. This usually happens when 
starting a scan procedure. An appropriate 
message box appears.
To identify the source of the problem, open 
the Ports configuration and select the port 
assigned to your scanner, port's symbol 
/dev/mfp0 corresponds to LP:0 designation 
displayed in the scanners’ options, /dev/mfp1 
relates to LP:1, and so on. USB ports start at 
/dev/mfp4, so scanner on USB:0 relates to 
/dev/mfp4 respectively and so forth 
sequentially. In the Selected port pane, you 
can see if the port is occupied by another 
application. If this is the case, you should 
either wait for completion of the current job or 
press the Release port button, if you are sure 
that the present port application is not 
functioning properly.

condition Suggested solutions
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Refer to the Linux User’s Guide that came with your computer for 
further information on Linux error messages.

Common MAC problems

 

It will take longer to print when you print a 
PDF file as an image.

 

Refer to MAC User’s Guide that came with your computer for further 
information on MAC error messages.

The machine does 
not scan.

• Ensure a document is loaded into the 
machine, ensure your machine is connected 
to the computer.

• If there is an I/O error while scanning.

condition Suggested solutions

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

The document has 
printed, but the print 
job has not 
disappeared from 
the spooler in Mac 
OS X10.3.2.

Update your MAC OS to MAC OS X 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the cover 
page printing.

Mac OS X cannot create the font during the 
cover page printing. The English alphabet and 
numbers are displayed normally on the cover 
page.

When printing a 
document in MAC 
with Acrobat 
Reader 6.0 or higher, 
colors print 
incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.

condition Suggested solutions
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12.Supplies and accessories
This guide provides information on purchasing supplies, accessories and maintenance parts available for your machine.

This chapter includes:

• How to purchase
• Available supplies

• Available accessories
• Checking replaceable’s lifespan

  

 

Available accessories may differ from country to country. Contact your 
sales representatives to obtain the list of available accessories.

How to purchase

To order Samsung-authorized supplies, accessories and maintenance 
parts, contact your local Samsung dealer or the retailer where you 
purchased your machine. You can also visit www.samsung.com/supplies, 
select your country/region, and obtain information on calling for service.

Available supplies

When supplies reach their lifespan, you can order the following types of 
supplies for your machine.

 

Depending on the options and job mode used, the toner cartridge’s 
lifespan may differ.

 

You must purchase supplies, including toner cartridges, in the same 
country where you  purchased your machine. Otherwise, supplies will 
be incompatable with your machine since the system configuration of 
these vary from country to country.

SCX-812x Series

CLX-92x1_9301 Series

Type Average yielda

a.Declared yield value in accordance with 5% coverage.

Part name

Toner cartridge Average continuous black 
cartridge yield: 25,000 
standard pages

MLT-D709S (Black)

Imaging unit Approx. 100,000 images MLT-R709

Waste toner 
container

Approx. 100,000 imagesc MLT-W709

Type Average yielda Part name

Toner cartridge Average continuous black 
cartridge yield: 20,000 
standard pages 

CLT-K809S (Black)

Average continuous 
colored cartridge yield: 
15,000 standard pages 
(Cyan/Magenta/Yellow)

CLT-C809S (Cyan)
CLT-M809S (Magenta)
CLT-Y809S (Yellow)

Imaging unit Approx. 50,000 images CLT-R809

Waste toner 
container

Approx. 100,000 imagesc CLT-W809

a.Declared yield value in accordance with 5% coverage.

Type Average yielda Part name
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Necessary precautions to take when installing 
accessories
• Disconnect the power cord.

Never remove the control board cover while the power is turned on.
To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external 
accessories.

• Discharge static electricity.
The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

• Activating the added accessories in the PS driver properties.
After installing an accessory such as an optional tray, PS driver users 
must do the additional setting. Go to the PS printer properties and set 
the added accesorry activated. 

 

When installing accessories, the battery inside the machine is a 
service component. Do not change it by yourself.
There is a risk of an explosion if battery is replaced by an incorrect 
type. Dispose used batteries according to the instructions.

Available accessories

You can purchase and install accessories to enhance your machine’s 
performance and capacity.

Accessory function Part name

Cabinet Stand You can place the 
machine on the 
ergonomically-designed 
cabinet which lets you 
reach the machine 
conveniently. Also, you 
can easily move the 
cabinet with its wheels, 
if necessary, and store 
miscellaneous items 
like papers into the 
cabinet.

CLX-DSK20T

Dual Cassette 
Feeder 

If you are experiencing 
frequent Paper Source 
problems, you can 
attach an additional 
tray. The optional tray 
can hold up to 1,040 
sheets. You can print 
documents in various 
sizes and types of print 
materials in the tray.

CLX-PFP100

300-Sheet Inner 
Finisher

This Inner Finisher 
allows you to sort, 
group and staple 
printouts.

CLX-FIN50S

Working Table You can place an 
external authentication 
device or 
miscellaneous items on 
the working table.

CLX-WKT000

Fax Kit This fax kit allows you 
to use your machine as 
a fax.

CLX-FAX160

FDI(Foreign Device 
Interface)Kit

This card is installed 
inside the machine to 
allow a third party 
device such as a coin 
operated device or a 
card reader. Those 
devices allow the 
payfor-print service on 
your machine.

CLX-KIT10F

Hard Disk Kit This hard disk kit will 
help the machine to be 
used in various ways.

ML-HDK471

Job Separator This Job separator will 
help the machine to 
collate printouts.

CLX-JST100 

Accessory function Part name
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Checking replaceable’s lifespan

If you experience frequent paper jams or printing problems, check the 
remaining lifespan of supplies. Replace the corresponding parts, if 
necessary.

1. Press Machine Setup > Others > Supplies Life from the main screen.
2. Check the supplies life.
3. Press Back for return to the previous screen.
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Specifications
This chapter gives information regarding this machine’s specifications.
This chapter include:

• Hardware specifications
• Environmental specifications
• Electrical specifications
• Print media specifications

 

The specification values here are based on preliminary data. see www.samsung.com for current information.

Hardware specifications

Environmental specifications

Item SCX-812x Series
CLX-93x1 Series
CLX-92x1 Series

Dimension Height (with Duplex Automatic Document Feeder) 700.8 mm (27.6 inches) 1102.5 mm (43.4 inches)

Depth 600 mm (23.6 inches) 620 mm (24.4 inches)

Width 560 mm (22 inches)

Weight Machine without consumables and options 55.5 Kg (122 lbs) 72.5 Kg (160 lbs)

Duplex automatic document feeder 5 Kg (11 lbs)

Item SCX-812x Series
CLX-93x1 Series
CLX-92x1 Series

Noise Levela

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.

Ready mode 43 dB(A)

Printing mode (Simplex)
(Duplex: Simplex+2dBA)

• Tray 1: 52dB(A)
• MP : 54 dB(A)
• Option tray : 54dB(A)

• Tray 1: 52dB(A)
• MP : 54 dB(A)
• Option tray : 54dB(A)

Copying mode (Simplex)
(Duplex: Simplex+2dBA)

• Tray 1: 55dB(A)
• MP : 57 dB(A)
• Option tray : 57dB(A)

• Tray 1: 55dB(A)
• MP : 57 dB(A)
• Option tray : 57dB(A)

Printing mode (with Finisher)
(Simplex)
(Duplex: Simplex+2dBA)

• Tray 1: 54dB(A)
• MP : 56 dB(A)
• Option tray : 56dB(A)

• Tray 1: 54dB(A)
• MP : 56 dB(A)
• Option tray : 56dB(A)

Copying mode (with Finisher)
(Simplex)
(Duplex: Simplex+2dBA)

• Tray 1: 57dB(A)
• MP : 59 dB(A)
• Option tray : 59dB(A)

• Tray 1: 57dB(A)
• MP : 59 dB(A)
• Option tray : 59dB(A)

Temperature Operation 10 to 32 °C (50 to 90 °F)

Storage -20 to 40 °C (-4 to 104 °F)

Humidity Operation 20 to 80% RH

Storage 10 to 90% RH
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Electrical specifications

 

Power requirements are based on the country/region where the device is sold. Do not convert operating voltages. Doing so might damage the device and 
void the product warranty.

Item Description

Power ratinga

a.see the rating label on the machine for the correct voltage, frequency (hertz), and type of current for your machine.

110 volt models AC 110 - 127 V

220 volt models AC 220 - 240 V

Power consumption Average operating mode Less than 1,100 W

Ready mode Less than 250 W

Power save mode Less than 3 W

Power off mode Less than 0 W
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Print media specifications 

Type Size Dimensions
print media weight/Capacity (Simplex)a

tray1,2,3,4 multipurpose tray

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) 71 to 90 g/m2 (19 to 24 lb bond) 

• 520 sheets of 80g/m2 (20 lb 
bond) for each tray

• 2,000 sheets of 80g/m2 (20 lb 
bond) for the high capacity 
feeder

 

A3 and 8K are not 
supported in Tray1.

71 to 90 g/m2 (19 to 24 lb bond) 

• 100 sheets of 80 g/m2 (20 lb 
bond)

Ledger 279 x 432 mm (11 x 17 inches)

Legal 216 x 356 mm (8.5 x 14 inches)

Executive 184 x 267 mm (7.25 x 10.5 inches)

Statement 140 x 216 mm (5.5 x 8.5 inches)

A3 297 x 420 mm (11.7 x 16.5 inches)

A4 210 x 297 mm (8.26 x 11.7 inches)

A5 148 x 210 mm (5.82 x 8.26 inches)

B4 257 x 364 mm (10.1 x 14.3 inches)

JIS B5 182 x 257 mm (7.16 x 10.11 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

US Folio 216 x 330 mm (8.5 x 13 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

8K 270 x 390 mm (10.75 x 15.5 inches)

16K 195 x 270 mm (7.76 x 10.75 inches)

A6 105 x 148 mm (4.13 x 5.82 inches) Not available in tray1,2,3,4 / High 
capacity feeder

Envelope Letter, Statement, A4, 
A5, JIS B5, A6, ISO 
B5

Refer to the Plain paper section Not available in tray1,2,3,4 / High 
capacity feeder

75 to 90 g/m2 (20 to 24 lb bond)
• 10 sheets stacking

Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches)

Envelope No. 10 105 x 241 mm (4.12 x 9.5 inches)

Envelope No. 9 98 x 225 mm (3.87 x 8.87 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.37 x 9.01 inches)

Envelope C6 114 x 162 mm (4.48 x 6.38 inches)

Envelope C4 229 x 324 mm (9.01 x 12.75 inches)

Thick paper Refer to the Plain 
paper section 

Refer to the Plain paper section 91 to 105 g/m2 (25 to 28 lb bond)
• 400 sheets for each tray
• 1,600 sheets for the high 

capacity feeder

91 to 105 g/m2 (25 to 28 lb bond)
• 50 sheets stacking

Heavy weight 
paper

Refer to the Plain 
paper section 

Refer to the Plain paper section 106 to 175 g/m2 (29 to 46 lb bond)
• 350 sheets stacking
• 1,400 sheets for the high 

capacity feeder

106 to 175 g/m2 (29 to 46 lb bond)
• 20 sheets stacking

Extra Heavy 
weight 1

Refer to the Plain 
paper section 

Refer to the Plain paper section 176 to 216 g/m2 (47 to 57 lb bond)
• 200 sheets stacking
• Not available in the high 

capacity feeder

176 to 216 g/m2 (47 to 57 lb bond)
• 10 sheets stacking
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Extra Heavy 
weight 2

Refer to the Plain 
paper section 

Refer to the Plain paper section Not available in tray1,2,3,4 / High 
capacity feeder

217 to 253 g/m2 (58 to 67 lb bond)
• 10 sheets stacking

Thin paper Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 18 lb bond)
• 520 sheets stacking
• 2,000 sheets for the high 

capacity feeder

60 to 70 g/m2 (16 to 18 lb bond)
• 100 sheets stacking

Cotton Refer to the Plain 
paper section 

Refer to the Plain paper section 75 to 90 g/m2 (20 to 24 lb bond)
• 400 sheets stacking
• 1,600 sheets for the high 

capacity feeder

75 to 90 g/m2 (20 to 24 lb bond)
• 50 sheets stacking

Colored / 
Pre-Printed

Refer to the Plain 
paper section 

Refer to the Plain paper section 75 to 90 g/m2 (20 to 24 lb bond)
• 400 sheets stacking
• 1,600 sheets for the high 

capacity feeder

75 to 90 g/m2 (20 to 24 lb bond)
• 50 sheets stacking

Recycled Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 90 g/m2 (16 to 24 lb bond)
• 400 sheets stacking
• 1,600 sheets for the high 

capacity feeder

60 to 90 g/m2 (16 to 24 lb bond)
• 100 sheets stacking

Thin cardstock Refer to the Plain 
paper section 

Refer to the Plain paper section 105 to 163 g/m2 (28 to 43 lb bond)
• 350 sheets stacking
• 1,400 sheets for the high 

capacity feeder

105 to 163 g/m2 (28 to 43 lb bond)
• 20 sheets stacking

Thick 
cardstock

Refer to the Plain 
paper section 

Refer to the Plain paper section 170 to 216 g/m2 (45 to 57 lb bond)
• 350 sheets stacking
• Not available in the high 

capacity feeder

170 to 216 g/m2 (45 to 57 lb bond)
• 20 sheets stacking

Thin glossy Refer to the Plain 
paper section 

Refer to the Plain paper section Not available in tray1,2,3,4 / High 
capacity feeder

106 to 169 g/m2 (28 to 45 lb bond)
• 20 sheets stacking

Thick glossy Refer to the Plain 
paper section 

Refer to the Plain paper section Not available in tray1,2,3,4 / High 
capacity feeder

170 to 253 g/m2 (45 to 67 lb bond)
• 10 sheets stacking

Labelsb Letter, A4 Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb bond)
• 20 sheets stacking

Postcard PostCard 4 x 6 101.6 x 152.4 mm (4 x 6 inches) Not available in tray1,2,3,4 / High 
capacity feeder

60 to 105 g/m2 (16 to 28 lb bond)
• 20 sheets stacking

Tray 1 minimum size (custom) 139.7 x 210 mm (5.5 x 8.27 inches) 60 to 216 g/m2 (16 to 57 lb bond) -

Tray 1 maximum size (custom) 257 x 364 mm (10.1 x 14.3 inches)

Tray 2,3,4 minimum size (custom) 139.7 x 210 mm (5.5 x 8.27 inches)

Tray 2,3,4 maximum size (custom) 305 x 457 mm (12 x 18 inches)

Multipurpose tray minimum size 
(custom)

98 x 148 mm (3.87 x 5.82 inches) - 60 to 253 g/m2 (16 to 67 lb bond)

Multipurpose tray maximum size 
(custom)

297 x 1,200 mm (11.7x 47.2 inches)

a.Maximum capacity may differ depending on media weight, thickness, and environmental conditions.

Type Size Dimensions
print media weight/Capacity (Simplex)a

tray1,2,3,4 multipurpose tray
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System requirements

Before you begin, make sure that your system meets the following requirements:

Windows

Your machine supports the following Windows operating systems.

 

• Internet Explorer 6.0 or higher is the minimum requirement for all Windows operating systems.
• Users who have administrator rights can install the software.
• Windows Terminal Services is compatible with your machine.
• For Windows 2000, Services Pack 4 or higher is required.

MAC

b.The smoothness of the labels used in this machine is 100 to 250 (sheffield). This means the numeric level of smoothness. 

OPERATING SYSTEM
Requirement (recommended)

CPU RAM free HDD space

Windows® 2000 Intel® Pentium® II 400 MHz (Pentium III 933 MHz) 64 MB (128 MB) 600 MB

Windows® XP Intel® Pentium® III 933 MHz (Pentium IV 1 GHz) 128 MB (256 MB) 1.5 GB

Windows Server® 2003 Intel® Pentium® III 933 MHz (Pentium IV 1 GHrmz) 128 MB (512 MB) 1.25 GB to 2 GB

Windows Server® 2008 Intel® Pentium® IV 1 GHz (Pentium IV 2 GHz) 512 MB (2048 MB) 10 GB

Windows Vista® Intel® Pentium® IV 3 GHz 512 MB (1024 MB) 15 GB

Windows® 7 Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher 1 GB (2 GB) 16 GB

• Support for DirectX® 9 graphics with 128 MB memory (to enable 
the Aero theme).

• DVD-R/W Drive

Windows Server® 2008 
R2

Intel® Pentium® IV 1 GHz (x86) or 1.4 GHz (x64) processors (2 GHz 
or faster)

512 MB  
(2048 MB)

10 GB

OPERATING SYSTEM
Requirements (recommended)

CPU RAM free HDD space

Mac OS X 10.4 • Intel™ processors
• PowerPC G4/G5

• 128 MB for a powerPC based Mac 
(512 MB)

• 512 MB for an Intel-based Mac (1 GB)

1 GB

Mac OS X 10.5 • Intel™ processors
• 867 MHz or faster Power PC G4/G5

512 MB (1 GB) 1 GB

Mac OS X 10.6 • Intel™ processors 1 GB (2 GB) 1 GB

Mac OS X 10.7 • Intel™ processors 2 GB 4 GB
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Linux

UNIX

Item Requirements

Operating system Redhat™ Enterprise Linux WS 4, 5 (32/64 bit)
Fedora 5 ~ 13 (32/64 bit)
SuSE Linux 10.1 (32 bit)
OpenSuSE™ 10.2, 10.3, 11.0, 11.1, 11.2 (32/64 bit)
Mandriva 2007, 2008, 2009, 2009.1, 2010 (32/64 bit)
Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04, 8.10, 9.04, 9.10, 10.04 (32/64 bit)
SuSE Linux Enterprise Desktop 10, 11 (32/64 bit)
Debian 4.0, 5.0 (32/64 bit)

CPU Pentium IV 2.4 GHz (IntelCore2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2 GB)

Item Requirements

Operating system Sun Solaris 9,10 (x86, SPARC) 
HP-UX 11.0, 11i v1, 11i v2, 11i v3 (PA-RISC, Itanium)
IBM AIX 5.1, 5.2, 5.3, 5.4 (PowerPC)

Free HDD space Up to 100 MB
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Contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

Country/Region Customer Care Center Web Site

ALBANIA 42 27 5755 www.samsung.com

ARGENTINE 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555 www.samsung.com

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA 0810-SAMSUNG 
(7267864, € 0.07/min)

www.samsung.com

AZERBAIJAN 088-55-55-555 www.samsung.com

BAHRAIN 8000-4726 www.samsung.com

BELARUS 810-800-500-55-500 www.samsung.com

BELGIUM 02-201-24-18 www.samsung.com/be 
(Dutch)
www.samsung.com/be
_fr (French)

BOLIVIA 800-10-7260 www.samsung.com

BOSNIA 05 133 1999 www.samsung.com

BRAZIL 0800-124-421
4004-0000

www.samsung.com

BULGARIA 07001 33 11 www.samsung.com

CAMEROON 7095-0077 www.samsung.com

CANADA 1-800-SAMSUNG 
(726-7864)

www.samsung.com/ca
www.samsung.com/ca
_fr (French)

CHILE 800-SAMSUNG 
(726-7864)
From mobile 02-482 82 00

www.samsung.com

CHINA 400-810-5858 www.samsung.com

COLOMBIA 01-8000112112 www.samsung.com

COSTA RICA 0-800-507-7267 www.samsung.com

COTE D’LVOIRE 8000 0077 www.samsung.com

CROATIA 062 SAMSUNG (062 726 
7864)

www.samsung.com

CYPRUS 8009 4000 only from 
landline

www.samsung.com

CZECH 
REPUBLIC

800-SAMSUNG 
(800-726786)

www.samsung.com

Samsung Electronics Czech and Slovak, s.r.o., 
Oasis Florenc, Sokolovská 394/17, 180 00, Praha 8

DENMARK 70 70 19 70 www.samsung.com

DOMINICA 1-800-751-2676 www.samsung.com

ECUADOR 1-800-10-7267 www.samsung.com

EGYPT 08000-726786 www.samsung.com

EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com

ESTONIA 800-7267 www.samsung.com

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.com

GEORGIA 8-800-555-555 www.samsung.com

GHANA 0800-10077
0302-200077

www.samsung.com

GREECE 80111-SAMSUNG (80111 
726 7864) only from land 
line
(+30) 210 6897691 from 
mobile and  land line

www.samsung.com

GUATEMALA 1-800-299-0013 www.samsung.com

HONDURAS 800-27919267 www.samsung.com

HONG KONG (852) 3698-4698 www.samsung.com/hk
www.samsung.com/hk
_en/

HUNGARY 06-80-SAMSUNG 
(726-7864)

www.samsung.com

INDIA 1800 1100 11
3030 8282
1800 3000 8282
1800 266 8282

www.samsung.com

INDONESIA 0800-112-8888
021-5699-7777

www.samsung.com

IRAN 021-8255 www.samsung.com

ITALY 800-SAMSUNG 
(726-7864)

www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273 www.samsung.com

KAZAKHSTAN 8-10-800-500-55-500 
(GSM:7799)

www.samsung.com

Country/Region Customer Care Center Web Site
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KENYA 0800 724 000 www.samsung.com

KOSOVO +381 0113216899 www.samsung.com

KUWAIT 183-2255 www.samsung.com

KYRGYZSTAN 00-800-500-55-500 www.samsung.com

LATVIA 8000-7267 www.samsung.com

LITHUANIA 8-800-77777 www.samsung.com

LUXEMBURG 261 03 710 www.samsung.com

MALAYSIA 1800-88-9999 www.samsung.com

MACEDONIA 023 207 777 www.samsung.com

MEXICO 01-800-SAMSUNG 
(726-7864)

www.samsung.com

MOLDOVA 00-800-500-55-500 www.samsung.com

MONGOLIA www.samsung.com

MONTENEGRO 020 405 888 www.samsung.com

MOROCCO 080 100 2255 www.samsung.com

NIGERIA 0800-726-7864 www.samsung.com

NETHERLANDS 0900-SAMSUNG 
(0900-7267864) (€ 
0,10/min)

www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 
726 786)

www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com

NORWAY 815-56 480 www.samsung.com

OMAN 800-SAMSUNG 
(726-7864)

www.samsung.com

PANAMA 800-7267 www.samsung.com

PERU 0-800-777-08 www.samsung.com

PHILIPPINES 1-800-10-SAMSUNG(726
-7864) for PLDT
1-800-3-SAMSUNG(726-
7864) for Digitel
1-800-8-SAMSUNG(726-
7864) for Globe
02-5805777

www.samsung.com

POLAND 0 801-1 SAMSUNG 
(172-678)
+48 22 607-93-33

www.samsung.com

PORTUGAL 808 20-SAMSUNG (808 
20 7267)

www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

ROMANIA 08010 SAMSUNG (08010 
726 7864) only from 
landline
(+40) 21 206 01 10 from 
mobile and land line

www.samsung.com

Country/Region Customer Care Center Web Site

RUSSIA 8-800-555-55-55 www.samsung.com

SAUDI ARABIA 9200-21230 www.samsung.com

SENEGAL 800-00-0077 www.samsung.com

SERBIA 0700 SAMSUNG (0700 
726 7864)

www.samsung.com

SINGAPORE 1800-SAMSUNG 
(726-7864)

www.samsung.com

SLOVAKIA 0800-SAMSUNG 
(0800-726-7864)

www.samsung.com

SOUTH AFRICA 0860-SAMSUNG 
(726-7864)

www.samsung.com

SPAIN 902-1-SAMSUNG(902 
172 678)

www.samsung.com

SWEDEN 0771 726 7864 
(SAMSUNG)

www.samsung.com

SWITZERLAND 0848-SAMSUNG 
(7267864, CHF 0.08/min)

www.samsung.com/ch
www.samsung.com/ch
_fr(French)

TADJIKISTAN 8-10-800-500-55-500 www.samsung.com

TAIWAN 0800-329-999
0266-026-066

www.samsung.com

TANZANIA 0685 88 99 00 www.samsung.com

THAILAND 1800-29-3232
02-689-3232

www.samsung.com

TRINIDAD & 
TOBAGO

1-800-SAMSUNG 
(726-7864)

www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG 
(726-7864)

www.samsung.com

UGANDA 0800-300 300 www.samsung.com

U.K 0330 SAMSUNG 
(7267864)

www.samsung.com

U.S.A 1-800-SAMSUNG 
(726-7864)

www.samsung.com

UKRAINE 0-800-502-000 www.samsung.com/ua
www.samsung.com/ua
_ru

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

Country/Region Customer Care Center Web Site
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Glossary

 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g
802.11b/g can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps; 802.11g up to 54 Mbps. 
802.11b/g devices may occasionally suffer interference from microwave 
ovens, cordless telephones, and Bluetooth devices. 

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a scanning unit that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original MAC (1984) and is 
now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 
client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a de facto standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a scanning unit that 
will automatically feed and turn over an original sheet of paper so that 
the machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.
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DLNA
The Digital Living Network Alliance (DLNA) is a standard that allows 
devices on a home network to share information with each other across 
the network.

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically turn over a sheet of paper so that 
the machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex Unit can print on both sides of paper during one 
print cycle.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original MAC (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that fuses the toner onto the print media. It 
consists of some parts such as a heating parts and a pressure roller. 
After toner is transferred onto the paper, the fuser unit applies heat and 
pressure to ensure that the toner stays on the paper permanently, which 
is why paper is warm when it comes out of a laser printer. 

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.
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IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.
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MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or rust colored and has a cylinder shape. 
An imaging unit containing a drum slowly wears the drum surface by its 
usage in the printer, and it should be replaced appropriately since it gets 
worn from contact with the cartridge development brush, cleaning 
mechanism, and paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, dot matrix printer, and laser 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used in a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
see PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.
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SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.

Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle or container used in a machine like a printer which 
contains toner. Toner is a powder used in laser printers and 
photocopiers, which forms the text and images on the printed paper. 
Toner can be fused by by a combination of heat/pressure from the fuser, 
causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program. It is an image capture API for 
Microsoft Windows and Apple MAC operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.

WPS
The Wi-Fi Protected Setup (WPS) is a standard for establishing a 
wireless home network. If your wireless access point supports WPS, you 
can configure the wireless network connection easily without a 
computer.

XPS
XML Paper Specification (XPS) is a specification for a Page Description 
Language (PDL) and a new document format, which has benefits for 
portable document and electronic document, developed by Microsoft. It 
is an XML-based specification, based on a new print path and a 
vector-based device-independent document format.
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